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We take pride in providing you the perfect sewing
experience!
BERNINA has represented exceptional quality since 1893. As a traditional Swiss company,
we use high quality materials to manufacture our products and have them extensively
tested, ensuring high performance and a long life. Over the years, we have always
remained true to our company philosophy - we are personally committed to offering our
customers an exceptional sewing experience.
Every BERNINA is characterized by state-of-the-art technology paired with innovations in
both hardware and software. This is because we truly want you to enjoy the creative
process to the fullest - after all, creativity is turning your ideas into something that makes
you and others happy.
With this in mind, I wish you many joyous moments with your BERNINA 990.

Sincerely, yours
Hanspeter Ueltschi
Owner, BERNINA
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Please be aware of the following basic safety
instructions when using your machine. Before
using this machine, read instruction manual
carefully.

DANGER
To protect against electric shock, the
following instructions must be observed.

► Never leave the machine unattended
when it is connected to the power supply.
Immediately after use and before cleaning,
switch off the machine and disconnect the
power cable from the outlet.

In order to protect against injury, the
following instructions must be adhered to.

► Do not look directly into the laser beam or
view it with optical instruments (e.g.
magnifying glasses).
If the laser is damaged or defective, have
the laser checked or repaired by your local
BERNINA dealer.

► Do not look directly into the LED lamp
with optical instruments (e.g. magnifying
glass).
If the LED lamp is damaged or defective,
have the LED lamp checked or repaired at
your local BERNINA dealer.

► Switch off the machine before working in
the needle area.

► Before starting the machine, close all
covers.

WARNING
To reduce the risk of burns, fire, electric shock
or personal injury, the following instructions
must be observed.

General Facts

► This machine may only be used for the
purpose described in this instruction
manual.

Working Environment

► Do not use the machine outdoors.

► Only use the machine in dry rooms.

► Do not use the machine in a humid area.

► Do not use the machine in rooms where
aerosol products (sprays) are being used.

► Do not use the machine in rooms where
oxygen is dispensed.

Technical Condition

► Never use the machine when it is damp.

► Do not use the machine if it is not working
properly.

► Do not use the machine if a cable or the
plug is damaged.

► Do not use the machine if it has been
dropped, damaged or has fallen into
water.

► If the machine is damaged or does not
work properly, have the machine checked
or repaired by your local BERNINA dealer.

► Keep all ventilation openings of the
machine and the foot control free of lint,
dust and loose cloth.
Do not use the machine if the ventilation
openings are blocked.

Accessories and Supplies

► Only use the accessories recommended by
the manufacturer.
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► Always use an original BERNINA Stitch
Plate.
An incorrect stitch plate can result in
needle breakage.

► Use only straight needles of good quality.
Bent or damaged needles can cause
needle breakage.

► The machine is double-insulated.
Only use original spare parts. See
instructions for servicing of double-
insulated products.

► To lubricate the machine, only use oil
recommended by BERNINA.

► Risk of chemical burns and ingestion. Keep
the battery out of the reach of children.
This machine contains a lithium button cell
battery. If a new or used lithium button
cell battery is swallowed or ingested, this
can cause serious internal injuries and can
be fatal within two hours. The battery
compartment must therefore always be
kept securely closed. If it is not possible to
securely close the battery compartment,
stop using the machine, remove the
battery and keep it out of the reach of
children. If you suspect that batteries have
been swallowed or ingested, consult a
doctor immediately.

Appropriate Use

► The machine may be used, cleaned and
maintained by children older than eight or
by people with reduced physical, sensory
or mental capabilities or if there is a lack
of experience and knowledge.
Furthermore, these persons must be
supervised while working with the
machine, or they must know the safe
operation of the machine and be aware of
resulting hazards.

► Children are not allowed to play with the
machine.

Special care should be taken when the
machine is operated by or in the presence
of children.

► Only use the machine with the supplied
power cable.
USA and Canada only: Do not connect
power plug NEMA 1-15 to circuits
exceeding 150 volt-to-ground.

If the machine is to be used in a country
other than the country of origin, obtain a
power cable suitable for this country from
a BERNINA dealer.

► Only use this machine with the supplied
foot control of type LV-1.

► Do not insert any objects into the
openings of the machine.

► Do not place any objects on the foot
control.

► While sewing, guide the fabric gently.
Pulling and pushing the fabric can cause
needle breakage.

► Keep fingers away from all moving parts.
Special care is required in the needle area.

► Only lift the machine by the handle.

► For activities in the needle area – such as
threading the needle, changing the
needle, threading the looper or changing
the presser foot – switch off the machine.
To switch off, set the power switch to 0.

► When protective covers are removed,
when the machine is oiled or when other
cleaning and maintenance operations
mentioned in this instruction manual are
carried out, switch off the machine and
disconnect the power plug from the
outlet.

► Pull the plug out of the outlet by pulling
on the plug. Do not pull on the cable.
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Safety Signs on the
Machine

Sign Purpose

Attention: Close the doors, lids and
covers before operating the
machine.
Caution; moving parts. To reduce
the risk of injury, switch off the
machine before maintenance work.
Attach the covers.

Warning regarding chemical burns
Swallowing the batteries may result
in severe internal chemical burns.
Make sure that the batteries do not
fall into the hands of children.

FCC Declaration of Conformity
(For USA and Canada)
Responsible Company: BERNINA International AG,
Seestrasse 161, 8266 Steckborn, SCHWEIZ
Product Name: BERNINA 990
This device satisfies the provisions of Section 15 of the
guidelines of the American Federal Communications
Commission (FCC). Operation of this device is subject
to the following conditions: (1) This device must not
cause harmful interference, and (2) this device must
accept any interference received, including interference
that may cause undesired operation.
This device has been tested and, according to the speci-
fications in Paragraph 15 of the FCC regulations, is
compliant with the limit values for a digital Class B
device. These specifications define appropriate
protection against such interference in closed rooms.
This device can generate, use and radiate HF energy.
Therefore, if not installed and used properly, it may
cause harmful interference to radio communications.
There is, however, no guarantee that interference will
not occur in certain situations. If this device does cause
harmful interference to radio or television reception,
which can be determined by turning the device off and
on, the user should try to correct the interference by
one or more of the following measures:
n Reorient the antenna or set it up at a different

location.
n Increase the spacing between the equipment and

receiver.
n Connect the equipment into an outlet on a circuit

different from that to which the receiver is
connected.

n Contact your BERNINA dealer or an experienced
radio/television technician.

Any change or modification to the device that has not
been expressly approved by BERNINA can invalidate the
electromagnetic compatibility (EMC) and result in the
revocation of the operating license for this device.
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Availability of the Instruction
Manual

The instruction manual is supplied with the
machine.
n Keep the instruction manual safe at a

suitable place near the machine to have it at hand
in case that you need to look up something.

n If you pass the machine to a third party, always
include the instruction manual.

n The latest version of the instruction manual can be
downloaded at www.bernina.com/990-support.

Proper Use
Your BERNINA machine is conceived and designed for
private household use. It is intended for sewing fabrics
and other materials as described in this instruction
manual and on the machine. Any other use is not
considered proper. BERNINA assumes no liability for
consequences resulting from improper use.

Equipment and Scope of Delivery
Example images are used in these instructions
for the purposes of illustration. The machines
and the accessories shown in the images

therefore do not always match the actual items
included with your machine. The supplied accessory
can vary depending on the country of delivery. Acces-
sories mentioned or shown, which are not included in
the scope of delivery, can be purchased as optional
accessories from a BERNINA dealer. Further accessories
can be found at www.bernina.com/990#!accessories.
For technical reasons and in order to improve the
product, changes may be made to the equipment of
the machine and the scope of delivery at any time and
without prior notice.

BERNINA Quality Control
All BERNINA machines are assembled with utmost care
and are subjected to an extensive functionality test. The
integrated stitch counter therefore indicates that the
machine has already sewn stitches, which were
performed exclusively for test purposes and quality
control. The subsequent thorough cleaning does not
exclude the possibility that thread remnants may still be
found in the machine.

Servicing of Double-insulated
Products
In a double-insulated product two systems of insulation
are provided instead of grounding. No grounding
means is provided on a double-insulated product nor
should a means for grounded be added to the product.
Servicing a double-insulated product requires extreme
care and knowledge of the system and should only be
done by qualified service personnel. Replacement parts
for a double-insulated product must be identical to the
original parts in the product. A double-insulated
product is marked with the words: Double-Insulation
or double-insulated.

The symbol may also be marked on the product.

Environmental Protection
BERNINA International AG is committed to environ-
mental protection. We strive to minimize the environ-
mental impact of our products by continuously
improving product design and our manufacturing
technology.

The machine is labeled with the symbol of the
crossed-out wastebin. This means that the
machine should not be disposed of in

household waste when it is no longer needed.
Improper disposal can result in dangerous substances
getting into the groundwater and thus into our food
chain, damaging our health.
The machine must be returned free of charge to a
nearby collection point for electrical waste and
electronic equipment or to a collection point for the
reuse of the machine. Information on collection points
can be obtained from your local administration. When
purchasing a new machine, the dealer is obliged to
take back the old machine free of charge and dispose
of it properly.
If the machine contains personal data, you are
responsible for deleting the data yourself before
returning the machine.
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Explanation of Symbols

    DANGER

Designates a danger with a high risk which can lead to
serious injuries or even death unless it is avoided.

    WARNING

Designates a medium-risk hazard which can lead to
serious injuries if not avoided.

    CAUTION

Designates a low-risk hazard which can lead to minor
or moderate injuries if not avoided.

  NOTICE

Designates a hazard which can lead to material
damage if not avoided.

TIP

Tips from the BERNINA sewing experts.
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The purpose of your BERNINA 990 is for sewing,
embroidering and quilting. Delicate silk or satin fabrics
as well as heavyweight linen, fleece and denim can be
sewn easily with this machine. Numerous practical as
well as decorative stitches, buttonholes and embroidery
designs are at your disposal.

Further Information
In addition to this instruction manual for your
BERNINA 990, further informative print media
is also enclosed.

The current version of your manual as well as further
information about the machine and the accessories can
be found on our website
bernina.com
"Made to Create" is the BERNINA slogan. Not only do
our machines support you as you make your ideas a
reality, we offer additional suggestions and instructions
for projects and the opportunity to exchange ideas with
other sewing, quilting and embroidery enthusiasts. We
wish you lots of joy.

BERNINA YouTube Channel
On YouTube we offer a wide range of how-to
videos and support concerning the most
important functions of our machines. You can

also find detailed explanations of presser feet and
accessories that make your projects successful.
youtube.com/BerninaInternational
Available in English and German.

"inspiration" – the Creative Sewing Magazine and
Online Store with Sewing Patterns

Are you looking for ideas, sewing patterns and
instructions for great sewing projects? If so, the
BERNINA magazine "inspiration" is exactly

what you need. Three times a year, "inspiration" offers
fantastic sewing and embroidery ideas. From seasonal
fashion trends to trendy accessories and practical tips
to original decorations for your home or cute sewing
ideas for children.
The magazine is available in English, German, Dutch,
and French.
In our online shop you can purchase "inspiration" as an
e-magazine or as a print version, either as individual
issues or as a subscription. Furthermore, there are many
individual downloadable patterns to discover! Why not
take a look at:
inspiration.bernina.com
And follow us on Instagram (inspi-
ration.sewing.magazine).

BERNINA Blog
Sophisticated instructions, free sewing patterns
and embroidery designs as well as many new
ideas can be found weekly on our BERNINA

Blog. Our experts give useful tips and step by step
instructions to achieve your desired results. In the
community you can upload your own projects and
exchange experiences and ideas with other sewing and
embroidering enthusiasts.
bernina.com/blog
Available in English, German, Dutch and French.

BERNINA Social Media
Follow on social networks to learn more about
events, exciting projects and tips and tricks all
about sewing, quilting and embroidering. We

will keep you informed and are looking forward to
sharing highlights from the world of BERNINA.
bernina.com/social-media

BERNINA World App
Download the BERNINA App to your
smartphone and enjoy direct access to all
product information. The accessory organizer

gives you an overview of your accessories and those
you would like to have. Furthermore, you have direct
access to the customer portal, the blog and the "inspi-
ration" online store, and you can always find a
BERNINA dealer near you. The app is available in the
Apple App Store and the Google Play Store.
bernina.com/app

BERNINA Stitchout App
WiFi enabled BERNINA embroidery machines
can be used together with the BERNINA
Stitchout App. Once the machine is connected

to the app, the embroidery process can be tracked and
monitored via the smartphone. The app shows how far
the embroidery design has progressed, which color will
be next and how long the embroidery process will take
in total. Furthermore, messages are displayed for the
case that the thread is broken or the embroidery is
finished. The app is available in the Apple App Store
and the Google Play Store.
bernina.com/stitchout-app

https://www.bernina.com
https://www.youtube.com/BerninaInternational
https://inspiration.bernina.com
https://www.bernina.com/blog
https://www.bernina.com/social-media
https://www.bernina.com/app
https://www.bernina.com/stitchout-app
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2.1 Machine

Front

1

2

3

4

5
6

7

8

1 Embroidery Module Connection   2 Bobbin Cover   3 Needle Area   4 Thread Cutter   5 Thread Take-up Lever
Cover   6 Speaker   7 Connection for Slide-on Table   8 Knee Lifter Connection  

Needle Area

4
5

6

3

8
7

2

1

1 Needle Threader   2 Lighting   3 Needle Holder  
4 Needle   5 Presser Foot   6 Connection for Sewing
Accessories   7 Stitch Plate   8 Feed Dog  

Bobbin Area

1 2

3

4

1 Bobbin Case   2 Thread Cutter   3 Bobbin Case
Holder   4 Bobbin Thread Indicator  
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Right Side

4
5
6
7
8

1

2
3

1 Magnetic Holder for Touchscreen Pen   2 Handwheel   3 Air Vents   4 Power Switch   5 Connection for Power
Cable   6 USB Port, Type C   7 USB Port, Type A   8 Connection for Foot Control  

Back

10

12
11

13

14

1

2

3
4
5

8

7

6

9

1 Air Vents   2 Connection for Multiple Spool Holder   3 Spool Pin Unit, Vertical   4 Spool Pin, Horizontal   5 Bobbin
Winding Unit with Thread Cutter   6 Retractable Thread Guide   7 Carry Handle   8 Thread Guide, Winder  
9 Opening for Thread Lubrication Unit   10 Thread Guide, Rear   11 Connection for Accessory   12 BSR Connection  
13 BERNINA Dual Feed   14 Connection for Darning Hoop  
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Controls

3

4

1

2

1 External Buttons above the Needle   2 Left Controls   3 Display   4 Right Controls  

External Buttons above the Needle

2

4

5

1

3

1 Automatic Needle Threader   2 Start/Stop   3 Thread
Cutter   4 Presser Foot Up/Down   5 Quick Reverse  

Thread Cutter
You can use the Thread Cutter   button to cut the
upper thread and the bobbin thread automatically.
If necessary, the machine is stopped, the needle and
presser foot are lowered, the upper thread and lower
thread are cut.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Automatic Needle Threader

You can use the Automatic Needle Threader 
button to thread the needle automatically.
The Start/Stop   button is deactivated and lights up
red. The upper thread is threaded into the needle.
If the needle is in the incorrect position, the needle will
first be moved to the correct position.

Start/Stop
You can use the Start/Stop   button to start or stop
the machine.
n Lights up green when the machine is ready.
n Lights up red when the machine is not ready.
n Does not light up when the machine is sewing or

embroidering.

Presser Foot Up/Down
You can use the Presser Foot Up/Down   button to
raise or lower the presser foot.
Depending on the starting position, the presser foot is
either raised all the way up or lowered to the hover
position.
You can define the hover position height in the
Settings.
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Quick Reverse
You can use the Quick Reverse   button to sew in
reverse while the button is pressed.
In the Settings, you can program whether the Reverse
option or the Backstep option should be executed.
In the following applications, you can program the
length by pressing the Quick Reverse   button:
n Buttonhole Programs
n Darning Programs
n Tapering Stitches
n Stitch Counter Program
n Stitches with Securing Program

Left Controls

1 2

3

4

5

1 Needle Position Up/Down   2 Securing   3 Pattern
Begin   4 Pattern End   5 Speed Control  

Securing
You can use the Securing   button to sew a
programmable number of securing stitches.
If you press the button before sewing, securing stitches
will be sewn at the beginning of the seam.
If you press the button during sewing, securing stitches
will be sewn immediately and the machine will stop.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Needle Position Up/Down
You can use the Needle Position Up/Down   button
to raise or lower the needle.
Depending on the starting position, the needle will be
raised or lowered. If the presser foot is raised, the
presser foot will first be lowered.

Pattern Begin
You can use the Pattern Begin   button to return to
the beginning of a stitch pattern or a stitch pattern
combination.

With some functions, e.g., buttonholes, darning,
tapering, the machine starts the pattern at the first
segment.

Pattern End
You can use the Pattern End   button to stop the
machine automatically at the end of a stitch pattern or
a stitch pattern combination.
If you press the button before sewing, the button is
activated and the Stop   icon is displayed in the stitch
preview.
If you press the button during sewing, the machine will
stop at the end of the pattern. If the machine is
stopped in the middle of a pattern the pattern will
complete when sewing is resumed. If Repeat   has
been set, the machine will stop at the end of the set
repeat.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Speed Control
You can use the speed control to regulate the sewing
speed.
Limit the maximum speed in Settings for more control
while sewing.

Right Controls

1

2

3

1 Upper Multi-function Knob   2 Lower Multi-function
Knob   3 Needle Position Left/Right  

Upper Multi-function Knob
You can use the Upper Multi-function Knob for setting
the Stitch Width and the values of a function.

Lower Multi-function Knob
You can use the Lower Multi-function Knob for setting
the Stitch Length and the values of a function.
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Needle Position Left/Right
You can use the Needle Position Left/Right 
buttons to move the needle to the left or to the right.
The needle position is shown on the sewing screen.
Negative values indicate a movement to the left,
positive values a move to the right.

2.2 Accessories
Further information and application notes on
the supplied and optional accessories can be
found under:

www.bernina.com/990#!accessories

Included Accessories

Accessories Purpose

Dust Cover To protect the machine from dust
and contamination.

BERNINA Acces-
sories Box

To store supplied and optional
accessories.

Power Cable To connect the machine with the
power supply.

Accessories Purpose

Foot Control To start and stop the machine.

To control the sewing speed.

Slide-on Table To increase the sewing surface.

Seam Guide for
Slide-on Table

To aide in guiding the fabric
along the Slide-on Table.

Knee Lever/Free
Hand System (FHS)

For raising and lowering the
presser foot free hand.

Retractable Thread
Guide

To guide the thread correctly
when threading.
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Accessories Purpose

Touchscreen Pen For precise operation of the
touchscreen.

Spool Cap D12 Secures the thread spool in place
and allows it to unwind
consistently while sewing.

Spool Cap D27 Secures the thread spool in place
and allows it to unwind
consistently while sewing.

Spool Cap D43 Secures the thread spool in place
and allows it to unwind
consistently while sewing.

4× Foam Pad The foam pad prevents the thread
from slipping, tangling or
breaking on the spool pin.

Spool Stabilizer To support large spools on the
vertical spool holder.

To avoid vibrations from the
spool.

Accessories Purpose

Thread Spool Net To regulate threads that unwind
too quickly from the spool, e.g.
nylon, rayon, silk or metallics.

5× Bobbin for B9/
BERNINA Hook

To wind the bobbin thread.

Straight and
CutWork Stitch
Plate with Sensor

For straight stitch and embroidery
projects.

For CutWork and CrystalWork
projects.

5.5 mm BSR Stitch
Plate with Sensor

For sewing with the BERNINA
Integrated Stitch Regulator (BISR).

Height Compen-
sation Tool

To level an angled position of the
presser foot sole when sewing
over thick seams.
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Accessories Purpose

Seam Ripper To undo seams and to cut
buttonholes open.

Right Seam Guide To align even seam distances.

Needle Assortment For the most common sewing
applications.

Brush To clean the feed dog and the
bobbin area.

Screwdriver, red,
slot

To loosen and tighten slotted
screws.

Accessories Purpose

Screwdriver, gray,
Torx

To change the needle.

Thread Lubrication
Unit

For sewing and embroidering
metallic threads.

Sewing Machine
Oil

To oil the machine.

USB Stick To save and transfer data, stitch
and embroidery designs and
update files.

Sewing Thread Set For sewing.
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Included Presser Feet

Presser Foot Purpose

Reverse Pattern
Foot #1C

For practical and decorative
stitches. To sew forward and in
reverse.

For materials such as corduroy,
denim or wool.

Reverse Pattern
Foot #1D

For practical and decorative
stitches. To sew forward and in
reverse.

For materials such as corduroy,
denim or wool.

Use only with the BERNINA Dual
Feed.

Overlock Foot #2A For visible seams on stretch
fabrics.

For overlock and neatening
seams.

Buttonhole Foot
with Slide #3A

For automatic buttonholes with a
maximum length of 30 mm, with
or without cord.

Buttonhole
Foot #3C

For the sewing of manual and
stitch counted buttonholes, with
or without a filler cord.

For gathering using thread or
elastic thread (smocking).

Presser Foot Purpose

Zipper Foot #4D For sewing in zippers, topstitching
next to raised seams.

For sewing on braids, piping and
hook and loop fastener.

Use only with the BERNINA Dual
Feed.

Blindstitch Foot #5 For sewing blindstitch hems,
edgestitching and topstitching on
either side of the foot.

Button Sew-On
Foot #18

For attaching buttons and hooks.

Open Embroidery
Foot #20C

For decorative sewing applications
and stitch patterns.

Sideways-Motion
Foot #40C

For sewing Sideways Motion
patterns and stitches in various
directions.
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Presser Foot Purpose

BERNINA Stitch
Regulator
(BSR) #42

Regulates the stitch length while
free-motion quilting, thread
painting and free-motion
embroidery on all fabrics.

Embroidery Module

2

1

4
3

3

1 Embroidery Arm   2 Coupling for Securing the Hoop  
3 Guide Rails   4 Connection to the Machine  

Included Embroidery Accessories

Accessories Purpose

Dust Cover To protect the Embroidery
Module from dust and
contamination.

Embroidery
Foot #26L

For embroidering, darning and
free hand quilting.

Accessories Purpose

Giant Hoop (incl.
embroidery
template)

To embroider embroidery designs,
embroidery design combinations
or endless embroidery.

Max. Embroidery Area: 305 × 410
mm (12.0 × 16.1 in)

Large Oval
Embroidery Hoop
(incl. embroidery
template)

For embroidering designs and
design combinations.

Max. Embroidery Area: 145 × 255
mm (5.7 × 10.0 in)

Medium
Embroidery Hoop
(incl. embroidery
template)

For embroidering designs and
design combinations.

Max. Embroidery Area: 100 × 130
mm (3,9 × 5,1 in)

Small Embroidery
Hoop (incl.
embroidery
template)

To embroider small embroidery
designs.

For free arm embroidering with
closed sewing projects such as
sleeves, trouser legs or socks.

Max. Embroidery Area: 72 × 50
mm (2.8 × 2.0 in)
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Accessories Purpose

6x Template Holder To fix the template in the
embroidery hoop.

4x Fabric Clamp For fixing the fabric to the outer
frame of the Giant Hoop.

Embroidery Needle
Assortment

For embroidering.

Thread Spool Net To regulate threads that unwind
too quickly from the spool, e.g.
nylon, rayon, silk or metallics.

High Thread
Tension Bobbin
Case

Increase the lower thread tension
for machine embroidery and free-
motion quilting.

Accessories Purpose

Embroidery Thread
Set

For embroidering.

2.3 User Interface Overview

User Interface Operation

Operation with Touch Gestures
The software can be operated with the touch-sensitive
screen using touch gestures or the included touch-
screen pen.

Gestures with
One Finger

Application

Tap n Select functions, stitch
pattern or embrodery
design

Tap and Hold n Open context menu in the
File Manager and
Embroidery Design
Overview

Drag n Scrolling in menus,
windows and bars

n Draw stitches in the Stitch
Designer

n Move Hoop View

Tap and Hold and
Drag

n Move or delete selected
stitches in Combi Mode

n Move selected layers in
Embroidery Mode

n Delete layers from the
layer bar in Embroidery
Mode
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Gestures with
Two Fingers

Application

Move Apart n Zoom the preview in, e.g.
in the Stitch Designer

Move Together n Zoom the preview out,
e.g. in the Stitch Designer

Operation with Mouse
You can also operate the user interface with a mouse
connected into a USB connection.
n Single Left-click

A single left-click works in the same way as tapping
with a finger throughout the entire user interface.
You can click to select elements, menus and
windows.

n Left-click and Hold
By pressing and holding the left mouse button on
an embroidery design, you can open the context
menu.
By pressing and holding the left mouse button on a
stitch pattern or embroidery design in the file
manager, you can display further information
about the stitch pattern or embroidery design.

n Right-click and Hold and Move
By holding down the right mouse button and
moving the mouse, you can move the preview in
the Embroidery Screen, in the Stitchout and in the
Stitch Designer.

n Mouse Wheel
You can use the mouse wheel to zoom and scroll in
the Sewing and Embroidery Screen, in the
Stitchout, in the Stitch Designer, in the File
Manager and other screens with a scroll bar.

Navigation
To go back step by step to a previous screen use the
Navigation Path located on the Navigation Bar. Find
Navigation Paths in the Help Center, Settings and File
Manager. With the Back  function, you can go
back step by step.

Activating/Deactivating Functions
You can switch functions on and off as follows:
n Tap the Switch

n Green: Function is switched on.

n White: Function is switched off.

n Tap Icons

n Blue: Function is switched on.

n Gray: Function is not available.

n Yellow Bar: Function or value deviates from the
default value.

n Red: Warning.

Setting Values
You can set values as follows:
n Slider

Set the value with the slider control or reset the
value to the default by tapping the small bullet.

n Plus and Minus Icons

n Multi-function Knobs

The knob icon that appears solid white identifies
which knob modifies the value.

Modified values are marked in yellow. You can reset a
modified value to the default by tapping the yellow
field.

Selection Options
With the Selection Options   function, you can
define whether you want to select an individual object,
multiple objects or all objects.

1 32

1 Single Selection   2 Multiple Selection   3 Select All  
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Home Screen

Main Menu   ► Home Screen 

1 3 4 5 62

1 Sewing   2 BERNINA Integrated Stitch Regulator  
3 Embroidery   4 Help Center   5 Settings   6 Main
Menu  

Modes

The main modes give you quick access to the most
important functions of your machine.

Sewing
In Sewing   mode, you will find the functions you
need for practical and creative sewing. [} see
page 49]

BERNINA Integrated Stitch Regulator
In BERNINA Integrated Stitch Regulator   mode,
you can sew and quilt with the integrated stitch
regulation. [} see page 72]

Embroidery
In Embroidery   mode, you will find functions for
creative machine embroidery and computerized
quilting. [} see page 79]

Help Center
In Help Center   mode, you will find frequently
requested instructions and information, the Onboard
Manual and Creative Consultant for various sewing,
embroidery and quilting techniques. Connect to your
device with WiFi connectivity to use the Help Center on
an external device. [} see page 24]

Settings
In Settings   mode, you can adjust various functions
in sewing and embroidery, carry out simple
maintenance operations and update the machine
firmware.

Main Menu

The Main Menu provides shortcuts to quickly navigate
to the following modes from any screen.

Home Screen
Main Menu   ► Home Screen 

With the Home Screen   menu entry, you can return
to the Home Screen. [} see page 22]

Clear
Main Menu   ► Clear 

The Clear   menu entry resets the following settings
to the default values:

Sewing Mode

n Stitch Length and Stitch Width of the Selected
Stitch

n Needle Position
n Mirroring
n Long Stitch
n Pattern Repeat
n Balance
n Directional Sewing
n Jumbo Stitch
n Stitch Density
n Upper Thread Tension
n Programmed Buttonhole Length
n Darning Program Settings
n Tapering Stitches
n Backstepping
n Stitches with Stitch Counter
n Presser Foot Selection

Embroidery Mode

n Design Position
n Rotation
n Scaling
n Mirroring
n Stitch Density
n Presser Foot Selection
n Shape Designer
n Thread Color Modifications

Quick Help
Main Menu   ► Quick Help 

With the Quick Help   function, you can tap any
screen element and receive help on its use. [} see
page 24]
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Lock
Main Menu   ► Lock 

With the Lock   function, you can lock the screen and
the sewing functions. With the Lock Sewing
Functions function, the motor will be blocked and the
machine cannot be started.

1. To lock the screen, tap Lock  .
2. To unlock the screen, swipe up and tap Unlock  .

Settings
Main Menu   ► Settings 

With the Settings   function, you can open the
Settings directly. [} see page 44]

Sewing
Main Menu   ► Sewing 

With the Sewing   function, you can open sewing
mode. [} see page 49]

BERNINA Integrated Stitch Regulator
Main Menu   ► BERNINA Integrated Stitch
Regulator 

With the BERNINA Integrated Stitch Regulator 
menu entry, you can open the BISR Mode. [} see
page 72]

Embroidery
Main Menu   ► Embroidery 

With the Embroidery   function, you can open
embroidery mode. [} see page 79]

Help Center
Main Menu   ► Help Center 

With the Help Center   function, you can open the
Help Center. [} see page 24]

File Management

In the File Manager, you can manage your own stitch
patterns and designs in the Personal Folder   and
USB Stick   folders. You can create folders and move,
copy, rename and delete files and folders.

Renaming a File or Folder

1. Tap the Fullscreen   icon in the toolbar to
display the management options.

2. Tap the Selection   icon.
3. Tap the desired object.

ð The object is marked with a check mark.
4. Tap the Options   Rename icon.
5. Enter the name and confirm.

Copying or Moving a File or Folder

1. Tap the Fullscreen   icon in the toolbar to
display the management options.

2. Tap the Selection   icon.
3. Tap the desired objects.

ð The objects are marked with a check.
4. Tap the Options  ► Copy or Options  ► Cut

icons.
5. Navigate to the target folder.
6. Tap the Options  ► Paste icon.

ð As soon as the process is complete, a message
appears.

Delete Files or Folder

1. Tap the Fullscreen   icon in the toolbar to
display the management options.

2. Tap the Selection   icon.
3. Tap the desired objects.

ð The objects are marked with a check.
4. Tap the Options  ► Delete icon.
5. Confirm the query.
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2.4 Help and Consultant

Quick Help

Main Menu   ► Quick Help 

You can use the Quick Help   function to open the
Quick Help for many screen elements, such as icons,
buttons or entire screen areas.

1. Tap the Quick Help   menu item.
2. Tap the screen element for which help is required.

ð The Quick Help for the screen element appears.
ð If there is further information on the screen

element in the operating instructions, a link is
displayed that calls up the Help Center.

Help Center

Quick Start

Main Menu   ► Help Center   ► Quick Start 

1 2 3

1 Search   2 Navigation Bar   3 Selection of Topics  

You can use the Quick Start   function to access
frequently searched instructions and information.

Instruction Manual

Main Menu   ► Help Center   ► Instruction
Manual 

1 2 3 4 5

1 Search   2 Navigation Bar   3 Table of Contents  
4 Content Area   5 QR Code  

You can use the Instruction Manual   function to
access the contents of your machine's user manual.
If your tablet is on the same WiFi network as your
machine, you can display the content on the tablet by
tapping the QR Code icon and scanning the QR code.

Consultant

Main Menu   ► Help Center   ► Consultant 

1 32 4 5 6 7 8

1 Search   2 Navigation Bar   3 Fabric Selection  
4 Supplies   5 Preparations   6 Tutorial   7 QR Code  
8 Apply Settings  

You can use the Consultant   function to obtain
recommendations for preparing and setting the
machine and corresponding tutorials for various
sewing, embroidery and quilting techniques. Settings
with a white circle can be applied automatically using
Apply Settings   icon.
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If your tablet is on the same WiFi network as your
machine, you can display the content on the tablet by
tapping the QR Code icon and scanning the QR code
on the machine's screen.
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3.1 Prior to Machine's First Use

TIP

BERNINA recommends lubricating the hook before
using the machine for the first time or after a longer
period of non-use. [} see page 100]
Lubricating the hook keeps the machine running
smoothly and quietly.

Removing the Protective Film on the
Battery
Your BERNINA 990 contains a battery, which ensures
that the clock continues to run, even if the machine is
switched off and disconnected from the power supply.
The protective film must be removed before the battery
can be used.

1. Carefully set down the machine on its back.
2. Pull the protective film on the battery out of the

battery compartment.

3. Set Up the machine.

3.2 Working Area
A stable table with a secure stand is a good prereq-
uisite for optimal sewing results. Ergonomics of the
sewing table is important to protect the muscles and
joints of the back, shoulder, arms and hands. The
recommendation for optimal ergonomics includes
matching the table height with the body posture. Avoid
remaining in the same position for long periods.
The machine can also be operated when standing.

Correct Sitting Position
With the arms bent (90°), the fingertips can touch the
stitch plate in a comfortable sitting position.

3.3 Connecting the Machine and
Switching it On

1. Insert the cable into the machine.

2. Insert the power plug of the power cable into the
socket.

3. Switch on the machine using the power switch.

3.4 Preparing the Machine for
Sewing
For your sewing project, you must prepare and set the
machine accordingly.

Prerequisite:
n The machine is switched on.
n The sewing settings have been made. [} see

page 45]
n The foot control is connected. [} see page 27]

1. Attach the Slide-on Table if required. [} see
page 28]

2. Attach the Knee Lifter. [} see page 29]
3. If the Embroidery Module is connected and is not

to be removed, move the embroidery hoop to the
sewing position. [} see page 43]

4. Remove the embroidery hoop. [} see page 43]
5. Select Sewing Mode via the main menu or the

Home Screen. [} see page 22]
ð The Sewing Screen appears. [} see page 49]

6. Use a suitable stitch plate. [} see page 30]
7. Use a suitable sewing needle. [} see page 33]
8. Attach and select a suitable presser foot. [} see

page 41]
9. Prepare and edit stitch pattern. [} see page 61]
10. Thread a suitable bobbin thread. [} see page 39]
11. Thread a suitable upper thread. [} see page 34]
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TIP

For special sewing techniques and fabrics, the
Consultant will recommend a presser foot, stitch
plate and needles as well as fabrics and sewing
settings. [} see page 24]

3.5 Preparing the Machine for
Embroidery
For your embroidery project you must prepare and set
the machine accordingly.

Prerequisite:
n The machine is switched on.
n The embroidery settings have been made. [} see

page 47]

1. Select Embroidery Mode via the main menu or the
Home Screen. [} see page 22]
ð The Embroidery Screen appears. [} see

page 79]
2. Remove the Knee Lifter.
3. Insert the Straight Stitch Plate. [} see page 30]
4. Insert a suitable embroidery needle. [} see

page 33]
5. Attach and select a suitable embroidery foot. [} see

page 41]
6. Attach the Embroidery Module. [} see page 42]
7. Attach the suitable hoop. [} see page 43]
8. Prepare and edit embroidery designs. [} see

page 83]
9. Thread a suitable bobbin thread. For a higher

bobbin thread tension, use a bobbin case with a
high thread tension. [} see page 39]

10. Thread a suitable upper thread. [} see page 34]

TIP

For special embroidery techniques and fabrics, the
Consultant will recommend an embroidery foot,
stitch plate and needles as well as fabrics and
embroidery settings. [} see page 24]

3.6 Foot Control
You can operate the front foot control with the ball of
your foot and the rear foot control with your heel. By
pressing with the ball of your foot, you can start and
stop the machine and control the speed with the
amount of force applied to the control. By pressing

with your heel, you can raise or lower the needle or
execute further functions. You can configure the
functions in the Sewing Settings. [} see page 46]

Connecting the Foot Control

1. Unwind the cable of the foot control to the desired
length.

2. Insert the plug of the cable into the foot control
socket of the machine.

3. Place the Foot Control on the floor in a
comfortable position for sewing.

4. If the cable is too long, roll up excess length.

3.7 Storing Accessories
The accessories box provides tidy storage for your
accessories.

1 2 3 4

5

6

7

1 Holder for Needle Sets   2 Holder for Presser Feet
without Lens   3 Bobbin Holder with Spring Button  
4 Compartment for Buttonhole Foot with Slide #3A  
5 Holder for Presser Feet with Lens   6 Drawer, Small  
7 Drawer, Large  
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1. Unfold the feet and stand up the accessories box.
2. Open the doors.

3. If necessary, insert the holders into the grooves in
the accessories box.

  NOTICE

Incorrect storing of the bobbin
Scratched or dirty sensor surfaces on the bobbins can
cause malfunctions of the lower thread indicator.
► Always position the bobbins in the bobbin holder

with the silver sensor surface to the right.

4. Place your accessories in the appropriate holders
and compartments.

5. To remove a bobbin, press the spring button down.
6. Store small parts in the drawers.

3.8 Slide-on Table
You can use the Slide-on Table to increase the sewing
area. This makes it easier to position and work on your
sewing project. The viewing window allows for visual
access to the bobbin area while changing the bobbin
without having to remove the table. The table has a
printed ruler in both centimeters and inches to aide in
aligning various projects. The zero center is aligned
with the center needle position when attached.

4

1
2
1
3

1

1 Adjustable Leg with Adjusting Screw   2 Viewing
Window   3 Ruler   4 Release Button  

Attaching the Slide-on Table

1. Raise the needle.
2. Raise the presser foot.
3. Release the adjustable legs on the Slide-on Table.

Make sure that the adjusting screws are not turned
out too far.

4. Slide the table over the freearm under the needle
and foot to the right until it engages on the right
side.

5. Fully extend the legs of the table.



My BERNINA

3 Set Up the machine 29

6. Adjust the height by turning the screw at the feet.
Ensure the table is flat and supported on the
surface below without raising it above the freearm.

7. To remove the Slide-on Table, press the release
button down and remove the Slide-on Table from
right to left under the needle and presser foot.

8. Lock the legs into place for storage.

Using the Seam Guide

The Seam Guide for the Slide-on Table allows you to
sew along the guide for unifom seams.

1

1 Release Button  

Prerequisite:
n The Slide-on Table is attached.

1. To attach the Seam Guide, press the release button
and engage the Seam Guide from the front to the
back on the Slide-on Table.

2. Press the release button down once attached and
position in place as desired.

3. To remove the Seam Guide, press the release
button and pull the Seam Guide away to the front.

3.9 Knee Lifter / Free Hand
System
With the Knee Lifter, you can raise and lower the
presser foot without taking your hands away from your
sewing project.
If the presser foot is raised, you can also lower the
presser foot using the Knee Lifter.

Working with the Knee Lifter offers the following
advantages:
n When the presser foot is raised with the Knee

Lifter, the feed dog is lowered at the same time
and the thread tension is released, enabling you to
easily move or remove your sewing project.

n When the presser foot is lowered with the Knee
Lifter, the feed dog is raised and, if necessary, the
thread tension is activated, enabling you to simply
continue sewing.

Using the Knee Lifter

Attaching the Knee Lifter of the Free Hand System

1. Insert the Knee Lifter into the Knee Lifter
Connection as far as it will go.

2. Adjust the sitting height so that the Knee Lifter can
be comfortably operated with the knee.
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TIP

The lateral position of the lever can be adjusted by
your local BERNINA dealer if required.

Raising the Presser Foot

1. Push the Knee Lifter to the right and hold it there
with your knee.
ð The presser foot is raised and the feed dog is

lowered.
2. Release the Knee Lifter slowly to lower the presser

foot.
ð The presser foot is lowered and the feed dog is

raised.

Lower the Presser Foot

► When the presser foot is raised, push the Knee
Lifter all the way to the right and slowly release it.
ð The presser foot is lowered, the feed dog is

raised and the thread tension is activated.

3.10 Stitch Plate
The supplied 9-mm Stitch Plate is suitable for most
sewing applications. For specific applications, e.g.
PunchWork, special stitch plates are used. The special
stitch plates are marked with a color code.
n Without color code: 9 mm Stitch Plate
n Orange: Straight and CutWork Stitch Plate
n Yellow: PunchWork Stitch Plate
n Blue/purple: 5.5 mm BISR Stitch Plate

Vertical lines are engraved on each stitch plate, which
you can use as a ruler for guiding the fabric in a
straight line. You can use the diagonal lines to align the
fabric at a precise 45° angle. You can use the
horizontal lines to lay the fabric at the specified
distance from the needle.

2
3

1

5

4

6

7

1 Pressure Point for Release   2 Fabric Placement  
3 Needle Position   4 Ruler in cm   5 Ruler in inches  
6 Color Code   7 Sensor  

Changing the Stitch Plate

Prerequisite:
n The needle and the presser foot are raised.

1. Lock screen and sewing functions.
2. Remove the needle and presser foot.
3. Press the stitch plate down at the pressure point for

release on the right until it tips.

4. Remove the stitch plate.
5. Place the openings of the new stitch plate above

the corresponding guide pins and press the stitch
plate down until it clicks into place.

6. Unlock sewing functions and screen.
ð The machine recognizes the new stitch plate

and displays it in the Status Bar.
ð The machine checks the compatibility of the

stitch plate with the attached needle and the
selected stitch. If the stitch cannot be sewn
with the attached stitch plate, the stitch is
shown in red in the stitch preview and the
machine will not start.



My BERNINA

3 Set Up the machine 31

3.11 Needle
Only use needles from the 130/705 system for your
machine. Select a needle thickness that is suitable for
the selected fabric: Fine needles for fine fabrics, thick
needles for heavy fabrics.
n Needle sizes 70, 75: Lightweight fabrics
n Needle sizes 80, 90: Medium fabrics
n Needle sizes 100, 110 and 120: Heavyweight

fabrics

There are different needle types for different sewing
projects. You can identify the needle type and needle
size by the needle name, e.g. 130/705 H-S/70:

1 2 5 3 4

1 705 = Flat Shank   2 130 = Shaft Length   3 H =
Needle Scarf   4 S = Point Type   5 70 = Needle Size  

Detailed information on needles and their applications
can be found in the BERNINA Needle Brochure.
Needles become worn over time. Needles should be
replaced regularly, as a clean stitch can only be made
with a sharp tip.

Needle/Thread Combination

The needle/thread combination is correct if
the thread is guided exactly into the long
groove and through the eye of the needle.

If the thread is too thin for the needle, it will
have too much room to move in the long
groove and in the eye of the needle. This
can result in the thread breaking or skipping
stitches.

If the thread is too thick for the needle, it
will be difficult to guide it through the eye
of the needle and it may rub along the edge
of the long groove. This can result in the
thread breaking and sticking in the needle.

Needle Overview

Needle Purpose

Universal Needle
130/705 H
60/8 – 120/19

With a slightly
rounded point.

For woven fabrics (light,
medium, heavy-weight),
knitwear, leather, vinyl, jeans/
denim. For natural and
synthetic fabrics.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Stretch Needle
130/705 H-S
75/11 – 90/14

With a medium ball
point.

For knitwear (jersey, tricot,
knit and stretch material).
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery.

Jersey/
Embroidery
Needle
130/705 H SUK
80/12

With a medium ball
point.

For woven fabrics (light,
medium, heavy-weight),
knitwear, vinyl.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery.

Jeans Needle
130/705 H-J
80/12 – 110/18

With a slim sharp
point.

Woven fabrics (light, medium,
heavy-weight), leather, jeans/
denim.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Leather Needle
130/705 H LR
90/14, 100/16

With cutting tip.

For leather, imitation leather
and similar materials.
For zippers, hems and
topstitching, materials that
tend to stick.
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Needle Purpose

Sharp Microtex
Needle
130/705 H-M
60/8 – 110/18

With a very slim
sharp point.

For woven fabrics (light,
medium, heavy), plastics,
materials that are difficult to
glide such as silk, microfiber
fabrics, vinyl, coated materials.
For general sewing, sewing on
buttons and buttonholes, zips,
hems and topstitching and
decorative sewing. For straight
stitches when topstitching
edges.

Quilting Needle
130/705 H-Q
75/11 – 90/14

With a very slim,
slightly rounded
point.

For woven fabrics (light,
medium and heavy-weight).
Decorative sewing,
patchwork, quilting. For
stitching/topstitching tasks,
such as quilting and
patchwork.

Embroidery
Needle
130/705 H-E
75/11 – 90/14

With a light ball
point and a partic-
ularly wide eye and
wide groove.

For woven fabrics (light,
medium, heavy-weight),
knitwear. For thicker threads.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery.

Fine Fabrics
Needle
130/705 H SES
70/10 – 90/14

With a light ball
point.

For fine, delicate materials,
such as velvet.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Metafil Needle
130/705 H METAFI
L
80/12

With medium ball
point and long eye
(2 mm).

For woven fabrics (light,
medium, heavy-weight),
knitwear. For sewing with
special effects and fancy
threads, especially metallic
threads.
For embroidery with metallic
thread. For hems and
topstitching, decorative
sewing and embroidery.

Needle Purpose

Topstitch Needle
130/705 H-N
80/12 – 100/16

With medium ball
point and long eye
(2 mm).

For woven fabrics (light,
medium and heavy-weight).
For hems and topstitching,
decorative sewing and
embroidery. For decorative
and quilting work with several
sewing threads and also for
embroidery.

Felting needle
PUNCH

With small barbs.

For woven fabrics (light,
medium, heavy-weight), jeans/
denim.
For felting a variety of yarns
and threads into base fabrics.

Hemstitch
Needle
130/705 H WING
100/16, 120/20

With a "wing" on
each side of the
needle.

For woven fabrics (light,
medium and heavy-weight).
For special effects in
decorative sewing and
embroidery with hemstitching.

Universal Twin
Needle
130/705 H ZWI
70-100

Needle distance:
1.0/ 1.6/ 2.0/ 2.5/
3.0/ 4.0/ 6.0/ 8.0

For visible hems in stretch
fabrics, pintucks, decorative
sewing.

Stretch Twin
Needle
130/705 H-S ZWI
75

Needle distance:
2.5/ 4.0

For visible hems in stretch
fabrics, pintucks, decorative
sewing.
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Needle Purpose

Hemstitch Twin
Needle
130/705 H ZWIHO
100

Needle distance:
2.5

For special effects with
hemstitch embroidery.

Universal Triple
Needle
130/705 H DRI
80

Needle distance:
3.0

For visible hems in stretch
fabrics, decorative sewing.

Changing the Needle

1. Raise the needle.
2. Lock screen and sewing functions.
3. Loosen the screw on the needle using the gray Torx

Screwdriver and pull the needle out in a downward
direction.

4. Insert and push the new needle with the flat side to
the back as far up as it will go into the needle
holder and hold it in place.

5. Tighten the screw.
6. Unlock sewing functions and screen.
7. In the Status Bar, tap Stitch Plate and Sewing

Needle   and select the fitted needle in the
Needle Overview section. [} see page 33]

Stitch Plate and Sewing Needle

Sewing   ► Stitch Plate and Sewing Needle 

1 2 3 4 5 6

1 Detected Stitch Plate   2 Selected Needle   3 Needle
Overview   4 Stitch Plate Overview   5 Needle Minder  
6 View Recommended  

The attached Stitch Plate is automatically recognized
and shown in the Status Bar and in the Detected
Stitch Plate section.
The stitch plates and needles compatible with the
machine are displayed in the Stitch Plate Overview
and Needle Overview sections.
Recommended stitch plates and needles are shown
with the Recommended   icon.
In order to verify the compatibility of the stitch plate,
presser foot and needle, you must select the attached
needle in the Needle Overview section. The selected
needle is shown in the Selected Needle section and in
the Status Bar. If the selected needle can no longer be
used with the stitch plate or the presser foot, an error
message is dsiplyed.

Recommended
With the Recommended  function, you can filter
the overview by recommended stitch plates and
needles.

Needle Minder
With the Needle Minder   function you can note the
needle type and needle size of the attached needle. If
you have forgotten which needle is attached, you can
look it up at any time.
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Needle Position

You can adjust the position of the needle in various
ways.

n Button Needle Position Up/Down  : Raise or
lower the needle.

n Buttons Needle Position Left/Right  : Move the
needle five positions to the left or to the right of
the center.

n Status icon Needle Stop  : Modify the needle
position when the machine is stopped.

3.12 Attaching the Retractable
Thread Guide
BERNINA recommends using the two left vertical spool
pins for sewing and stitching in conjunction with the
retractable thread guide. The retractable thread guide
ensures a clean unwinding of the thread from the
spools.

1. Insert the retractable thread guide into the opening
provided and press it down firmly until it sits
securely.

2. Flip over the guide and engage it in the groove.
Align the thread guide in such a way that the three
rear eyelets lie exactly above the three vertical spool
pins.

3. Pull the thread guide up as far as it will go. While
doing so, rotate the rod slightly so that the locking
cams engage.

3.13 Upper Thread
The quality, thickness and material of the thread must
be suitable for the selected fabric. BERNINA
recommends purchasing high-quality threads to
achieve optimum sewing results.
n Cotton threads are particularly suitable for sewing

decorative projects on cotton fabric, such as quilts.
As cotton threads are not particularly tear-resistant,
they can also be used for basted seams that are
later undone. They should not, however, be used
for seams that need to be particularly hard-
wearing.

n Mercerized cotton threads have a slight sheen that
remains even after washing.

n Polyester threads have a high tensile strength and
are particularly colorfast. Polyester threads are more
flexible and are recommended where a strong and
elastic seam is required.

n Rayon/viscose threads are characterized by their
bright sheen. Rayon threads are suitable for
decorative stitches and create a more beautiful
effect.

Threading the Single Needle

In order to get a proper stitch and prevent threads from
becoming tangled, the upper thread must be threaded
correctly.
The direction in which the thread should be threaded is
marked on the machine with solid arrows and is
numbered according to the correct sequence.

Prerequisite:
n The retractable thread guide is attached. [} see

page 34]
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n A foam pad is attached to each of the vertical spool
pins.

1. Raise the presser foot so that the thread tension
discs are open and the thread can slide easily
between them.

2. Raise the needle so that the thread can be easily
inserted into the thread take-up lever.

3. Lock screen and sewing functions.
4. Place the spool on the center vertical spool pin.
5. Pull the thread upward and through the two thread

guides lying vertically above it in the thread guide.

6. Guide the thread through the thread eyelet from
right to left.

7. Hold the thread with your right hand and, with
your left hand, pull the thread taut under and
through the thread guide to the front of the
machine.

8. Guide the thread on the right downward past the
thread tension disc.

9. Guide the lower thread upward around the thread
take-up lever cover.

10. Guide the thread through the thread take-up lever
and guide it downward. Make sure that the thread
is guided under the left side panel.
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11. Guide the thread behind the two thread guides in
the needle area.

  NOTICE

Damage to the Automatic Needle Threader or the
Needle
Thin needles can break when using the automatic
needle threader.
The threading hook of the automatic needle threader
can be damaged.
► Only use the automatic needle threader with

needles of size 70 and above.
► Always thread size 60 needles by hand.

12. Guide the thread from back to front around the
thread cutter and trim the thread.

13. Unlock sewing functions and screen.

14. Press the Automatic Needle Threader   button.
ð The thread is threaded into the needle.

Notes on the Automatic Needle Threader
n The Automatic Needle Threader is only suitable for

threading a single needle. Always thread twin
needles and triple needles by hand.

n The Automatic Needle Threader is suitable for
needles of size 70 and above. Thread thinner
needles by hand.

n The Automatic Needle Threader is not compatible
with the following presser feet. If you are using one
of these presser feet, thread the needle by hand.

n Punch Tool #45

n Walking Foot #50

n Leather Roller Foot #55

n Adjustable Ruler Foot #72

n Binder Attachment #85

n Ruffler #86

n Foot for Cut ‘n’ Sew Attachment #90

Threading the Twin Needle

To thread a twin needle, thread both threads one after
the other according to the instructions for the single
needle. Start with the left needle. [} see page 34]
Note the following differences:

Prerequisite:
n A foam pad is attached to each of the vertical spool

pins.

1. Place the spool for the right needle on the center
spool pin and the spool for the left needle on the
left spool pin.

2. Guide both upper threads up to the thread tension
disc in the same way as threading the single
needle.

3. At the thread tension disc, guide the thread for the
left needle down the left and the thread for the
right needle down the right of the thread tension
disc.

4. Guide the threads up to the needle in the same
way as threading the single needle.

5. Thread both needles by hand.
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Threading the Triple Needle

To thread a triple needle, thread the three threads one
after the other according to the instructions for the
single needle. Start with the left needle. [} see
page 34]
Note the following differences:

Prerequisite:
n A foam pad is attached to each of the vertical spool

pins.

1. Place the spool for the left needle on the left spool
pin, the spool for the center needle on the center
spool pin and the spool for the right needle on the
right spool pin.

2. Guide the threads up to the needle in the same
way as threading the single needle.

3. At the thread tension disc, guide the thread for the
left needle down to the left and the threads for the
right and center needle down to the right of the
thread tension disc.

4. Guide the threads up to the needle in the same
way as threading the single needle.

5. Thread all needles by hand.

Threading Special Threads

Special threads such as loosely twined threads and
metallic threads can be difficult to thread and use. The
Thread Lubrication Unit and the special silicone fluid
prevent delicate threads from tearing or breaking and
making them easier to use.

1. Insert the Thread Lubrication Unit in the opening
provided and moisten the felt surfaces with a little
silicone fluid.

2. Insert the thread between the felt surfaces of the
Thread Lubrication Unit.

3. Guide the thread to the needle in the same way as
threading the single needle. [} see page 34]

4. Thread the needle by hand.

Using the Horizontal Spool Pin

On the horizontal spool pin, a foam pad and a spool
cap ensure that the thread is unwound properly. The
foam pad prevents the spool from rotating too quickly.
The spool cap ensures that the spool pin is held in place
and the thread is unwound from the spool without
becoming tangled. Spool caps are available in different
sizes.

1
2
3

1 Foam Pad   2 Thread Spool   3 Spool Cap  

1. Place the foam pad on the spool pin.
2. Place the thread spool on the spool pin.
3. Select a spool cap with the same diameter as the

spool and place it on the spool pin. The spool
should not rotate. The thread should unwind
properly.
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4. For slippery threads put a spool net over the spool
as an additional measure.

5. Guide the thread directly to the rear thread guide
and continue threading. [} see page 34]

3.14 Bobbin Thread
For general sewing, we recommend using the same
thread for the upper thread and the lower thread.
Consult the Creative Consultant for thread recommen-
dations with various applications and fabrics.

Bobbin Winding

The direction in which the bobbin thread should be
spooled is indicated on the machine with broken lines
and numbered accordingly.

1. Place an empty bobbin on the bobbin winder so
that the silver sensor surface is facing downward.

2. Place the spool on the right vertical spool pin.
3. Pull the thread upward and insert it from back to

front in the two thread guide eyelets directly
above.

4. Guide the thread through the thread eyelet from
right to left.

5. Guide the thread around the bobbin winder pre-
tension in the direction of the arrow.
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6. Wind the thread 2 – 3 times around the bobbin in
the direction of the arrow and cut it using the
thread cutter on the engaging lever.

7. Push the engaging lever toward the bobbin.

ð As the bobbin starts to wind, the speed can be
adjusted on the screen.

ð The winding indicator is displayed in the Status
Bar.

ð The winding will stop automatically when the
bobbin is full.

8. To stop before the bobbin is full, simply engage the
lever to the right to pause.

9. Remove the bobbin and cut the thread using the
thread cutter.

Threading the Bobbin Thread

1. Raise the needle.
2. Raise the presser foot.
3. Lock screen and sewing functions.
4. Open the bobbin cover.

5. Press the latch on the right of the bobbin case and
remove the bobbin case.

6. Remove the bobbin from the bobbin case.
7. Insert the new bobbin so that the silver sensor

surface lies inside the bobbin case.

8. Guide the thread through the slot to the left.
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9. Pull the thread through under the spring and under
the two thread guides.

10. When inserting the bobbin case, hold the bobbin
case so that the wire of the thread guide points
upward.

11. Insert the bobbin case. Press the left side of the
bobbin case until the bobbin case engages.

12. Pull the thread over the thread cutter and cut.

13. Close the bobbin cover.

3.15 Presser Foot

Raising/Lowering the Presser Foot

The presser foot is automatically lowered at the start of
sewing.

► Press the Presser Foot Up/Down   button.
ð Depending on the starting position, the presser

foot is either raised or lowered to the hover
position.

TIP

If the presser foot is raised, you can also lower the
presser foot using the Knee Lifter.

Changing the Presser Foot

1. Raise the needle.
2. Raise the presser foot.
3. Lock screen and sewing functions.
4. Press the clamping lever up and pull the presser

foot downward to the side.

1

2

5. Guide the new presser foot into the holder from
below and press the clamping lever down.

6. Unlock sewing functions and screen.
7. Tap the Presser Foot   icon and select in the

Presser Foot Overview the attached presser foot.
[} see page 41]

Attach the BERNINA Stitch Regulator
(BSR)

Prerequisite:
n The screen and sewing functions are locked.
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1. Attach the BSR Presser Foot.

1
2

2. Insert the cable of the presser foot into the BSR
connection.

3. Unlock sewing functions and screen.
ð The BSR Mode function is switched on and

the BSR Settings are displayed.

Presser Foot Selection

Sewing   ► Presser Foot 

1 42 3

1 Selected Presser Foot   2 Search   3 Recommended  
4 Presser Foot Overview  

Presser Foot Selection in the Status Bar recommends
the appropriate Presser Foot based on the currently
selected stitch pattern or embroidery design.
The presser feet compatible with the machine are
displayed in the Presser Foot Overview section.
Recommended presser feet are marked with the
Recommended   icon.
In order for the machine to check the compatibility of
the stitch, presser foot, needle and stitch plate, you
must select the attached presser foot in the Presser
Foot Overview section. The selected presser foot is
shown in the Selected Presser Foot section and in the
Status Bar.
If the stitch pattern or the embroidery design is not
compatible with the selected presser foot, this can lead
to collisions - an error message will appear, the stitch in
the stitch preview is shown in red and the machine
does not start.

Search
With the Search  function, you can search for the
attached presser foot by entering the presser foot
number.

Recommended
With the Recommended  function, you can filter
the overview by recommended presser feet.

Presser Foot Pressure

Sewing   ► Presser Foot Pressure 

The presser foot pressure has a default setting for
working with medium fabrics. When working with
thick fabrics, a reduced presser foot pressure enables
the fabric to be moved more easily beneath the presser
foot. When working with thin fabrics, a higher presser
foot pressure prevents the fabric from slipping easily.
We recommend testing the setting before you start. If
the fabric moves with some resistance, you can reduce
the presser foot pressure. If the fabric slips easily
beneath the presser foot, you can increase the presser
foot pressure.
Help on finding the optimum presser foot pressure for
various fabric types and sewing techniques can be
found in Consultant in the Help Center. [} see page 24]
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3.16 Fabric Feed

Feed Dog

The feed dog moves the fabric under the presser foot.
The feed dog can be lowered for applications in which
the fabric is to be guided freely.
In sewing mode, you can lower and raise the feed dog
manually using the Feed Dog   icon in the Status
Bar. In embroidery, BISR and BSR mode, the feed dog is
lowered automatically.

Dual Feed

The BERNINA Dual Feed feeds the upper fabric while
the feed dog controls the bottom layer. This ensures a
more even feed for many applications, including:
n Sewing seams and zippers
n Managing difficult fabrics such as: velvet, satins
n Matching pattern repeats, stripes and checks
n Knits and Fleece
n Patchwork: Accurate piecing, quilting and binding

Note: The BERNINA Dual Feed can only be used with
presser feet with the designation D.

Switching On/Off the BERNINA Dual Feed

Engaging the BERNINA Dual Feed

1. Raise the presser foot.
2. Attach a D presser foot.
3. Push the dual feed down until it engages.

Disengaging the BERNINA Dual Feed

1. Raise the presser foot.

2. Pull the dual feed downward and let it slide
backward and up.

3.17 Embroidery Module

Connecting and Removing the
Embroidery Module

Connecting the Embroidery Module

Prerequisite:
n The work area is large enough and has sufficient

load-bearing capacity for the machine and the
embroidery module.

n There is enough space for the embroidery arm to
move freely.

1. Lift the embroidery module on the left side.
2. Push and lower the embroidery module carefully

from left to right into the embroidery module
connection of the machine.
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  NOTICE

Lifting or moving the machine when the
Embroidery Module is connected
Damage to the embroidery module connection and
machine.
► Before lifting or moving the machine, detach the

embroidery module.

Removing the Embroidery Module

► Lift the embroidery module on the left side and
carefully pull it to the left.

Preparing the Embroidery Hoop

Prepare the embroidery hoop according to the hoop
instructions. You can download the instructions for
embroidery hoops at www.bernina.com.

Attaching and Removing the Hoop

Attaching the Hoop

1

2

1 Attaching Mechanism   2 Hoop  

1. Raise the needle.
2. Raise the presser foot.
3. Hold the hoop with the right side of the fabric up

with the attaching mechanism to the left.
4. Position the hoop below the presser foot.

5. Squeeze both attaching mechanisms of the hoop
towards each other.

6. Position the embroidery hoop above the bracket of
the embroidery arm.

7. Press the hoop down until it clicks in position.
8. Release the attaching mechanism.
9. Select the embroidery hoop on the machine. [} see

page 43]
10. Before using the embroidery hoop for the first time

or if the needle position and the center of the
embroidery hoop are not aligned, calibrate the
embroidery hoop on the machine. [} see page 48]

Removing the Embroidery Hoop

1. Squeeze both attaching mechanisms of the hoop
towards each other.

2. Remove the hoop.

Hoop Overview
Embroidery   ► Hoop 

1 2 3

1 Selected Hoop   2 Hoop Relocation   3 Hoop
Selection  

Selected Hoop
The attached hoop is automatically recognized and
shown against a dark background in the Status Bar and
in the Selected Hoop section.
If no embroidery hoop has been attached, an
embroidery hoop matching the size of the embroidery
design is preselected in the Hoop Selection section.
The selected hoop is shown against a light background.

https://www.bernina.com
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Hoop Relocation
In the Hoop Relocation area, you can move the
attached hoop to certain positions.
n Centered  : For easier threading of the needle.
n Sewing Position  : For sewing without having

to remove the embroidery module. If a hoop is
attached, you will be prompted to remove the
hoop.

n At the Rear  : To easily access the bobbin area.

Hoop Selection
The hoops compatible with the machine are displayed
in the Hoop Selection section.
To prepare the embroidery design, you can select a
suitable embroidery hoop before attaching the hoop.

3.18 Basic Settings

Welcome Message
Settings   ► Personal   ► Welcome Message

With the Welcome Message setting, you can enter a
text to be displayed when the machine is switched on.

Background Color
Settings   ► Personal   ► Background Color

With the Background Color setting, you can select a
color scheme for your screen. The background, icons
and menu adapt to the color scheme.

Language
Settings   ► Personal   ► Language

With the Language setting, you can set the language
of the user interface.

My Dealer Information
Settings   ► Personal   ► My Dealer Information

With the My Dealer Information setting, you can
enter the address of your BERNINA dealer for quick
reference at any time.

Machine Name
Settings   ► Machine   ► Information ► Identifi-
cation ► Machine Name

With the setting Machine Name you can enter the
name under which the machine is displayed in a WiFi
network.

Data Usage
Settings   ► Machine   ► Information ► Data
Usage

With the setting Data Usage you can agree or object
to the use of anonymized usage data by BERNINA for
product improvement.

Monitoring Functions
Settings   ► Machine   ► Monitoring Functions

The machine has monitoring sensors, which issue a
warning if the upper thread or lower thread is broken
or has run out. With the Monitoring Functions
setting, you can switch the Upper Thread Indicator and
the Bobbin Thread Indicator on or off.

Sound
Settings   ► Machine   ► Sound

With the Sound setting, you can turn all signal sounds
on and off and adjust their volume. If all signal sounds
are switched on, you can select various signal sounds
for different functions such as Stitch Selection  ,
Functions and Icons   and Stitch Regulation  ,
and switch individual acoustic signals on and off.

Display Brightness
Settings   ► Machine   ► Display and Lighting
► Display

With the Display Brightness setting, you can adjust
the brightness of the display.

Lighting
Settings   ► Machine   ► Display and Lighting
► Lighting

With the settings Free Arm   and Needle Area 
you can switch the sewing light above the free arm and
the needle area on and off independently of each other
and adjust the brightness of the sewing lights.

Date and Time
Settings   ► Machine   ► Date, Time and Alarm

With the Date and Time setting, you can select the
time format and set the date and time manually or
automatically.

Alarm
Settings   ► Machine   ► Date, Time and Alarm

With the Alarm   setting, you can switch on a
reminder and set the following information:
n Alarm Time 
n Sound 
n Alarm Message 
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WiFi Connection
Settings   ► Machine   ► WiFi Connection

You can connect the machine to a WiFi network. This
allows you to transfer embroidery designs from the
BERNINA Embroidery Software onto the machine, to
track the progress of the stitching on the BERNINA
Stitchout App or display content from the Help Center
on a tablet.
With the WiFi Connection setting, you can switch the
WiFi connection on and off. The machine indicates the
network to which it is connected.
All available networks are displayed in the Available
Networks list. You can connect the machine to any
available network. In the case of protected networks,
you must sign in with a password.
Once you have set up the WiFi connection once, you
can switch the WiFi connection on and off in the Status
Bar.

3.19 Sewing Settings

Upper Thread Tension

Settings   ► Sewing   ► Upper Thread Tension

The upper thread tension is set optimally at the
BERNINA factory. Mettler Metrosene/Serlon thread size
100/2 is used for the upper and bobbin thread.
If you use different types of sewing threads, the upper
thread tension may vary. You can override the default
setting based on thread and fabric you are using in the
Upper Thread Tension in the Sewing Settings. This
modification is made to all sewing patterns and kept
until changed again in the Settings, even after a
machine restart.
The higher the upper thread tension is set, the tighter
the upper thread is tensioned, and the bobbin thread is
pulled deeper into the fabric. The lower the setting the
lower the upper thread is tensioned, and the bobbin
thread is pulled less deeply into the fabric.

TIP

If the sewing test shows that the upper thread
tension is not optimal for a stitch pattern, you can
modify the upper thread tension for the selected
stitch pattern using the Upper Thread Tension 
function in the Status Bar.

Sewing Speed

Settings   ► Sewing   ► Sewing Speed

The sewing speed is specified in stitches per minute.
The maximum sewing speed is 1200 stitches per
minute.
With the Sewing Speed function, you can limit the
maximum sewing speed. The setting is saved when the
machine is switched off.

Securing Stitches

Settings   ► Sewing   ► Securing Stitches

With the Securing Stitches function, you can set
whether securing stitches should be sewn automatically
upon starting sewing.

Presser Foot Hover Position

Settings   ► Sewing   ► Presser Foot Hover Position

With the Presser Foot Hover Position function, you
can set how high the presser foot is raised when the
machine stops with the needle position down. The
following options are available:
n Low: The presser foot remains lowered.
n Medium: The presser foot is raised to a medium

height.
n High: The presser foot is raised.

External Buttons

Settings   ► Sewing   ► External Buttons

With the External Buttons function, you can program
additional functions for the following buttons:
n Pattern End
n Securing
n Presser Foot Up/Down
n Thread Cutter
n Quick Reverse

Pattern End

Settings   ► Sewing   ► External Buttons ► Pattern
End

With the Pattern End function, you can set which
functions are carried out when the Pattern End 
button is pressed. The following functions are available:

Securing
With the Securing   function, you can switch the
sewing of securing stitches on and off.



My BERNINA

3 Set Up the machine 46

Securing Stitches
When the Securing  function is switched on, you
can use the Securing Stitches   function, to select
how securing stitches are sewn. The following
functions are available:
n Secure in Place: Securing Stitches in Place.
n Running Stitches: Running Stitches.

Running Stitches
If you have selected the Running Stitches   setting,
you can set the count of securing stitches.

Cut Upper and Lower Thread
With the Cut Upper and Lower Thread   function,
you can switch the thread cut on and off.

Raise Presser Foot
With the Raise Presser Foot   function, you can
switch the raising of the presser foot on and off.
You can combine the Securing  , Cut Upper and
Lower Thread   and Raise Presser Foot 
functions.

Securing

Settings   ► Sewing   ► External Buttons
► Securing

With the Securing function, you can set which
function is carried out when the Securing   button
is pressed. The following functions are available:
n Secure in Place: Securing Stitches in Place.
n Running Stitches: Running Stitches.

If you have selected the Running Stitches   setting,
you can set the count of securing stitches.

Presser Foot Up/Down

Settings   ► Sewing   ► External Buttons ► Presser
Foot Up/Down

With the Presser Foot Up/Down function, you can set
the height to which the presser foot is raised when the
Presser Foot Up/Down   button is pressed.
Depending on the material thickness, you can raise the
presser foot to 0 – 7 mm.

Thread Cutter

Settings   ► Sewing   ► External Buttons ► Thread
Cutter

With the Thread Cutter function, you can determine
whether securing stitches are sewn when the Thread
Cutter   button is pressed. The following functions
are available:

Securing
With the Securing   function, you can switch the
sewing of securing stitches on and off.

Securing Stitches
When the Securing  function is switched on, you
can use the Securing Stitches   function, to select
how securing stitches are sewn. The following
functions are available:
n Secure in Place: Securing Stitches in Place.
n Running Stitches: Running Stitches.

Running Stitches
If you have selected the Running Stitches   setting,
you can set the count of securing stitches.

Quick Reverse

Settings   ► Sewing   ► External Buttons ► Quick
Reverse

With the Quick Reverse function, you can set how the
machine sews in reverse when the Quick Reverse 
button is pressed. The following functions are available:
n Reverse: Machine sews backward.
n Backstep: The machine sews the stitch pattern

backwards stitch by stitch according to the stitches
sewn. This setting is particularly suitable for
decorative stitches.

Foot Control

Settings   ► Sewing   ► Foot Control

The default setting Needle Up/Down   is set for the
back kick on the foot control. You can switch the
standard function off and on or switch on and set a
combination of the following functions:

Securing
With the Securing   function, you can switch the
sewing of securing stitches on and off.



My BERNINA

3 Set Up the machine 47

Securing Stitches
When the Securing  function is switched on, you
can use the Securing Stitches   function, to select
how securing stitches are sewn. The following
functions are available:
n Secure in Place: Securing Stitches in Place.
n Running Stitches: Running Stitches.

Running Stitches
If you have selected the Running Stitches   setting,
you can set the count of securing stitches.

Cut Upper and Lower Thread
With the Cut Upper and Lower Thread   function,
you can switch the thread cut on and off.

Raise Presser Foot
With the Raise Presser Foot   function, you can
switch the raising of the presser foot on and off.

Buttonhole Foot Calibration

Settings   ► Sewing   ► Buttonhole Foot Calibration

The Buttonhole Foot with Slide #3A is calibrated to the
machine and they should always be used together. A
new buttonhole foot must be calibrated with the
machine in the sewing settings before its first use.

Prerequisite:
n The needle is not threaded.

1. Open the Buttonhole Foot Calibration setting.
2. Attach the Buttonhole Foot with Slide #3A.

3. Push the Start/Stop   button.
ð The machine moves the buttonhole foot with

slide forward and backward and displays
successful calibration.

3.20 Embroidery Settings

Upper Thread Tension

Settings   ► Embroidery   ► Upper Thread Tension

The upper thread tension is set optimally at the
BERNINA factory. Mettler Metrosene/Serlon thread size
100/2 is used for the upper and bobbin thread.
If you use different types of sewing threads, the upper
thread tension may vary. You can override the default
setting in the Embroidery Settings. This modification is
made to all embroidery designs and kept until changed
again in the Settings, even after a machine restart.

The higher the upper thread tension is set, the tighter
the upper thread is tensioned, and the bobbin thread is
pulled deeper into the fabric. The lower the setting the
lower the upper thread is tensioned, and the bobbin
thread is pulled less deeply into the fabric.

TIP

If the embroidery test shows that the upper thread
tension is not optimal for an embroidery design, you
can modify the upper thread tension for the selected
embroidery design using the Upper Thread
Tension   function in the Status Bar.
For a higher bobbin thread tension, use a bobbin
case with a high thread tension (HTTBC).

Embroidery Speed

Settings   ► Embroidery   ► Embroidery Speed

The embroidery speed is specified in stitches per
minute. The maximum embroidery speed is 1000
stitches per minute.
With the Embroidery Speed setting, you can limit the
maximum embroidery speed. The setting is saved when
the machine is switched off.

TIP

You can also modify the embroidery speed during
stitching using the foot control or the slide speed
control. You can switch on the maximum embroidery
speed for the current embroidery design while
embroidering using the function High Speed  .

Design Position

Settings   ► Embroidery   ► Design Position

With the Design Position setting, you can set the
standard positioning of the embroidery design in the
hoop.
Embroidery designs can be positioned either in the
center of the hoop (default) or at the saved position.
The saved position corresponds either to the position of
the embroidery design when saved in your Personal
Folder or to the position saved in BERNINA Embroidery
Software. The setting is saved when the machine is
switched off.
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Calibrating the Hoop

Settings   ► Embroidery   ► Hoop Calibration

Hoops must be calibrated when new and after every
machine firmware update.
With the Hoop Calibration function, you can calibrate
all hoops.

1. Hoop the fabric with non-woven material.
2. Place the template in the inner hoop onto the

fabric.
3. Attach the hoop.

ð The machine recognizes the attached
embroidery hoop and displays it in the Status
Bar.

4. Open the Hoop Calibration setting.
5. Switch on the Camera   and Laser   functions.

ð The laser indicates the exact position of the
needle.

6. If the needle is not positioned exactly at the center
of the template, center the needle using the arrow
buttons.

7. Confirm the hoop calibration.

The setting is saved when the machine is switched off.
With the Reset Calibration function, you can delete
an exisiting calibration.

Cut and Secure
Settings   ► Embroidery   ► Cut and Secure

Quilt Settings
With the Quilt Settings   function, you can switch
on and off special quilt settings for thread cutting and
securing.
Quilt Settings:
n Quilt Securing Stitches.
n Thread Cut Disabled.
n Thread Away Disabled.

Thread Cut After Start
If the Thread Cut After Start   function is switched
on, the machine stops after a few stitches and you can
cut the thread end by hand.

Securing
With the Securing   function, you can switch the
sewing of securing stitches on and off.

Securing Stitches
When the Securing  function is switched on, you
can use the Securing Stitches   function, to select
how securing stitches are sewn. The following
functions are available:
n Secure in Place: Securing Stitches in Place.
n Running Stitches: Running Stitches.

Secure at Beginning
With the Secure at Beginning   function, you can
switch the sewing of securing stitches at the beginning
of the embrodery design on and off.
If an embroidery design has programmed securing
stitches, the programmed securing stitches are sewn.

Secure at End
With the Secure at End   function, you can switch
the securing stitches at the end of the embroidery
design.
If an embroidery design has programmed securing
stitches, the programmed securing stitches are sewn.

Unit of Measurement

Settings   ► Embroidery   ► Unit of Measurement

With the Unit of Measurement function, you can set
the preferred measurement, either mm or inches. The
embroidery size is shown in the selected measurement
unit. The setting is saved when the machine is switched
off.

SPI (Customizable Quilt Designs)

Settings   ► Embroidery   ► SPI (Customizable Quilt
Designs)

With the SPI (Customizable Quilt Designs) setting,
you can set the stitch length for Customizable Quilt
Designs in stitches per inch (SPI).
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Main Menu   ► Sewing 

1 2 93 5 6 74 8

101011111313 1212

1 Status Bar   2 Undo/Redo   3 Stitch Length   4 Presser Foot Preview   5 Stitch Width   6 Needle Position   7 Stitch
Preview   8 Edit   9 File Manager   10 Save   11 Reset   12 Combi Mode   13 View  

Undo
With the Undo   function, you can undo the most
recent actions.

Redo
With the Redo   function, you can redo undone
actions.

Stitch Length
With the Stitch Length function, you can adjust the
length of the current stitch. [} see page 61]

Presser Foot Preview
A preview of the recommended or selected presser foot
is displayed in the presser foot preview.

Stitch Width
With the Stitch Width function, you can adjust the
width of the current stitch. [} see page 61]

Edit
With the Edit   function, you can open the stitch
pattern editing functions. [} see page 61]

Needle Position
If the needle has been moved to the left or right, the
value of the needle position is displayed. You can move
the needle position back to the middle position by
tapping the icon Needle Position  .

Stitch Preview
The Stitch Preview shows a preview of the current
stitch or stitch pattern combination, along with the
selected presser foot. In Combi Mode, you can select
and move the individual stitches in the stitch preview.

Save
With the Save   function, you can save a modified
stitch pattern as a new stitch or with new default
settings. [} see page 70]
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Reset
With the Reset   you can reset the saved settings of
the loaded stitch to the factory default. [} see
page 70]
The function is only displayed if you have loaded a
stitch pattern with new default settings.

Combi Mode
With the Combi Mode   you can switch the Combi
Mode on and off. [} see page 68]

View
With the View   function, you can adjust the view on
the Sewing Screen.
n Rotate  : Rotate the view by 90°, e.g. to make it

easier to design texts.
n Presser Foot On/Off  : Show and hide the

presser foot.
n Grid On/Off  : Show and hide the grid.
n Zoom In/Zoom Out  : Zoom the view in or out.
n Zoom Factor: Reset the view to the default.

4.1 Status Bar
The Status Bar displays the state of various functions.
Some functions can be set directly with the respective
status, e.g. the needle position, the feed dog or the
laser. For other functions, you can open the settings
with the status, e.g. the upper thread tension or the
presser foot pressure.
The color of the icon shows the current state of the
function.
n White: Default setting
n Blue: Active setting
n Yellow: Modified setting
n Red: Warning

WiFi, Time and Alarm
The WiFi   icon displays the WiFi connectivity, the
current time and alarm if active.
By tapping the icon, you open the settings for WiFi,
Time and the Alarm function. In the Settings, you can
switch the WiFi connection on or off or set up the WiFi
connection. [} see page 45]
You can also set a reminder. [} see page 44]

Needle Stop
The Needle Stop   icon shows the needle position
when the machine is stopped.
n : Needle Stop Up.
n : Needle Stop Down.

You can set the needle position to stop up or down by
toggling the icon.

Upper Thread Tension
The Upper Thread Tension   icon shows the
recommended upper thread tension for the selected
stitch.
You can modify the upper thread tension for the
selected stitch by tapping the Upper Thread Tension
icon. [} see page 45]

Presser Foot
The Presser Foot   icon shows the recommended or
selected presser foot.
You can open presser foot selection by tapping the
icon. In the presser foot selection, you can select the
attached presser foot and display details about the
presser foot. [} see page 41]

Presser Foot Pressure
The Presser Foot Pressure  icon shows the presser
foot pressure.
You can open and change the presser foot selection by
tapping the Presser Foot Pressure icon. [} see
page 41]

Stitch Plate and Sewing Needle
The Stitch Plate and Sewing Needle   status
shows the selected needle and the attached stitch
plate. The attached stitch plate is automatically
recognized.
You can open the needle overview and select the
attached needle by tapping the icon. [} see page 33]

Feed Dog
The Feed Dog   status shows the position of the
feed dog.
n Feed Dog   (white): Feed Dog is up.
n Feed Dog   (yellow): Feed Dog is down.

You can lower and raise the feed dog by tapping the
icon.

Bobbin Thread
The Bobbin Thread   status shows the fill capacity of
the lower thread bobbin.
n White: Good
n Yellow: Low or Empty

You can open the Bobbin Thread Status by tapping the
Bobbin Thread   icon. In the setting, the bobbin fill
capacity is shown and you can visualize the animation
and step-by-step instructions to insert the Bobbin Case.
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TIP

Toggle the light on/off to make it easier to insert the
Bobbin Case when the Slide-on Table is attached.

Camera
The Camera   icon shows the status of the camera.
n White: Camera off.
n Yellow: Camera on.
n Red: Camera not available.

You can switch the camera on and off for a live image
of the sewing area by tapping the icon.

Laser
The Laser   icon shows the status of the laser.
n White: Laser off.
n Yellow: Laser on.

By tapping the icon, you can switch the laser on and
off.
The laser indicates the next stitch point in sewing mode
and the exact needle position in embroidery mode.
Depending on the presser foot and needle position, the
entry point may be concealed by the presser foot. To
avoid the deflection of the laser with transparent
presser feet, you can lower the presser foot before the
sewing start, e.g. with the Knee Lifter.

4.2 File Manager
In the File Manager, you can load and manage stitch
patterns. The File Manager is opened when you tap a
stitch patttern category, the tabs Personal Folder 
and USB Stick   in the Quick Access Bar.

1
2

3

4

1 Toolbar   2 Navigation Bar   3 Quick Access Bar  
4 Selection Area  

Toolbar

In the toolbar, you will find functions for searching for
files, adjusting the view and managing your own files in
your Personal Folder and on a USB stick.

Search
With the Search   function, you can search for stitch
patterns by stitch number.

Selection
With the Selection   function, you can select folders
or files that you wish to manage using a function from
the Options   menu.
The Selection   function is only available for the
Personal Folder   and USB Stick   folders.

Options
With the Options   menu, you can manage the
selected file(s) or folder(s) using the Selection 
function.
n Rename: Renaming a File or Folder [} see page 23]
n Cut: Cut File(s) or Folder(s). [} see page 23]
n Copy: Copy File(s) or Folder(s). [} see page 23]
n Paste: Paste cut or copied File(s) or Folder(s). [} see

page 23]
n New Folder: Create New Folder.
n Information: Show preview and further infor-

mation on the stitch pattern.
n Select All: Select all displayed File(s) and Folder(s).
n Delete: Delete File(s) or Folder(s). [} see page 23]

The Options   menu is only available for objects in
the Personal Folder   and USB Stick   folders.

View
With the View   function, you can switch the view
in the selection area between grid and list view. In the
grid view, you can choose between large and small
icons.

History
With the History   function, you can display and
choose the most recently sewn stitch patterns. The
History is retained after restarting the machine.

USB Stick
With the USB Stick   function, you can switch
between your Personal Folder and the USB Stick in the
selection area.
This function is only available if a USB stick is inserted.
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Fullscreen
With the Fullscreen   function, you can expand the
File Manager to fill the entire screen and show
additional functions.

Navigation Bar

The Navigation Bar shows the path to the selected
stitch pattern. With the Back  function, you can
go back step by step.

Quick Access Bar

You can use the Quick Access Bar to directly access the
categorized stitch folders, Personal Folder and USB as
well as the Stitch Designer.

Practical Stitches
In the Practical Stitches   folder, you will find all
practical stitches. [} see page 53]

Decorative Stitches
In the Decorative Stitches   folder, you will find all
decorative stitches collated into folders by categories.
[} see page 56]

Alphabets
In the Alphabets   folder, you will find all sewing
alphabets. [} see page 57]

Buttonholes
In the Buttonholes   folder, you will find all
buttonholes, eyelets and the Button Sew-on Program.
[} see page 57]

Quilting Stitches
In the Quilting Stitches   folder, you will find all
quilt stitches. [} see page 59]

Personal Folder
In the folder Personal Folder  , you can save and
load your own stitch pattern. You can organize the
stitch patterns in folders.

USB Stick
In the USB Stick   folder, you can save or load your
own stitch patterns on a USB stick. You can organize
the stitch patterns in folders.

Stitch Designer
With the Stitch Designer   icon, you can open the
Stitch Designer function and modify existing stitch
patterns or design your own stitch pattern. [} see
page 74]

Selection Area
In the Selection Area, you can navigate through the
folders and load a stitch pattern. Each stitch pattern is
displayed with a preview image. Stitch pattern combi-
nations are also marked.
If you press and hold a stitch pattern or stitch pattern
combination, a preview of the stitch pattern or the
entire combination and further information is
displayed. If you tap the icon Load   in the preview,
the stitch pattern or combination is loaded.
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5.1 Practical Stitches
Sewing   ► Practical Stitches 

Stitch
patterns

Stitch
number

Name Purpose

1 Straight Stitch For joining seams, for topstitching and basting.

2 Zigzag For finishing, sewing knit seams, sewing on lace
inserts and elastic bands.

3 Vari-Overlock For finishing edges, sewing together and finishing
knit fabrics.

4 Running Stitch For darning and reinforcing fabric edges or
attaching lace or elastic tape.

5 Securing Program For automatic securing at the start of the seam
with forward and reverse stitches.

6 Triple Straight Stitch For reinforced seams on heavy fabrics,
topstitching and decorative effects.

7 Triple Zigzag For durable seams on strong fabrics, visible hems
and decorative seams.

8 Honeycomb Stitch For visible and decorative seams on knits and
wovens.

9 Blind Stitch For blind hems on most fabric types and for shell
edging on soft jerseys and fine fabric.

10 Double Overlock For sewing together and finishing knit fabrics.

11 Superstretch Stitch For very stretchy open seams.
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Stitch
patterns

Stitch
number

Name Purpose

12 Gathering Stitch For gathering with heavier threads and for flat
joining seams on medium-weight fabrics.

13 Stretch Overlock For sewing together and finishing knit fabrics as
well as for flat joining seams.

14 Tricot Stitch For visible hems and seams in lingerie and
sweaters and for mending tricot fabric.

15 Universal Stitch For flat joining seams, visible hems and decorative
seams in heavy fabrics such as felt and leather
and for attaching elastic tape.

16 Stitched Zigzag For finishing and reinforcing fabric edges, for
sewing on elastic tape and for decorative seams.

17 Lycra Stitch For flat joining seams, visible hems on lycra fabric
and for stitching over seams in undergarments.

18 Stretch Stitch For stretchy seams and hems in woven and knit
fabrics.

19 Reinforced Overlock For overlock seams or flat joining seams on
medium-weight knit fabrics and toweling.

20 Knit Overlock For stretchy seams and hems in woven and knit
fabrics.

21 Basting Stitch For tacking seams, hems and for quilting projects.

22 Simple Darning Program For automatic darning in fine to heavy fabrics.

23 Reinforced Darning
Program

For automatic darning in heavy materials.

24 Bartack Program For reinforcing pocket openings, buttonholes and
sewing belt loops.

25 Bartack Program For reinforcing pocket openings and securing
seam ends.

26 Large Fly Stitch For reinforcing pocket openings, zippers and slits
in medium-weight to heavy fabrics.

27 Small Fly Stitch For reinforcing pocket openings, zippers and slits
in fine to medium-weight fabrics.
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Stitch
patterns

Stitch
number

Name Purpose

29 Narrow Blind Stitch For blind hems and shell edging in fine and soft
fabrics.

31 Triple Straight Stitch with
Long Stitch

For durable seams in heavy fabrics, e.g. visible
and decorative seams.

32 Single Straight Stitch As a connecting stitch in a combination of one
straight stitch.

33 Three Single Straight
Stitches

As connecting stitches in a combination of three
individual straight stitches.

34 Darning Stitch For darning.

35 Open Overlock Stitch For sewing together and finishing knit fabrics
with a reinforced edge.

36 Overlock For medium-weight knit fabrics.

37 Reinforced Overlock Stitch For sewing together and finishing knit fabrics.

38 Chain Stitch For decorative and reinforcing stitches on most
woven fabrics.

39 Cover Stitch Effect To sew decorative seams and hems in heavy knits
and woven fabrics.

40 Cover Stitch Effect To sew decorative seams and hems in heavy knits
and woven fabrics.

41 Open Overlock Stitch For sewing together and finishing knit fabrics
with a reinforced edge.

42 Cover Stitch Effect To sew decorative seams and hems in heavy knits
and woven fabrics.
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5.2 Decorative Stitches
Sewing   ► Decorative Stitches 

Category Name

100 Nature

200 Nature Sideways Motion

300 Cross Stitches

400 Satin

500 Satin Sideways Motion

600 Geometric

700 Heirloom

800 Heirloom Sideways Motion

900 Children

Category Name

1000 Children Sideways Motion

1100 Special

1200 Filigree

1400 Tapering

1500 Banner

1600 Quilt Stitches Sideways
Motion

1700 International

1900 Geometric Sideways Motion

2000 Seasons

2200 Sport and Hobby

2500 Constellations

2600 Emojis

2700 Emojis Sideways Motion
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5.3 Alphabets
Sewing   ► Alphabets 

Stitch Patterns Name

Block

Double Block

Script Italic

Quilt

Art Deco

Stitch Patterns Name

Comic

Calibri Italic

Agency

Hand of Sean

Monogram

Long Thin

Hiragana

Katakana

Cyrillic

Cyrillic Italic

Kanji

5.4 Buttonholes
Sewing   ► Buttonholes 
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Stitch
patterns

Stitch
number

Name Purpose

51 Standard Buttonhole For light to medium-weight fabrics. e.g. blouses,
dresses and bed linen.

52 Narrow Standard
Buttonhole

For light to medium-weight fabrics, e.g. blouses,
dresses, children's and baby clothes, crafts.

53 Stretch Buttonhole For all knit fabrics.

54 Round Buttonhole with
Normal Bartack

For medium-weight to heavy fabrics. e.g. dresses,
jackets, coats and rainwear.

55 Round Buttonhole with
Horizontal Bartack

For medium-weight to heavy fabrics, with a
reinforced bar, e.g. dresses, jackets, coats and
rainwear.

56 Keyhole Buttonhole For heavy woven fabrics, e.g. jackets, coats and
leisure wear.

57 Keyhole Buttonhole with
Pointed Bartack

For stronger, woven fabrics, e.g. jackets, jeans
coats and leisurewear.

58 Keyhole Buttonhole with
Horizontal Bartack

For heavy woven fabrics, e.g. jackets, coats and
leisurewear.

59 Straight Stitch Buttonhole For staystitching and reinforcing buttonholes and
as buttonhole edging, especially for buttonholes
in leather and imitation leather.

63 Heirloom Buttonhole For handlook stitching effects on clothes and
handicrafts on light to medium-weight fabrics.

64 Double-rounded
Buttonhole

For medium-weight to heavy fabrics.

65 Double-rounded Heirloom
Buttonhole

For light to medium-weight, woven fabrics. e.g.
blouses, dresses and bed linens.

66 Narrow Buttonhole with
Double Pointed Bartack

For decorative buttonholes in medium-weight
fabrics, e.g. dresses and jackets.

67 Round Buttonhole with
Bartack

For medium-weight woven fabrics, e.g. blouses,
dresses and jackets.

68 Decorative Keyhole
Buttonhole with
Horizontal Bartack

For stronger, woven fabrics, e.g. jackets, coats
and leisurewear.
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Stitch
patterns

Stitch
number

Name Purpose

69 Decorative Buttonhole
with Double Pointed
Bartack

For decorative buttonholes in firmer woven
fabrics.

70 Decorative Stretch
Buttonhole

For decorative buttonholes in light to medium-
weight knit fabrics.

60 Button Sew-on Program Sews buttons with 2 or 4 holes.

61 Small Zigzag Eyelet Openings for cords or narrow ribbons and for
decorative work.

62 Straight Stitch Eyelet Openings for cords or narrow ribbons and for
decorative work.

5.5 Quilt Stitches
Sewing   ► Quilt Stitches 

Stitch Number Name Purpose

No. 1301 Quilting, Securing Program To secure at the sewing start and end with short
stitches forward.

No. 1302 Quilting, Straight Stitch For machine quilting using a straight stitch with
a 3 mm stitch length.

No. 1303 Piecing Stitch/Straight Stitch For piecing quilt blocks together using a straight
stitch with a 2 mm stitch length.

No. 1304 –
 No. 1308

Hand-look Quilt Stitches For imitating the look of hand quilting with
monofilament thread.

No. 1309 –
 No. 1312

Blanket Stitch For appliqué.
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Stitch Number Name Purpose

No. 1313 –
 No. 1314

Blanket Stitch For sewing on the edge between two areas in
crazy patchwork.

No. 1315 Satin Stitch For appliqué with more distinct seams.

No. 1316 Narrow Blind Stitch For edging and appliqué with minimally visible
seams.

No. 1317 –
 No. 1330

Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and
finishing.

No. 1331 Stippling Stitch For quilting, crazy patchwork, embellishing and
finishing.

No. 1332 –
 No. 1338

Feather Stitch For quilting, crazy patchwork, embellishing and
finishing.

No. 1339 –
 No. 1346

Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and
finishing.

No. 1363 –
 No. 1394

Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and
finishing.
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6.1 Load Stitch Pattern

1 2

1 Selection Area   2 Quick Access Bar  

1. Tap the stitch category in the Quick Access Bar.
2. Find and load the desired stitch pattern in the File

Manager.
ð The stitch pattern is displayed in the stitch

preview.

Further information on the selection area can be found
in the File Manager. [} see page 51]

6.2 Stitch Pattern Editing

Stitch Width

The recommended stitch width is indicated for each
stitch. You can modify the stitch width for most
stitches, alphabets and buttonholes. The stitch width
depends on the needle used, the presser foot and the
stitch plate.
The machine checks the compatibility between the
needle, presser foot, stitch plate and stitch. To do this,
the attached presser foot must be selected in the Status

Bar with the Presser Foot   icon. If the stitch cannot
be sewn with the selected presser foot and the
attached stitch plate, the stitch is shown in red.

TIP

You can also modify the stitch width during sewing
with the Upper Multi-function Knob.
With the 5.5   function, you can set the stitch
width directly to 5.5 mm, e.g. if you are using a
narrow presser foot.

Stitch Length

The recommended stitch length is indicated for each
stitch. You can modify the stitch length for most
stitches, alphabets and buttonholes.
In the case of decorative stitches and alphabets, the
pattern length is shown instead of the stitch length.

TIP

You can also modify the stitch length during sewing
with the Lower Multi-function Knob.
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Editing Functions

Sewing   ► Edit 

With the Edit   function, you can view the editing
functions for the selected stitch. Associated functions
are grouped together. The Edit and Optimize
submenus are always available. For some stitch
categories, e.g. buttonholes, additional submenus are
shown.

Repeat
Sewing   ► Edit   ► Edit ► Repeat 

With the Repeat   function, you can set the number
of repeats of a stitch pattern after which the machine
should stop. You can set 0 – 99 repeats. The number of
repeats still to be sewn is displayed on the Sewing
Screen.

Mirror Left/Right
Sewing   ► Edit   ► Edit ► Mirror Left/Right 

With the Mirror Left/Right   function, you can
mirror a stitch pattern along the vertical axis.

Mirror Up/Down
Sewing   ► Edit   ► Edit ► Mirror Up/Down 

With the Mirror Up/Down   function, you can mirror
a stitch pattern along the horizontal axis.

Triple Stitch
Sewing   ► Edit   ► Edit ► Triple Stitch 

With the Triple Stitch   function, triple stitches are
sewn three times (forward-backward-forward) for a
more pronounced or reinforced stitching. Not
applicable with satin and some decorative stitches.

TIP

This function is particularly suitable for topstitching
with decorative seams if you do not have a thicker
thread available. If you are using a thick thread in a
contrasting color, this will produce a striking,
decorative seam.

Jumbo Stitch
Sewing   ► Edit   ► Edit ► Jumbo Stitch 

With the Jumbo Stitch   function, you can enlarge or
decrease the size of the stitch pattern. When increased
over 9 mm in width the stitch becomes a Sideways
Motion pattern and stitches with the Presser
Foot #40C.

TIP

Jumbo Stitch is better suited for patterns that are not
too complex.
Bring the Jumbo Stitch into Embroidery to embellish
embroidered projects.

TIP

To adjust satin stitches so that they can be sewn
larger, also change the stitch density. [} see
page 64]

Long Stitch
Sewing   ► Edit   ► Edit ► Long Stitch 

With the Long Stitch   function, the machine only
sews every second stitch.
You can use the Long Stitch   function to create new
stitch patterns. Satin stitches are not changed. If you
combine the Long Stitch   function with the straight
stitch, you can easily create basted seams. At a stitch
length of 6 mm, the machine sews 12 mm long basting
stitches.

Directional Sewing
Sewing   ► Edit   ► Edit ► Directional Sewing 

With the Directional Sewing   function, you can
sew stitch patterns in any direction without having to
rotate the fabric.
The #40C presser foot must be attached in order to use
the Directional Sewing   function.
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TIP

n Stabilize the fabric.
n Guide the fabric lightly with your fingertips.
n Use the guide lines on the Slide-on Table to guide

the fabric in a straight line.
n Draw parallel guide lines to keep the fabric

parallel to the presser foot.

TIP

You can also modify the sewing direction in 0.5°
increments during sewing using the multi-function
knobs.

Stitch Counter
Sewing   ► Edit   ► Edit ► Stitch Counter 

With the Stitch Counter   function, you can save the
length of a seam for some stitch patterns based on the
count of stitches sewn. The number of stitches counted
is displayed on the Sewing Screen and saved until the
machine is switched off. [} see page 63]

Distort
Sewing   ► Edit   ► Edit ► Distort 

With the Distort   function, you can distort stitch
patterns in a horizontal and vertical direction. For
example, sewing a straight font in italics.

Reverse
Sewing   ► Edit   ► Edit ► Reverse 

With the Reverse   function, you can sew in reverse
without pressing and holding the Quick Reverse 
button.

Backstep
Sewing   ► Edit   ► Edit ► Backstep 

With the Backstep   function, you can perform
precise backwards stitching. The machine ensures that
the stitches sewn in reverse are sewn precisely over the
stitches sewn forward. This allows you to secure
decorative stitches or make individual stitch patterns
bolder by sewing over them several times.

Using the Stitch Counter

Sewing   ► Edit   ► Edit ► Stitch Counter 

Prerequisite:
n A stitch pattern is selected.

1. Tap the Stitch Counter   icon.
ð In the info bar the Stitch Counter   and

Repeat   icons are shown and the Quick
Reverse   icon flashes.

2. Sew the desired length.
3. Push the Quick Reverse   button.

ð The Stitch Counter   display changes to
AUTO and shows the length of the saved
seam.

ð As soon as the stitch pattern is sewn again, the
machine stops after the saved stitch number.

ð The stitch count is saved until it is overwritten
or cleared.

4. To access the saved stitch count after deactivating
the function, tap the Stitch Counter   icon
twice, until AUTO appears.
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Optimization Functions

The optimization functions for stitch patterns are
grouped together in the Optimize submenu.

Balance
Sewing   ► Edit   ► Optimize ► Balance 

With the Balance   function, you can fine tune any
stitch patterns that are not sewn correctly due to the
selected fabric.
Compare a sewn sample with the display in the Stitch
Preview section and adjust the balance so that the
preview corresponds to the incorrectly sewn stitch
pattern.

Dual Feed Balance
Sewing   ► Edit   ► Optimize ► Dual Feed
Balance 

If the fabric layers are not fed evenly despite the fact
that the Dual Feed is engaged, you can use the Dual
Feed Balance   function to optimize the Dual Feed.
n If the upper fabric becomes increasingly longer

than the lower fabric, set a positive value.
n If the upper fabric becomes increasingly shorter

than the lower fabric, set a negative value.

Stitch Density
Sewing   ► Edit   ► Optimize ► Stitch Density 

With the Stitch Density   function, you can modify
the stitch density for some decorative satin stitches
(e.g. No. 401).
n If you increase the stitch density, the stitch spacing

is reduced and the threads become closer.
n If you reduce the stitch density, the stitch spacing is

increased and the threads are further away.

The length of the stitch pattern is not affected.

6.3 Buttonholes
For buttonholes, you can adjust the buttonhole length
as well as the width of the slit. As soon as a buttonhole
stitch is loaded, the Buttonhole Options submenu
appears in the editing menu.
n Length  : Program the buttonhole length.
n Slit Width  : Adjust the width of the slit.

Buttonhole Length
Sewing   ► Edit   ► Buttonhole Options
► Length 

The following functions are available for adjusting the
buttonhole length:
n Record mm  : Program the buttonhole length in

mm. [} see page 65]
n Auto Length  : Adjust the buttonhole length to

the button size. [} see page 65]
n Stitch Counter  : Program the buttonhole

length with the stitch counter. [} see page 65]
n Sew Manually  : Sew the buttonhole manually.

[} see page 66]
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Record the Buttonhole Length in mm

Sewing   ► Edit   ► Buttonhole Options
► Length   ► Record mm 

With the Record mm   function, the machine
measures the sewn length of the first bead and saves it.
The machine finishes the buttonhole automatically.

Prerequisite:
n A buttonhole is loaded.
n Buttonhole Foot #3A is attached.

1. Tap the Record mm   icon.
ð The Reverse  icon flashes on the Sewing

Screen.
2. Sew the first bead and press the Quick Reverse 

button at the desired length.
ð The machine will complete the buttonhole.
ð The machine switches to Button Size   mode

and all additional buttonholes are automatically
sewn to the displayed length in mm.

ð The buttonhole length remains saved until it is
overwritten, cleared or the machine is switched
off.

Adjusting the Buttonhole Length to the
Button Size

Sewing   ► Edit   ► Buttonhole Options
► Length   ► Auto Length 

With the Auto Length   function, you can measure
the diameter of the button. The machine automatically
adjusts the length of the buttonhole to the size of the
button.

Prerequisite:
n A buttonhole is loaded.
n Buttonhole Foot #3A is attached.

1. Tap the Auto Length   icon.
2. Place the button in the measuring circle on the

screen and adjust the size of the measuring circle
to the size of the button.
ð The measured buttonhole length is displayed in

the Sewing Screen.
3. Sew the buttonhole.

ð The buttonhole length remains saved until it is
overwritten, cleared or the machine is switched
off.

Programming the Buttonhole Length with the
Stitch Counter

Sewing   ► Edit   ► Buttonhole Options
► Length   ► Stitch Counter 

With the Buttonhole Foot #3C you can program the
buttonhole length with the Stitch Counter 
function. The machine sews the left bead forward, the
lower bartack, the right bead in reverse and finally the
upper bartack. The length of the right bead is not
automatically adjusted to the length of the left bead,
but must be separately programmed.

Prerequisite:
n A buttonhole is loaded.
n Buttonhole Foot #3C is attached.

1. Tap the Stitch Counter   icon.
2. Sew the left bead and stop at the desired length.

ð The Reverse  icon flashes on the Sewing
Screen.

3. Press the Quick Reverse   button.
ð The machine sews the lower bartack and starts

to sew the right bead in reverse.
ð The Reverse  icon flashes on the Sewing

Screen.
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4. Stop the left bead at the height of the first stitch
and press the Quick Reverse   button.
ð The machine sews the upper bartack.
ð The lengths of the beads are saved.
ð All additional buttonholes are sewn with the

saved count of stitches.
ð The buttonhole length remains saved until it is

overwritten, cleared or the machine is switched
off.

TIP

Detailed step-by-step instructions on this topic can
also be found in the Consultant on your machine.

Sewing a Buttonhole Manually

Sewing   ► Edit   ► Buttonhole Options
► Length   ► Sew Manually 

With the Sew Manually   function, you can sew
buttonholes segment by segment. The individual
segments of the buttonhole are displayed in the
Buttonhole bar. Every time you have sewn a segment,
you can move to the next segment by pressing the
Quick Reverse   button.

Prerequisite:
n A buttonhole is loaded.
n Buttonhole Foot #3C is attached.

1. Tap the Sew Manually   icon.
ð The individual segments are displayed in the

Buttonhole bar.
ð Segment 1 is active.

2. Sew the left buttonhole bead and stop the machine
at the desired length.
ð Segment 2 is active during sewing.

3. To switch to the next segment, tap the Quick
Reverse   button or stop the machine and select
the next segment in the buttonhole bar.

4. Finish sewing the buttonhole segment by segment.

Slit Width
Sewing   ► Edit   ► Buttonhole Options ► Slit
Width 

With the Slit Width   function, you can set the width
of the slit between 0.1 and 2.0 mm. If you make a
significant change to the slit width, you may also have
to adjust the stitch width and the stitch length.

TIP

Set a wide slit width for thick buttons on heavy
fabrics. To reinforce the buttonhole, increase the
stitch width and shorten the stitch length.
Set a narrow slit width for thin buttons on light
fabrics. To make the buttonhole lighter, reduce the
stitch width and increase the stitch length.

6.4 Tapering Stitches
Tapering stitches are decorative stitches that taper off
at the beginning and at the end. You can edit the tips
and the length of the tapering stitches. As soon as a
tapering stitch is loaded the Tapering Options
submenu appears in the editing menu.
n Tips  : For modifying the style of the tips.
n Length  : Adjust the overall length.



Sewing

6 Prepare and Edit Stitch Pattern 67

Tips
Sewing   ► Edit   ► Tapering Options ► Tips 

With the Tips   function, you can adjust the tips of
the tapering stitches. You can choose from 4
predefined tips 1 – 4 and use the Adjust
Manually   function to adjust the lateral position
and the angle of the selected tip.

Tip
Sewing   ► Edit   ► Tapering Options ► Tips 
► Adjust Manually 

With the Tip setting, you can move the tips of the
tapering stitches to the side from the far left to the far
right.

Angle
Sewing   ► Edit   ► Tapering Options ► Tips 
► Adjust Manually 

With the Angle setting, you can adjust the angle of the
tips between 0° and 90°.

Length
Sewing   ► Edit   ► Tapering Options ► Length 

With the Length   function, you can adjust the
overall length of stitch pattern. The following functions
are available:
n Record mm 
n Adjust Length 
n Sew Manually 

Record mm
Sewing   ► Edit   ► Tapering Options ► Length 
► Record mm 

With the Record mm   function, you can sew the
desired length and save it with the Reverse   button.
Additional tapering stitches with this stitch pattern are

sewn at the same length. The setting remains saved
until it is overwritten, cleared or the machine is
switched off.

Adjust Length
Sewing   ► Edit   ► Tapering Options ► Length 
► Adjust Length 

With the Adjust Length   function, you can adjust
the desired overall length im mm. The machine
automatically sews the tapering stitch.

Sew Manually
Sewing   ► Edit   ► Tapering Options ► Length 
► Sew Manually 

With the Sew Manually   function, you can sew the
middle section freely for each tapering stitch. The
machine sews the first tip and automatically switches to
the middle section. As soon as you press the
Reverse   button, the machine sews the second tip.
The sewn length is not saved.

6.5 Darning Program
The darning program No. 23 allows you to set the
darning length. As soon as the darning program is
loaded, the Darning Options submenu appears in the
editing menu.
n Darning Length  : Program the darning length.

Darning Length
Sewing   ► Edit   ► Darning Options ► Darning
Length 

The following functions are available for adjusting the
darning length:
n Record mm  : Program the darning length in

mm. [} see page 68]
n Auto Length  : Set the auto darning length.

[} see page 68]
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Record the Darning Length in mm

Sewing   ► Edit   ► Darning Options ► Darning
Length   ► Record mm 

With the Record mm   function, the machine
measures the sewn length of the first row and saves it.
The machine finishes the darning program automat-
ically.

Prerequisite:
n The Darning Program No. 23 is loaded.
n Buttonhole Foot #3A is attached.

1. Tap the Record mm   icon.
ð The Reverse  icon flashes on the Sewing

Screen.
2. Sew the first row and press the Quick Reverse 

button at the desired length.
ð The machine will complete the darning

program.
ð The darning length remains saved until it is

overwritten, cleared or the machine is switched
off.

Sew the Darning Length Automatically

Sewing   ► Edit   ► Darning Options ► Darning
Length   ► Auto Length 

With the Auto Length   function, you can adjust
the darning length in mm. The machine automatically
finishes the darning program with the set darning
length.

Prerequisite:
n The Darning Program No. 23 is loaded.
n Buttonhole Foot #3A is attached.

1. Tap the Auto Length   icon.
2. Set the darning length.
3. Sew the darning program.

ð The machine will complete the darning
program.

ð The darning length remains saved until it is
overwritten, cleared or the machine is switched
off.

6.6 Stitch Pattern Combination

Combi Mode

In Combi Mode, you can combine stitch patterns and
letters to form stitch pattern combinations or lettering.
Stitch pattern combinations can be saved and sewn as
one stitch pattern.

1 2 3 4

1 Combi Mode   2 Save   3 Combination Bar  
4 Selection Options  

Creating Stitch Pattern Combinations

Sewing   ► Combi Mode 

1. Tap the Combi Mode   icon in the Sewing
Screen.

2. Combine the desired stitch patterns or letters from
the File Manager, in sequence to form a combi-
nation.
ð The stitch patterns are inserted in the combi-

nation bar, after the stitch selected, and
displayed in the Stitch Preview.

ð The combination can be sewn and/or saved.

Editing Functions

Sewing   ► Combi Mode   ► Edit 

In the Edit Menu the Combination Options submenu
contains additional functions for editing individual
stitch patterns, multiple stitch patterns or the entire
stitch pattern combination.
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TIP

For stitch patterns in combinations, you can also use
the functions in the Edit and Optimize submenus.

Move
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Move 

With the Move   function, you can move individual
stitch patterns in combination horizontally and
vertically. Connectors are inserted between the moved
stitch pattern and the stitch pattern combination. These
connectors are not stitched but are movements of the
feed dog. When these are inserted the combination is
now a Sideways Motion pattern.

TIP

You can also drag and drop a stitch pattern in the
Sewing Screen to move it.

Duplicate
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Duplicate 

With the Duplicate   function, you can duplicate
individual stitch patterns, multiple stitch patterns or the
entire combination. The duplicated stitch patterns are
inserted after the selected stitch patterns. If the "Select
All" option is selected, the entire sequence is inserted
at the end.

Unify Width
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Unify Width 

With the Unify Width   function, you can set the
width of all stitch patterns in the combination to match
the widest stitch pattern. The Unify Width 
function is only available if the entire combination is
selected.

Unify Length
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Unify Length 

With the Unify Length   function, you can set the
length of all stitch patterns in the combination to
match the longest stitch pattern. The Unify
Length   function is only available if the entire
combination is selected.

Stop
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Stop 

With the Stop   function, you can stop the machine
automatically after any stitch pattern in the combi-
nation. The Stop   function is only available in single
selection mode.

Tie-Off
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Tie-Off 

With the Tie-Off   function, you can automatically
insert securing stitches after any stitch pattern in the
combination. The Tie-Off   function is only available
in single selection mode. The Tie-Off   function can
be combined with the Stop   and Thread Cut 
functions.

Thread Cut
Sewing   ► Combi Mode   ► Edit   ► Combi-
nation Options ► Thread Cut 

With the Thread Cut   function, you can stop the
machine after any stitch pattern in the combination
and cut the threads automatically. The Thread Cut 
function is only available in single selection mode.

TIP

Examples of Application:
n Create combination with lettering types and sew

it onto various different labels.
n Prepare lettering, interrupt it at a specific point

and continue sewing it on a new line.
n Sew a stitch pattern in a different color.

Delete
Sewing   ► Combi Mode   ► Edit   ► Combination
Options ► Delete 

With the Delete   function, you can remove the
selected stitch pattern from the combination or remove
the entire combination.
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TIP

You can also drag and drop selected stitch patterns
out of the combination bar to the left to remove
them.

6.7 Save
With the Save   function, you can save a modified
stitch pattern as follows:
n New Stitch  : Save stitch pattern as new stitch

pattern. [} see page 70]
n New Default  : Save stitch pattern with new

default settings. [} see page 70]

New Stitch
Sewing   ► Save   ► New Stitch 

With the New Stitch   function, you can save
modified stitch patterns in the folder Personal
Folder   or on a USB stick. To do so, you need to
name the new stitch and select the folder in which it
should be saved. [} see page 51]

New Default
Sewing   ► Save   ► New Default 

With the New Default   function, you can save a
modified stitch pattern as the new standard setting.
Each time you select the stitch pattern in the File
Manager, it will be opened with the new settings.

Reset

Sewing   ► Reset 

If you load a stitch with new default settings, the
Reset   function is displayed on the Sewing Screen.
With the Reset   function, you can reset the saved
settings to the factory default.
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The machine offers various options for securing the
thread at the beginning and end of the seam.

At the Beginning of the Seam
n Thread with the needle threader or press the

Thread Cutter   button.
If the Securing Stitches function is switched on in
the sewing settings, the machine secures.

n Manually sew a few stitches forward, then
backward, then forward again.

n Press the Securing   button before starting to
sew.

n With a back-kick on the foot control, if the
Securing   function is switched on for the back-
kick.

At the End of the Seam
n Manually sew a few stitches backward, then

forward again.
n Press the Securing   button when securing is to

be carried out.

n Press the Pattern End   button. The Stop 
icon appears in the stitch preview.
If the button for the Securing   function is
activated in sewing settings, the machine stops and
secures at the end of the pattern.

n Press the Thread Cutter   button.
If the button for the Securing   function is
activated in sewing settings, the machine secures
when the button is pressed and cuts the thread.

n With a back-kick on the foot control, if the
Securing   function is switched on for the back-
kick.
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Free-motion quilting often results in varying stitch
lengths due to freely guiding the fabric. The stitch
regulation compensates for these differences in stitch
length.
Integrated sensors register the movement of the fabric
and adjust the speed of the machine to suit the
movement of the fabric. The faster you guide the
fabric, the faster the machine sews. If you move the
fabric more slowly, the machine will sew equally slowly.
This ensures that all stitches are sewn to equal length,
resulting in regular stitch formation.
To use the stitch regulation, choose between the
BERNINA Integrated Stitch Regulator (BISR) and various
presser feet or the BERNINA Stitch Regulator (BSR) #42.

TIP

Detailed step-by-step instructions on this topic can
also be found in the Consultant on your machine.

8.1 Stitch Regulation

1

3

4

5

6

2

1 Stitch Regulation On/Off   2 Sound   3 Stitch  
4 Mode   5 Settings   6 KickStart  

Stitch Regulation On/Off
With the Stitch Regulation On/Off function, you can
switch the stitch regulatoin on or off. When the
function is switched off, the stitch length will not be
corrected, even if BISR mode is activated or the BSR
presser foot is attached.
For the BISR Mode function, the BERNINA
Integrated Stitch Regulator   mode must be called
up via the main menu and the 5.5-mm BISR Stitch Plate
must be attached.
The BERNINA Stitch Regulator (BSR) must be attached
in order to use the BSR Mode function [} see page 40]

Sound
With the Sound function, you can activate an audible
warning. The warning tone sounds if you feed the
fabric too quickly and the machine reaches the
maximum speed and therefore is no longer able to
correct the stitch length.

Stitch
In BISR and BSR mode, you can choose between
straight stitch and zigzag options.
The straight stitch option is suitable for free-motion
quilting, embroidery and thread painting.
The zigzag option can be used in free-motion
embroidery or thread painting.

Mode
In the Mode area, you can select the desired BSR
mode:
n BSR 1: The needle continues sewing in place if the

fabric is not being moved. [} see page 72]
n BSR 2: The needle stops when you stop moving the

fabric. [} see page 73]
n BSR 3: Basting Mode [} see page 73]

You can edit the settings associated with each mode.

KickStart
With the KickStart function, you can quilt without
continuously pressing down the foot control. [} see
page 73]

BISR 1/BSR 1 Mode
In this mode, the machine runs continuously at a low
speed once you press the foot control or the Start/
Stop   button. As you move the fabric, the machine
speeds up or slows down in order to keep to the set
stitch length.
This mode is well-suited to quilt designs with many
points or with micro-stippling, where the fabric stops
briefly with each change in direction. If the machine
continues sewing slowly when doing so, quilting feels
smoother. Sewing in place also enables you to secure
the thread without pressing an additional button.
The following settings can be selected for this mode:

Stitches per Inch (SPI)
With the Stitches per Inch (SPI) setting, you can set
the desired stitch length in stitches per inch.
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Revolutions per Minute (RPM)
With the Revolutions per Minute (RPM) setting, you
can set the speed at which the machine sews when the
fabric is not being moved. The set speed is the
minimum speed when the machine is sewing.

BISR 2/BSR 2 Mode
In this mode, the machine starts sewing as soon as you
press the foot control and move the fabric. The
machine stops as soon as you are no longer moving the
fabric or no longer pressing the foot control.
To secure the thread, you can move the fabric back and
forth in place or press the Securing   button.

Stitches per Inch (SPI)
With the Stitches per Inch (SPI) setting, you can set
the desired stitch length in stitches per inch.

BISR 3/BSR 3 Mode
This mode is intended for basting. You can choose
between two basting stitch lengths. To ensure that the
stitches are sewn correctly, move the quilt more slowly
when basting.

Using KickStart
With the KickStart   function, you can quilt without
continuously pressing down the foot control.

1. Tap the KickStart   icon.
ð The KickStart screen will appear.

2. To start the machine, press the foot control with
your heel.
ð Once the fabric is moved, the machine starts

sewing with the selected settings.
3. To stop the machine, press the foot control with

your heel.
ð The machine will stop, but the KickStart 

function will remain active.
4. To end the KickStart   function, tap the screen

or press the foot control with the ball of your foot.
ð The KickStart screen will disappear.

Please Note
n As long as the KickStart   function is active, the

function programmed for the back-kick will be
deactivated. In this case, the back-kick is instead
used to start and stop the machine.

n If no sewing is being carried out in the BSR
modes 2 and 3, the machine will switch to standby
mode after 7 seconds. This means that the machine
will not start sewing automatically if the fabric is
moved. You can end standby mode with another
back-kick.

n The KickStart   function is automatically
stopped in the following cases:

n If the active monitoring function reports an
error, e.g. thread break or bobbin empty.

n If the foot control cable is removed.

n If no sewing takes place for 60 seconds.
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9.1 Stitch Designer Screen
Sewing   ► Stitch Designer 

2

1

3

4

6

5

7

8

9

10

11

12

1 Edit   2 Stitch Design Area   3 Stitch Preview   4 Forward/Backward   5 Cancel   6 Apply   7 View   8 Move  
9 Draw   10 Selection Options   11 Stitch Information   12 Undo/Redo  

You can use the Stitch Designer to modify existing
stitch patterns or create your own stitch patterns.
Stitches created in the Stitch Designer can be saved in
the folder Personal Folder   or on an USB stick.

Undo
With the Undo   function, you can undo the most
recent actions.

Redo
With the Redo   function, you can redo undone
actions.

Stitch Information
The stitch information displays information about the
stitch pattern, depending on the selection.
n Width  : Horizontal distance between two

points.

n One point selected: Distance between the
selected point and the centerline. Points with a
negative value are to the left of the centerline,
while points with a positive value are to the right
of the centerline.

n Multiple points selected: Distance between the
two points farthest from one another.

n All points selected: Width of the stitch pattern.

n Length  : Vertical distance between two points.

n One point selected: Distance between the
selected point and the previous point.

n Multiple points selected: Distance between the
two points farthest from one another.

n All points selected: Height of the stitch pattern.

n Number of Stitches  : Number of selected
points.
If only one point is selected, this display is hidden.

Selection Options
With the Selection Options   function, you can
select individual points, multiple points or the entire
stitch pattern.
n Single Point  : Select a single point.
n Multiple Points  : Starting from the currently

selected point, select multiple connected points.
n All Points  : Select all points.
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Draw
With the Draw   function, you can draw a new stitch
pattern directly on the screen. The points are automat-
ically set in the Stitch Design Area. Once you have
drawn the stitch pattern, you can edit the individual
points.

Move
With the Move   function, you can move the
selected points within the Stitch Design Area.

TIP

You can also move points using the multi-function
knobs.

View
With the View   function, you can adjust the view on
the Stitch Designer Screen:
n Rotate  : Rotate the view by 90°, e.g. to make it

easier to design texts.
n Limit Width  : Limit the width of the stitch

design area.
n Zoom In/Zoom Out  : Zoom the view in or out.
n Zoom Factor: Reset the view to the default.

Forward/Backward
With the Forward/Backward function, you can run
the stitch pattern point by point to select a stitch point.

9.2 Editing Functions
Sewing   ► Stitch Designer   ► Edit 

With the Edit   function, you display and hide the
Edit Menu.

New
Sewing   ► Stitch Designer   ► Edit   ► New 

When you start the Stitch Designer, the selected stitch
is displayed in the stitch design area. With the New 
function, you can clear the stitch design area and start
a new stitch design.

Delete
Sewing   ► Stitch Designer   ► Edit 
► Delete 

With the Delete   function, you can delete the
selected points.

Add Stitch
Sewing   ► Stitch Designer   ► Edit   ► Add
Stitch 

With the Add Stitch   function, you can add a stitch
or a stitch pattern from any stitch category to the stitch
design. The stitch is inserted after the selected point.

Duplicate
Sewing   ► Stitch Designer   ► Edit 
► Duplicate 

With the Duplicate   function, you can duplicate the
selected points.

Mirror Left/Right
Sewing   ► Stitch Designer   ► Edit   ► Mirror
Left/Right 

With the Mirror Left/Right   function, you can
mirror the selected points along the vertical axis.

Mirror Up/Down
Sewing   ► Stitch Designer   ► Edit   ► Mirror
Up/Down 

With the Mirror Up/Down   function, you can mirror
the selected points along the horizontal axis.

Triple Stitch
Sewing   ► Stitch Designer   ► Edit   ► Triple
Stitch 

With the Triple Stitch   function, you can sew the
selected points or the stitch before a selected point
with a triple stitch.

Invert
Sewing   ► Stitch Designer   ► Edit   ► Invert 

With the Invert   function, you can reverse the
sewing order of the selected points.
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Sew Virtually
Sewing   ► Stitch Designer   ► Edit   ► Sew
Virtually 

With the Sew Virtually   function, you can virtually
sew the created stitch pattern.
Sew Virtually enables you to recognize potential errors
or problems such as uneven stitch lengths or
overlapping stitches in order to rectify them.

Snap to Grid
Sewing   ► Stitch Designer   ► Edit   ► Snap to
Grid 

With the Snap to Grid   function, you can snap the
points into place at the displayed points on the grid.
The grid helps you to align the stitch patterns symmet-
rically and maintain uniform spacing.
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Embroidery File Format
Your machine can read embroidery designs that have
been created using the BERNINA Embroidery Software
and exported as EXP files. When they are exported, a
BMP file and an INF file are created alongside the actual
embroidery file. The BMP file provides a preview of the
embroidery design and the INF file provides the infor-
mation on the thread colors. If the INF file is missing,
the embroidery design cannot be displayed in the
correct thread colors and will instead be displayed in
default colors. You can set the colors manually in the
editing functions.
The built-in embroidery alphabets are a unique format
to this machine. Once saved they are converted to an
EXP format. Some editing functions are then no longer
available.
In addition to the BERNINA embroidery file format, your
machine can also read the following embroidery file
formats: BQM, HQF, PAT, PLI, QLI, TAP, SEW, PES, PEC,
XXX, PCS, JEF and DST.
BERNINA International AG cannot guarantee that
embroidery designs that have not been created or
converted using the BERNINA Embroidery Software will
be correctly read and embroidered.

Design Size
You can increase or decrease the size of embroidery
designs by up to 20 % without loss of quality on the
machine or on a PC using the BERNINA Embroidery
Software. Embroidery Lettering can be resized greater
than 20% and stitches are recalculated.
Customizable Quilt Designs (BQM, HQF, PAT, PLI, QLI,
TAP) are vector-based embroidery designs. You can
adjust the size of such quilt designs in almost any way.
The stitch length set in the embroidery settings remains
when the pattern size is adjusted.

Upper Thread
Select high-quality embroidery threads for the upper
thread, as these have an even thickness and are less
prone to breaking. Embroidery created with glossy, fine

embroidery thread is particularly beautiful. Thread
manufacturers offer a comprehensive range of thread
types and colors.
n Polyester with a sheen is durable, break-resistant

and colorfast. Polyester with a sheen is suitable for
all types of embroidery.

n Rayon is a fine, silk-like fiber with a glossy effect.
Rayon is suitable for fine embroidery that is not
subject to heavy stress.

n Metallic thread is a glossy thread available in fine to
medium thicknesses, and is suitable for special
effects in embroidery.
When using metallic threads, switch off the
automatic thread cutter and reduce the embroidery
speed and upper thread tension.
To reduce thread breakage, you can use the Thread
Lubrication Unit.

Bobbin Thread
Special bobbin thread for embroidery is usually only
available as black or white thread. If both sides of the
embroidery will be visible, you can also use the upper
thread in the same color or another normal embroidery
thread as the bobbin thread.
n Embroidery bobbin thread is an especially soft and

light polyester thread which is suited to be used as
bobbin thread. This special bobbin thread ensures a
steady thread tension and an optimal intertwining
of the upper and bobbin thread.

Stabilizers
Use a stabilizer to stabilize the fabric during stitching.
Light weight and knit fabrics are difficult to hoop and
tend to deform. A stabilizer prevents the fabric moving
or puckering during stitching.
There are various types of stabilizers for various appli-
cations.

Stabilizer Scope of Application Fabric/Application

Cut-away Stabilizer Necessary: Knit fabrics
Possible: Woven fabrics

n Jersey, sweater, knitwear, stretch fleece
n Embroidery designs with high stitch density

Tear-away Stabilizer Woven fabrics n Denim, cotton, linen, felt, wool, silk

Water-soluble Stabilizer Washable fabrics
Projects where there must
not be any visible stabilizer
residue

n Organza, net, chiffon
n Freestanding embroidery
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Stabilizer Scope of Application Fabric/Application

Topping Fabrics with a pile or texture n Velvet, fleece, plush, knit fabrics, corduroy,
broadcloth

Adhesive Stabilizer Fabrics or projects that
cannot be hooped

n Leather, imitation leather, cork, velvet, velour,
neoprene, fur, corduroy

n Collar corners, pockets, cuffs

Hydro Stabilizer For most embroidery appli-
cations

n Leather, imitation leather, cork, velvet, velour,
neoprene, fur, corduroy

n Collar corners, pockets, cuffs

Iron-on Stabilizer Iron-on fabrics n Appliques and patches

Stabilizers can be fixed onto the fabric with adhesive
spray or starch spray before hooping. Starch spray can
be used to stiffen the fabric before embroidering.

Embroidery Test
For important projects it is recommended to test sew
the embroidery design on the same or similar fabric
using the same stabilizer, threads and needle.
n An embroidery test enables you to recognize

potential errors or difficulties in advance so that
you can make appropriate adjustments.

n The embroidery test enables you to check the
selected embroidery threads and colors appear on
the fabric and adjust as needed.

n The embroidery test enables you to determine the
ideal stitch density and apply the correct settings.
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Main Menu   ► Embroidery 

1 2 3 4 5 6

778899

1 Status Bar   2 Undo/Redo   3 Info Box   4 Design Preview   5 Edit   6 Layer Bar   7 Stitchout   8 Save   9 View  

Undo
With the Undo   function, you can undo the most
recent actions.

Redo
With the Redo   function, you can redo undone
actions.

Info Box
In the Info Box, you can find the following information
about the embroidery design:
n Embroidery Time  : Estimated time required to

stitchout the selected layer(s).
n Embroidery Size  : Overall width and height of

selected layer(s).
n Number of Colors  : Number of colors used in

the selected layer(s).

Design Preview
The Design Preview shows a preview of the current
embroidery designs in the attached or selected hoop.

Edit
With the Edit   function, you can show editing
functions for the embroidery designs. [} see page 84]

Stitchout
With the Stitchout   function, you can open the
Stitchout Summary window und start stitchout.
[} see page 94]

Save
With the Save   function, you can save the
embroidery design in your Personal Folder or on a USB
stick. [} see page 93]

View
With the View   function, you can adjust the view on
the Embroidery Screen.
n Background  : Adjust the background of the

hoop. [} see page 83]
n Background On/Off  : Display or hide the

background of the hoop.
n Grid  : Display the center of the hoop, display a

grid and hide the center point and grid.
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n Zoom In/Zoom Out  : Zoom view in or out.
n Default: Reset the view to the default.

Context Menu
You can tap and hold an object to open a context
menu with the following functions:
n Edit Text: Change selected text.
n Lock: Lock selected object for editing. The layer is

marked with the Lock   icon. You can unlock the
object by tapping the Lock   icon in the layer bar.

n Delete: Delete selected objects.
n Delete All: Delete all objects.
n Mirror Left/Right: Mirror the selected object on a

vertical axis.
n Mirror Up/Down: Mirror the selected object on a

horizontal axis.
n Select All: Select all objects.

11.1 Status Bar
The Status Bar displays the state of various functions.
Some functions can be set directly with the respective
status, e.g. the needle position or the laser. For other
functions, you can open the settings via the status
display, e.g. upper thread tension.
The color of the icon shows the current state of the
function.
n White: Default setting
n Blue: Active setting
n Yellow: Modified setting
n Red: Warning

WiFi, Time and Alarm
The WiFi   icon displays the WiFi connectivity, the
current time and alarm if active.
By tapping the icon, you open the settings for WiFi,
Time and the Alarm function. In the Settings, you can
switch the WiFi connection on or off or set up the WiFi
connection. [} see page 45]
You can also set a reminder. [} see page 44]

Upper Thread Tension
The Upper Thread Tension   status shows the
recommended upper thread tension for the selected
embroidery design.
You can modify the upper thread tension for the
selected embroidery design by tapping the status.
[} see page 45]

Presser Foot
The Presser Foot   status shows the recommended
or selected presser foot.

You can open presser foot selection by tapping the
icon. In the presser foot selection, you can select the
attached presser foot and display details about the
presser foot. [} see page 41]

Hoop
The Hoop   status displays the attached hoop. If no
hoop has been attached, the status shows the recom-
mended hoop for the selected embroidery design.
n White/Bue: Default and/or selected hoop.
n Yellow: Attached and recognized hoop.
n Red: Incompatible hoop or design does not fit

inside the hoop area.

You can select the attached hoop and display details
for the hoop by tapping the status. [} see page 43]

Stitch Plate and Sewing Needle
The Stitch Plate and Sewing Needle   status
shows the selected needle and the attached stitch
plate. The attached stitch plate is automatically
recognized.
You can open the needle overview and select the
attached needle by tapping the icon. [} see page 33]

Feed Dog
The Feed Dog   status shows the position of the
feed dog. In embroidery mode, the feed dog is lowered
automatically.

Bobbin Thread
The Bobbin Thread   status shows the fill capacity of
the lower thread bobbin.
n White: Good
n Yellow: Low or Empty

You can open the Bobbin Thread Status by tapping the
Bobbin Thread   icon. In the setting, the bobbin fill
capacity is shown and you can visualize the animation
and step-by-step instructions to insert the Bobbin Case.

TIP

Toggle the light on/off to make it easier to insert the
Bobbin Case when the Slide-on Table is attached.

Camera
The Camera   icon shows the status of the camera.
n White: Camera off.
n Yellow: Camera on.
n Red: Camera not available.

You can switch the camera on and off for a live image
of the embroidery area by tapping the icon. You can
only switch on the camera if a hoop is attached.
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Laser
The Laser   icon shows the status of the laser.
n White: Laser off.
n Yellow: Laser on.

By tapping the icon, you can switch the laser on and
off.
The laser indicates the next stitch point in sewing mode
and the exact needle position in embroidery mode.
Depending on the presser foot and needle position, the
entry point may be concealed by the presser foot. To
avoid the deflection of the laser with transparent
presser feet, you can lower the presser foot before the
sewing start, e.g. with the Knee Lifter.

11.2 Layer Bar

1
2
3
4

1 Add Design   2 Embroidery Design Layers  
3 Embroidery Designs Combined   4 Selection Options  

In the layer bar, the individually added embroidery
designs or elements of an embroidery design are
displayed as layers. The most recently added
embroidery design is shown at the top. The lowest
layer shows all added embroidery designs combined.
The order of the layers affects the embroidery.
The following functions are available in the layer bar:
n Add Design  : Add embroidery designs from the

File Manager. [} see page 83]
n Selection Options  : You can select a single

layer, multiple layers or all layers for editing. [} see
page 21]

n Change the order of the layers by moving them or
delete layers by dragging them out. [} see page 20]

11.3 File Manager
In the File Manager, you can load and manage
embroidery designs. The File Manager is shown when
the Add Design   function is tapped in the layer bar.

1
2

3

4

1 Toolbar   2 Navigation Bar   3 Quick Access Bar  
4 Selection Area  

Toolbar

In the toolbar, you will find functions for searching for
files, adjusting the view and managing your own files in
your Personal Folder and on a USB stick.

Search
With the Search   function, you can search for
embroidery designs by name in the currently selected
folder.

Selection
With the Selection   function, you can select folders
or files that you wish to manage using a function from
the Options   menu.
The Selection   function is only available for the
Personal Folder   and USB Stick   folders.

Options
With the Options   menu, you can manage the
selected file(s) or folder(s) using the Selection 
function.
n Rename: Renaming a File or Folder. [} see

page 23]
n Cut: Cut File(s) or Folder(s). [} see page 23]
n Copy: Copy File(s) or Folder(s). [} see page 23]
n Paste: Paste cut or copied File(s) or Folder(s). [} see

page 23]
n New Folder: Create New Folder.
n Information: Show preview and further infor-

mation on the stitch pattern.
n Select All: Select all displayed File(s) and Folder(s).
n Delete: Delete File(s) or Folder(s). [} see page 23]
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The Options   menu is only available for objects in
the Personal Folder   and USB Stick   folders.

View
With the View   function, you can switch the view
in the selection area between grid and list view. In the
grid view, you can choose between large and small
icons.

USB Stick
With the USB Stick   function, you can switch
between your Personal Folder and the USB Stick in the
selection area.
This function is only available if a USB stick is inserted.

Fullscreen
With the Fullscreen   function, you can expand the
File Manager to fill the entire screen and show
additional functions.

Navigation Bar

The Navigation Bar shows the path to the selected
folder. With the Back  function, you can go back
step by step.

Quick Access Bar

With the Quick Access Bar you can directly access the
various embroidery design folders, your Peronal Folder
and a USB stick.

Embroidery Designs
In the Embroidery Designs   folder, you will find all
embroidery designs that are supplied with the machine.
The embroidery designs are collated into folders by
subjects. [} see page 119]

Lettering
In the Lettering   folder, you will find alphabets
which you can use to create your own texts. [} see
page 91]

Sewing
In the Sewing   folder you will find all the sewing
stitches and can use them as embroidery designs.
[} see page 53]

Personal Folder
In the folder Personal Folder  , you can save and
load your own embroidery designs. You can organize
the embroidery designs in folders. [} see page 23]

USB Stick
In the folder USB Stick  , you can save or load your
own embroidery designs on a USB stick. You can
organize the embroidery designs in folders.

Selection Area
In the Selection Area, you can navigate through the
folders and load an embroidery design. Each
embroidery design is displayed with a preview image
including details of the file format.
If you press and hold on an embroidery design, a
preview and further information is displayed, such as
the number of stitches, the recommended hoop or the
embroidery motif size. If you tap the icon Load   in
the preview, the embroidery design is loaded.
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12.1 Loading the Embroidery
Design

1 2 3

1 Add Design   2 Selection Area   3 Quick Access Bar  

1. If the File Manager is not open, tap the Add
Design   function in the layer bar.

2. Tap the embroidery design category in the Quick
Access Bar.

3. Find and load the desired embroidery design in the
File Manager.
ð The embroidery design is displayed in a hoop in

the design preview that is closest to the size of
the design.

Further information on the selection area can be found
in the File Manager. [} see page 81]

12.2 Hoop Background
Embroidery   ► View   ► Background 

With the Background   function, you can select a
hoop background.
n None: Show white background.
n Scanned Image: Scan the hoop and show as a

background image. [} see page 83]
n Color: Set the background color. [} see page 83]

Scan Hoop
If you wish to position an embroidery design precisely
on patterned fabric, a quilt or a project, simply hoop
the fabric and scan it as a background image.

Prerequisite:
n A hoop with the hooped project is attached.
n An embroidery foot or no presser foot is attached.

n The thread is removed from the needle and is
outside the embroidery area.

1. Select the Scanned Image option in the
Background   function.
ð The last scanned image is displayed.

2. Tap the Scan Hoop   icon.
ð The hoop is scanned and the image is

displayed.
ð With the Delete   function, you can delete

the scanned image.
ð With the Scan Hoop   function, you can scan

the hoop again.
3. To use the scanned image as the background,

confirm the image.

Setting the Background Color
You can use a colored hoop background to simulate
the color of the fabric, so that you can better visualize
how the embroidery design will appear on the project.
Embroidery designs with light colors in particular are
easier to see on a dark background.

1. Select the Color option in the Background 
function.

2. Set the hue, saturation and brightness to your
preferences and confirm.
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12.3 Embroidery Design Editing
Embroidery   ► Edit 

With the Edit   function, you can view the editing
functions. The editing functions are summarized in the
Edit, Arrange and Position submenus.
The results of editing are shown in real time in the
design preview in the selected hoop.

Editing Functions

The editing functions for embroidery designs are
grouped together in the Edit submenu. The editing
functions are applied to the currently selected layers.

Move
Embroidery   ► Edit   ► Edit ► Move 

With the Move   function, you can move the
selected layers horizontally and vertically. With the
Center   function, you can position the layers in the
center of the hoop.

TIP

You can also move the layers directly in the design
preview, e.g. using finger gestures or the multi-
function buttons.

Rotate
Embroidery   ► Edit   ► Edit ► Rotate 

You can use the Rotate   function to rotate the
selected layers in 1° or 45° increments.

TIP

You can also rotate the layers directly in the design
preview, e.g. using finger gestures or the multi-
function buttons.

Resize
Embroidery   ► Edit   ► Edit ► Resize 

With the Resize   function, you can modify the size
of the selected layers. With the default setting, the
length and width is changed proportionally. With the
Proportional   function, you can unlink the length
and width, enabling you to set the values separately.
You can also modify the size of the layers directly in the
design preview. Moving the corner points will change
the size of the layers proportionally. Moving the side
points will change the size of the layers non-propor-
tionally.

TIP

For best results, do not enlarge or reduce the layers
by more than 20%.

Duplicate
Embroidery   ► Edit   ► Edit ► Duplicate 

With the Duplicate   function, you can duplicate the
selected layers.

Mirror Left/Right
Embroidery   ► Edit   ► Edit ► Mirror Left/
Right 

With the Mirror Left/Right   function, you can
mirror the selected layers along the vertical axis.

TIP

You can also access this function by pressing and
holding an embroidery design.

Mirror Up/Down
Embroidery   ► Edit   ► Edit ► Mirror Up/Down 

With the Mirror Up/Down   function, you can mirror
the selected layers along the horizontal axis.

TIP

You can also access this function by pressing and
holding an embroidery design.

Stitch Density
Embroidery   ► Edit   ► Edit ► Stitch Density 

With the Stitch Density   function, you can set the
density of stitches in the selected layers. This change is
only shown in the design preview once you have
confirmed the modified value. Depending on the size
and complexity of the embroidery design, processing
time to calculate the preview may be required.
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Colors
Embroidery   ► Edit   ► Edit ► Colors 

With the Colors   function, you can display and
modify the colors and thread brands of the selected
layers.
The following functions enable you to edit the thread
brand and the color:
n Change Color  : Modify the color and thread

brand of the selected color. [} see page 87]
n Back to Default  : Reset all changes to default

settings.
n Color Wheel  : Modify all colors at the same

time or modify colors individually. [} see page 87]
n Change Brand  : Modify the thread brand for

all colors simultaneously. [} see page 87]

Shape Designer
Embroidery   ► Edit   ► Edit ► Shape Designer 

With the Shape Designer   function, you can
arrange the selected layers around a shape, e.g. around
a circle. You can change the arrangement to create
unique embroidery design combinations. [} see
page 88]

Delete
Embroidery   ► Edit   ► Edit ► Delete 

With the Delete   function, you can delete the
selected layers.

TIP

You can also drag and drop selected layers out of the
layer bar to the left to remove them.

Arranging Functions

The arranging functions for embroidery designs are
grouped together in the Arrange submenu.

Group
Embroidery   ► Edit   ► Arrange ► Group 

With the Group   function, you can group together
the selected layers. The group is displayed in place of
the lowest selected layer in the layer bar.

Ungroup
Embroidery   ► Edit   ► Arrange ► Ungroup 

Multi-colored embroidery designs are saved as a single
group, where each color forms its own layer. With the
Ungroup   function, you can split up an embroidery
design into its color layers and up to its connecting
stitches. The layers are displayed separately in the layer
bar and can be edited separately.
Embroidery designs that have previously been grouped
together can also be split up again with the
Ungroup   function.

Move Up
Embroidery   ► Edit ► Arrange ► Move Up 

With the Move Up   function, you can move the
selected layer upward step by step in the layer bar.
Moving layers upward will cause them to be stitched
later. The top layer is stitched last.

TIP

You can also move a layer within the layer bar with
finger gestures.

Move Down
Embroidery   ► Edit ► Arrange ► Move Down 

With the Move Down   function, you can move the
selected layer downward step by step in the layer bar.
Moving layers downward will cause them to be stitched
earlier. The bottom layer is stitched first.

TIP

You can also move a layer within the layer bar with
finger gestures.

Align
Embroidery   ► Edit ► Arrange ► Align 

With the Align   function, you can align multiple
selected layers with each other, center multiple selected
layers together, or distribute multiple selected layers
evenly.
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Match Start/Stop
Embroidery   ► Edit   ► Arrange ► Match Start/
Stop 

With the Match Start/Stop   function, you can
combine two embroidery designs, e.g. BQM Quilt
Designs or sewing stitches. The last stitch of a selected
embroidery design is merged with the first stitch of the
next selected embroidery design in the layer bar. The
second embroidery design is moved to the last stitch of
the first embroidery design.

This function is particularly useful in the following
applications:
n Borders
n Shape Designer
n Duplicate
n Assembling Customizable Quilt Designs

In combination with the Reduce Thread Changes
function, the embroidery designs are joined together
without sewing stitches and stitched out seamlessly.

Positioning Functions

The positioning functions for embroidery designs are
grouped together in the Position submenu.

Center Design
Embroidery   ► Edit ► Position ► Center Design 

With the Center Design   function, the needle
position is moved to the center of the embroidery
design.
This function is only active if a hoop is attached.

Check Design
Embroidery   ► Edit ► Position ► Check Design 

With the Check Design   function, you can check
the four corners and the center of the selected layer
and move the embroidery design if necessary. [} see
page 88]

Virtual Positioning
Embroidery   ► Edit ► Position ► Virtual
Positioning 

With the Virtual Positioning   function, you can
move the hoop such that the needle is at the selected
position in the design preview. With this function you
can check the position of an embroidery design stich-
by-stitch.
This function is only active if a hoop is attached.

TIP

You can use the laser to precisely check the virtual
positioning.

Pinpoint Placement
Embroidery   ► Edit ► Position ► Pinpoint
Placement 

With the Pinpoint Placement   function, you can
position an embroidery design at a specific position in
the hoop. You can also rotate and modify the size of
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the embroidery design while doing so in order to
ensure that it is correctly stitched, even if the fabric is
not clamped straight. [} see page 88]

Endless Embroidery
Embroidery   ► Edit ► Position ► Endless
Embroidery 

With the Endless Embroidery   you can stitch combi-
nations that are longer than the hoop. Reference
markings can be programmed and stitched, which are
useful for repositioning the hoop after re-hooping. You
can also create combinations of designs and stitch
patterns, duplicate them and use them to fill the area
of the hoop, e.g. as a patterned background for an
embroidery project. [} see page 90]

Show Start/Stop
Embroidery   ► Edit ► Position ► Show Start/
Stop 

With the Show Start/Stop   function, you can
display the first and the last stitch of each individual
embroidery design in the design preview.
n Green: First stitch
n Red: Last stitch

Flip Start/Stop
Embroidery   ► Edit ► Position ► Flip Start/Stop 

With the Flip Start/Stop   function, you can reverse
the stitch sequence of Customizable Quilt Designs.

Changing the Colors

Embroidery   ► Edit   ► Edit ► Colors 

1 2 3 4 5

6
7
8

1 Color   2 Embroidery Sequence   3 Color Number  
4 Thread Brand   5 Change Color   6 Back to Default  
7 Color Wheel   8 Change Brand  

There are the following options available for changing
a color in an embroidery design:
n Change Color  : Select a color from a color

palette.
n Change Color  : Use the Search   function to

search for a color by color number.
n Color Wheel  : Modifying colors with the color

wheel.

Modifying Colors with the Color Wheel

1

2

3

4

1 Color Bar   2 Slider Hue   3 Selected Color  
4 Brightness  

With the Color Wheel   function, you can change all
the colors in an embroidery design simultaneously or
modify each color separately.

1. Select the color to be changed in the color bar.
ð The selected color is highlighted in the color

wheel.
2. To modify the hue of all colors, turn the color

wheel with the Hue control.
3. To change the hue of an individual color, pull the

highlighted color in the color wheel to the desired
point.

4. To change the brightness of the selected color,
move the Brightness control.
ð The changes are displayed in the color bar and

in the design preview.

Change Thread Brand

Embroidery   ► Edit   ► Edit ► Colors 

The embroidery designs are programmed with the
Isacord 40 thread brand. If you would rather work with
embroidery threads from other brands, you can change
the thread brand.

1. To change the thread brand for all threads in the
layer, tap the Change Brand   icon and select
the thread brand from the list.
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2. To change the thread marker for an individual
color, select the color, tap the Change Color 
► Change Palette   icon, select the thread
marker from the list and tap the desired color.

Arranging Embroidery Designs

Embroidery   ► Edit   ► Edit ► Shape Designer 

With the Shape Designer   function, you can create
unique embroidery design combinations.

Prerequisite:
n A layer or multiple layers are loaded.
n The size and colors of the embroidery designs have

been adjusted.

1. Activate the Shape Designer   function.
2. Select the shape form for arranging the motifs.
3. Set the number of motifs.
4. Set the size of the shape.
5. Align the motifs with the shape.
6. Mirror motifs and/or rotate in 45° steps if required.

ð Every second motif is mirrored.
7. To reset the arrangement, tap the selected shape

again.

Check Design

Embroidery   ► Edit   ► Position ► Check
Design 

With the Check Design   function, you can check
the intended position of your embroidery design in the
hoop before you start stitching out.

Prerequisite:
n A hoop with the hooped project is attached.

1. Tap an arrow in the Move Hoop to Position area.
ð The hoop moves until the needle is located at

the selected point of the embroidery design, as
long as the point is within the area to be
embroidered.

2. Check whether the position is correct.
3. If necessary, move the embroidery design

horizontally and vertically.
4. If necessary, check other positions.

Pinpoint Placement

Embroidery   ► Edit   ► Position ► Pinpoint
Placement 

With the Pinpoint Placement   function, you can
position the embroidery design with the following
options:
n Grid 
n Free Point 
n Four Point 

TIP

Using the Laser function, you can position the point
precisely at the desired location on the fabric.

Positioning the Embroidery Design by 2 Grid
Points

With the Grid   option, you can position embroidery
designs precisely on the fabric using 2 grid points.
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Prerequisite:
n The desired position of the embroidery design is

marked on the fabric with two points and is clearly
visible.

n A hoop with the hooped project is attached.

1. Tap the Grid   icon.
2. To maintain the size of the embroidery design,

activate the Retain Size   function.
3. Select any point on the grid as the rotation point.
4. Position the needle at the corresponding marking

on the fabric using the multifunction knobs and
confirm with the Pin   button. You can activate
the laser to assist with exact positioning of the
needle.

5. Select a second grid point. Position the needle at
the second marking on the fabric and confirm with
the Pin   button.

Positioning the Embroidery Design by means
of 2 Freely Positioned Points

With the Free Point   option, you can position
embroidery designs precisely on the fabric using 2
freely positioned points.

Prerequisite:
n The desired position of the embroidery design is

marked on the fabric with two points and is clearly
visible.

n A hoop with the hooped project is attached.

1. Tap the Free Point   icon.
2. To maintain the size of the embroidery design,

activate the Retain Size   function.
3. Select any point on the embroidery design as the

rotation point.
4. Position the needle at the corresponding marking

on the fabric using the multifunction knobs and
confirm with the Pin   button. You can activate
the laser to assist with exact positioning of the
needle.

5. Select the second point of the embroidery design.
Position the needle at the second marking on the
fabric and confirm with the Pin   button.

Positioning the Embroidery Design in a
Square

With the Four Point   option, you can position the
embroidery design in a square using four points, e.g. in
a quilt block. The following options can be used to
place the design:
n Morph  : The embroidery design is reshaped so

that it fits into the boundary.
n Fit  : The embroidery design is inserted propor-

tionally and centered within the boundary.

Prerequisite:
n The desired position of the embroidery design is

marked on the fabric with four points and is clearly
visible, or the hoop has been scanned and the
preview displays the fabric. [} see page 83]

n A hoop with the hooped project is attached.

1. Tap the Four Point   icon.
ð The design is placed inside a rectangular

bounding box.
2. Select one of the corner points and position the

needle over the corresponding marking on the
fabric with the multi-function knobs. You can
activate the laser to assist with exact positioning of
the needle.

3. Select all corner points one after the other and
position the needle.
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4. Select the Morph   or Fit   option.
ð The design is placed inside a bounding box.

5. To maintain the size of the embroidery design,
activate the Retain Size   function.

6. If necessary, set a margin spacing from the grid.

Borders

Embroidery   ► Edit   ► Position ► Endless
Embroidery 

With the Endless Embroidery   function, you can
stitch combinations that are longer than the hoop.

TIP

n Using a larger hoop will require less re-hooping.
n To help keep the designs straight, draw guide

lines on the fabric and use the template for
clamping and re-hooping. Make sure that the
guide lines run parallel to the lines of the
template. You can also reposition the embroidery
design using the Pinpoint Placement 
function.

Creating Borders

Prerequisite:
n A hoop with the hooped project is attached.

1. Select an embroidery design.
2. Select the Endless Embroidery   function.

ð The embroidery design is multiplied to match
the hoop.

ð Marker positions are inserted.
3. If necessary, insert additional marker positions. The

marker points are also embroidered and help to
align the project when rehooping.

4. If necessary, enter the number of repetitions of the
embroidery design.

5. If necessary, adjust the size of the embroidery
design so that it fits into the hoop.

6. If necessary, adjust the spacing between the
embroidery designs.

7. Confirm settings.

Endless Embroidery

Prerequisite:
n A hoop with the hooped project is attached.

1. With the Stitchout   function, open the
Stitchout Summary screen and confirm the
settings.

2. Use the Start/Stop   button to start stitching
out.

3. Once the embroidery design has been fully stitched
out, remove the hoop and re-hoop the fabric so
that the stitched-out marker positions are located
in the upper embroidery area of the hoop.

4. Using the Pinpoint Placement  ► Free
Point  function in the embroidery design,
connect at the stitched marker postions. [} see
page 86]

5. Continue stitchout.
6. Repeat these steps until the required length of the

trim has been achieved.
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12.4 Lettering

Lettering

Embroidery   ► Lettering 

Font Name

Art Deco Block

Artemis Script

Astra

Athletic Block

Atlantic Script

Basic Block

Blackletter English

Boffo

Cyrillic Book

Chancery

Font Name

Children's Slab

Chivalry

Condensed Sans

Curved Block

Cyrillic Calligraphic

Flare

Full Block Outline

Full Block

Happy Times

Micro Block

Oriental Script

Park Avenue

Quilt Block

Winding Times
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Creating Lettering

1 432

1 Justification   2 Font Selection   3 Keyboard   4 Text
Preview  

You can design single-line or multi-line lettering.

1. Tap the Add Design   icon in the layer bar.
2. In the File Manager, tap the Lettering   tab and

select a font.
3. Type in the text using the on-screen keyboard. You

can adjust the font, orientation and line breaks to
suit your preferences when doing so.
ð The changes are displayed in the preview.

4. Confirm the completed text.

Access special characters by long pessing on the
keyboard character, e.g. "È", "É" etc. when you press
the letter "E".

Editing Functions

Embroidery   ► Edit 

You can edit lettering using special functions. These are
grouped together in the Lettering submenu.

Edit Text
Embroidery   ► Edit   ► Lettering ► Edit Text 

With the Edit Text   function, you can edit the
lettering. This enables you to correct text, insert line
breaks or modify the alignment.

TIP

You can also access this function by pressing and
holding an embroidery design.

Transform
Embroidery   ► Edit   ► Lettering ► Transform 

With the Transform   function, you can reshape
single-line text as follows:
n Horizontal  : Arrange text horizontally.
n Vertical  : Arrange text vertically.
n Arch  : Reshape horizontal text into an arch.

Spacing
Embroidery   ► Edit   ► Lettering ► Spacing 

With the Spacing   function, you can modify the
character spacing.

Line Spacing
Embroidery   ► Edit   ► Lettering ► Line
Spacing 

With the Line Spacing   function, you can modify
the spacing between lines for multi-line lettering.

Styling
Embroidery   ► Edit   ► Lettering ► Styling 

With the Styling   function, you can modify the
stitches in the lettering with the following settings:
n Stitch Density: Modify the density of the lettering.
n Pull Compensation: Compensate for the fabric

contracting when stitching.
n Satin Value: Transform satin stitches that are

longer than the set value into step stitches.

The lettering is recalculated and the changes are only
shown in the design preview when you confirm the
settings.
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12.5 Saving Embroidery Designs
Embroidery   ► Save 

You can save modified embroidery designs in the
Personal Folder or on a USB stick.

1. Tap the Save   icon.
2. Enter and confirm the embroidery design name.
3. Select a folder, create a new folder or select the

USB Stick   icon in the toolbar and confirm.
ð The embroidery design is saved in the Personal

Folder  or on the USB stick .
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13.1 Stitchout Summary
Embroidery   ► Stitchout 

In the Stitchout Summary screen, you can modify the
most common settings for optimal stitchout quality
before entering the Stitchout. Additional settings can
be modified in Embroidery Settings. [} see page 47]

Hoop
The Hoop   status shows the attached hoop.

Stitch Plate
The Stitch Plate   setting shows the attached stitch
plate.

Presser Foot
The Presser Foot   setting shows the selected presser
foot. If you use a different presser foot, you can select
it from the list. The list contains all presser feet that are
suitable for embroidery.

Quilt Settings
With the Quilt Settings   function, you can switch
on and off special quilt settings for thread cutting and
securing. The following options are available:
n On: Activate quilt settings.

n Quilt Securing Stitches.

n Thread Cut Disabled.

n Thread Away Disabled.

n Off: Adopt the thread cut settings from the
embroidery settings. [} see page 48]

Thread Away
With the Thread Away   function, you can set cut
threads to be pulled to the rear of the fabric for cleaner
embroidery on the top.
For embroidery designs with long stitches, it is recom-
mended to switch off the function because the presser
foot could get caught in the long stitches due to the
rapid movement of the embroidery arm. The same risk

applies when working with appliqué, water-soluble
non-woven materials or other raised decorations such
as buttons.
The Thread Away   function should not be used if
the Thread Cutting   function is switched off.

Color
With the Color   setting, you can define how thread
changes are handled during embroidery. The following
options are available:
n Multi Color: The embroidery design is stitched

with multiple colors as indicated in the saved
design.
After each color, the machine stops so that you can
change the threads.

n Single Color: The embroidery design is stitched
with the thread that is currently threaded, without
changing threads.

n Reduce Thread Changes: The embroidery design
is regrouped so that the fewest possible thread
changes need to be made.
Use this function when sewing Customizable Quilt
Designs to avoid multiple starts and stops.
If this function is activated, the colors are also
regrouped in edit mode.

Basting
With the Basting   function, you can secure
materials in the hoop that cannot be hooped, e.g., felt,
organza and silk. The basting can also be used to
prevent top stabilizers from moving or as a guide for
trimming after embroidery. The following functions are
available:
n None: No basting is stitched.
n Around Design: The machine sews a basted seam

around the embroidery design.
If you sew a basted seam around the embroidery
design, you can determine the distance between
the basted seam and the embroidery design. Use
the basted seam around the pattern if the
embroidery design is substantially smaller than the
hoop, or if you are only embroidering a small piece
of fabric.

n Around Hoop: The machine will sew a basted
seam along the inner edge of the hoop.
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Thread Cutting
With the Thread Cutting   function, you can switch
automatic cutting of the thread on and off. The
following options are available:
n Off: The thread is not automatically cut.
n On Thread Change: The thread is automatically

cut on thread changes.
n On Jump Stitch: The thread is automatically cut

when connecting stitches are made.

If this option is selected, you can define the length
of the connecting stitch at which the thread is to
be cut.

Fabric Thickness
With the Fabric Thickness   function, you can set
the thickness of the fabric. The set value affects the
embroidery speed. The higher the value, the slower the
machine embroiders so that the needle does not get
stuck in thicker fabrics.

13.2 Stitchout
Embroidery   ► Stitchout   ► OK 

8
7 6

5

3

10

1

2

9

4

1 Design Preview   2 Color Bar   3 Color Change   4 Embroidery Information   5 High Speed   6 Stitch   7 Summary  
8 Edit   9 Current Color   10 View  

The Stitchout screen appears when the embroidery
design is ready for stitching out. You can start stitching
with the Start/Stop   button.

Design Preview
The design preview shows the embroidery design as it
will be stitched out. When it is opened, the current
color layer is adjusted in the preview. You can adjust
the preview with finger gestures or the view slider.

Color Bar
The color bar shows the color layers in the order in
which they will be stitched out. The length of the
individual color sections corresponds to the count of
stitches in that color – the more stitches, the longer the
section.
You can scroll left and right in the color bar using the
two arrow keys, in order to display other colors in the
embroidery design.
If you select a color, that color is displayed in the
Current Color bar and in the design preview. At the
same time, the hoop is moved to the starting position
for the selected color. The embroidery information is
also adjusted.
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Color Change
With the Color Change   function, you can define
how thread changes are handled during embroidery.
This setting overwrites the setting on the Stitchout
Summaryscreen. The following options are available:
n Multi Color  : The embroidery design is stitched

with multiple colors as indicated in the saved
design.
After each color, the machine stops so that you can
change the threads.

n Single Color  : The embroidery design is
stitched with the thread that is currently threaded,
without changing threads.

n Reduce Thread Changes  : The embroidery
design is regrouped so that the fewest possible
color changes need to be made.
Use this function when sewing Customizable Quilt
Designs to avoid multiple starts and stops.
If this function is activated, the colors are also
regrouped in edit mode.

Embroidery Information
The following information about the embroidery
process is displayed in the Embroidery Information area:
n Color: Sequence number of the current color.
n Stitch: Current stitch number/Total stitch number.
n Total Time: Estimated stitch time for the whole

design.
n Color Time: Estimated stitch time for the current

color.

High Speed
Embroidery designs are stitched out at the optimum
speed for an even embroidery pattern. The optimum
embroidery speed depends on the hoop used. With the
High Speed   function, you can increase the
embroidery speed up to the saved maximum speed.
Depending on the type of stitch, e.g. triple stitch, the
function may result in an irregular stitch pattern.
This function is only available once you have started
stitching out using the Start/Stop   button.

Stitch
With the Stitch   function, you can return to a
specific point in the embroidery after a thread break or
other interruption in the embroidery process in order to
continue stitching from that point. The machine
displays the needle position at the time the process was
canceled.
You can move stitch by stitch or use the lower multi-
function knob to move across larger sections of the
design. The laser makes it easier to recognize the
current stitch.

If you wish to return to a specific stitch, you can enter
the number of the stitch.

Summary
With the Summary   function, you can cancel
stitchout in order to modify the current embroidery
settings in the Stitchout Summary screen.

Edit
With the Edit   function, you can cancel stitchout in
order to edit the embroidery design.

Current Color
The color bar shows the current thread color with the
thread brand and number.
If the machine is sewing, the slider shows the current
needle position. If the machine is not sewing, you can
move the slider to move the needle to a desired
position.

View
With the View   function, you can modify the size of
the embroidery design in the design preview.
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14.1 Software

Update Firmware

Settings   ► Machine   ► Update and Reset
► Update Firmware

You can use the Update Firmware function to install
the latest version of the firmware on your machine.
You can update the current firmware of the machine
and download detailed step-by-step instructions for the
update process at www.bernina.com/990-support.

Prerequisite:
n The latest firmware data has been downloaded and

copied to the USB stick according to the update
instructions.

1. You can open the Update Firmware function in
the settings.

2. Update the firmware according to the instructions
on the screen.

Reset Settings

Settings   ► Machine   ► Update and Reset
► Reset Settings

With the Reset Settings functions, you can reset the
sewing and embroidery settings or all settings to the
factory settings.

Delete Data

Settings   ► Machine   ► Update and Reset
► Delete Data

With the Delete Data function, you can delete all
personal data stored on the machine.

Save and Transfer Data

Settings   ► Machine   ► Update and Reset
► Save and Transfer Data

With the Save and Transfer Data functions, you can
save your personal data, e.g. settings and your own
stitch and embroidery designs, to a USB stick and
transfer them back to the machine.

14.2 Machine

Maintenance Intervals
To ensure that your machine remains in proper working
order for many years to come, BERNINA recommends
regular maintenance and care of your machine.
The maintenance intervals are heavily dependent on
the following factors:
n Frequency of use of the machine
n Nature of the fabric used
n Number of Stitches
n Nature of the thread used

BERNINA recommends maintaining the machine after
every 3 – 4 full bobbins have been used.

Task Maintenance Interval Measures

Cleaning the Machine Regularly, depending on usage of
the machine.

► Wipe down the surface of the
machine and screen with a soft,
slightly damp microfiber cloth.

Checking the Machine Regularly, depending on usage of
the machine.

1. Check the machine for external
damage.

2. In case of damage, contact your
BERNINA dealer.

Cleaning the Feed Dog and
Stitch Plate

Regularly, depending on usage of
the machine.

► Clean the feed dog. [} see page 99]

Cleaning the Hook Regularly, depending on usage of
the machine.

► Clean the hook. [} see page 99]
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Task Maintenance Interval Measures

Cleaning the Thread Catcher If the relevant message is displayed. ► Clean the thread catcher. [} see
page 101]

Cleaning the Needle
Threader and Thread Clamp

Regularly, depending on usage of
the machine.

► Cleaning the needle threader and
thread clamp [} see page 101]

Replacing the Needle Regularly, depending on usage of
the machine.

► Replace the needle. [} see page 33]

Update Firmware As soon as a new version is
available.

► Updating Firmware. [} see page 97]

Lubricating the Hook n Before using the machine for
the first time.

n After a longer downtime of the
machine.

n Before every new project.
Now and then during a project,
depending on the scope of the
project.

n Regularly, depending on usage
of the machine.

n If the relevant message is
displayed.

n In case of unusual noises in the
bobbin area.

► Lubricate the hook. [} see page 100]

Adjusting, cleaning and lubri-
cating machine components
inside the machine

n For intensive use: Every year
n For normal use: Every two years
n If the relevant message is

displayed.

► Contact your BERNINA dealer.

Maintenance Information

Settings   ► Machine   ► Maintenance

Number of Stitches
The display Number of Stitches shows the number of
stitches that have been sewn with the machine.

Service Prediction / Service Interval
The display Service Prediction / Service Interval
shows how much of the maintenance interval has
elapsed. If the maintenance forecast reaches 100 %, a
corresponding message is displayed when the machine
is started and the machine must be serviced.

Lubrication Prediction / Lubrication Interval
The display Lubrication Prediction / Lubrication
Interval shows how much of the lubrication interval
has elapsed. If the maintenance forecast reaches
100 %, a corresponding message is displayed when the
machine is started and the machine must be lubricated.
[} see page 100]

Number of Thread Cuts / Next Cleaning
The display Number of Thread Cuts / Next Cleaning
shows the number of thread cuts the machine has
made.
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Cleaning the Screen

1. Lock screen and sewing functions.
2. Wipe down the screen with a soft, slightly damp

microfiber cloth.

Cleaning the Feed Dog

Thread residue accumulates under the stitch plate over
time. Remove the thread residue on a regular basis.

1. Raise the needle and presser foot.
2. Lower feed dog.

    CAUTION

Electronically Driven Components
Risk of injury near the needle and the hook.
► Switch off the machine and disconnect it from the

power supply.

3. Remove the needle and presser foot.
4. Remove the stitch plate.

  NOTICE

Dust and thread remnants inside the machine
Damage to mechanical and electronic components.
► Use a brush or a soft cloth.
► Do not use compressed air spray.

5. Clean the feed dog with the brush.

Cleaning the Hook

    CAUTION

Electronically Driven Components
Risk of injury near the needle and the hook.
► Switch off the machine and disconnect it from the

power supply.

1. Open the bobbin cover.
2. Remove the bobbin case.

3. Push the release lever to the left.

4. Fold down the bobbin case holder with the black
bobbin cover.

5. Remove the hook.

  NOTICE

Dust and thread remnants inside the machine
Damage to mechanical and electronic components.
► Use a brush or a soft cloth.
► Do not use compressed air spray.

6. Clean the hook race area with a brush and a soft
cloth. Never use any sharp instruments.

7. Hold the hook at the pin in the center with two
fingers.

8. Guide the hook with the lower edge diagonally
from the top to the bottom behind the bobbin
cover.

9. Position the hook with the two lugs on the hook
driver meeting the corresponding openings in the
hook. The gray marking on the hook driver must be
visible in the hole of the hook.

10. Insert the hook.
ð The shuttle is magnetic and therefore pulled

into the correct position.
11. Close the bobbin cover and the fastening bracket

until the release bracket engages.
12. Turn the handwheel to check.

ð The hook will rotate.
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13. Insert a bobbin case and close the bobbin cover.

Lubricating the Hook

Lubricating the hook keeps the machine running
smoothly and quietly.

    CAUTION

Electronically Driven Components
Risk of injury near the needle and the hook.
► Switch off the machine and disconnect it from the

power supply.

1. Open the bobbin cover.
2. Remove the bobbin case.
3. Push the release lever to the left.

4. Fold down the bobbin case holder with the black
bobbin cover.

5. Remove the hook.

6. Clean the hook race area with a brush and a soft
cloth. Never use any sharp instruments.

7. Add a drop of BERNINA sewing machine oil to the
bottom of the hook race.

8. Add one drop of BERNINA sewing machine oil into
each of the two oil depots so the felt is damp.
Make sure that the surface of the hook sleeve
remains free of oil.

9. Hold the hook at the pin in the center with two
fingers.

10. Guide the hook with the lower edge diagonally
from the top to the bottom behind the bobbin
cover.

11. Position the hook with the two lugs on the hook
driver meeting the corresponding openings in the
hook. The gray marking on the hook driver must be
visible in the hole of the hook.
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12. Insert the hook.
ð The shuttle is magnetic and therefore pulled

into the correct position.
13. Close the bobbin cover and the fastening bracket

until the release bracket engages.
14. Turn the handwheel to check.

ð The hook will rotate.
15. Insert a bobbin case and close the bobbin cover.
16. To absorb excess oil, sew or embroider on a test

fabric.

Cleaning the Thread Catcher

Settings   ► Machine   ► Maintenance
► Cleaning the Thread Catcher

Thread remnants accumulate in the thread catcher over
time. Clean the thread catcher when the corresponding
message is displayed.

1. You can open the Cleaning the Thread Catcher
function in the settings.

2. Clean the thread catcher according to the
instructions on the screen.

Cleaning the Needle Threader and Thread
Clamp

Settings   ► Machine   ► Maintenance
► Cleaning the Needle Threader and Thread Clamp

Lint can accumulate on the needle threader and
prevent proper performance. It is recommended to
clean the threader head regularly.

1. You can open the Cleaning the Needle Threader
and Thread Clamp function in the settings.

2. Clean the thread catcher and the thread clamp
according to the instructions on the screen.

Changing the Battery

1. Switch off the machine and disconnect it from the
power supply.

2. Remove all threads and thread stand.
3. Carefully set down the machine on its back.

4. Open the battery compartment cover on the
bottom of the machine.

5. Remove the battery and dispose of it properly.

    WARNING

Danger of chemical burns if the lithium button cell
battery is swallowed
Swallowing the lithium button cell battery may result in
severe internal chemical burns.
► Make sure that the battery does not fall into the

hands of children and is not swallowed.
► If you suspect that the battery has been swallowed

or has otherwise entered the body, contact a
doctor immediately.

6. Insert a new type CR2032 battery. When doing so,
make sure that the positive pole is facing outward.

7. Close the battery compartment cover.
8. Set up the machine.

Export the Log File

Settings   ► Machine   ► Maintenance ► Export
the Log File

Log files help service personnel to find errors in the
firmware. If you are requested to do so by BERNINA
Service, you can export a log file.

1. Insert the USB stick into the machine.
2. Confirm saving the log file and wait until the

export is complete.
3. Close the window.
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The Automatic Needle Threader does not thread the needle

The needle selected in the needle selection cannot be
automatically threaded, e.g. twin needle.

► Single needle: Select the needle in the needle
selection to match the attached needle. [} see
page 33]

► Double and triple needles: Thread the needle by
hand.

Automatic threading is not possible with the selected
presser foot.

► Attach the appropriate presser foot and select it in
the presser foot selection. [} see page 40]

The automatic needle threader is dirty. ► Clean the needle threader. [} see page 101]

The threader mechanism is not in the correct position. ► Check the position of the threader mechanism.
► If the needle threader is at the front, turn the

needle threader slightly to the left until it is perpen-
dicular to the machine head. If necessary, confirm
the error message. Rethread the needle.

Stitch regulation does not react correctly

Dust or thread residue in front of the BISR sensor. ► Switch off the stitch regulation.
► Open the bobbin cover.
► Clean the sensor at the bobbin cover and the area

under the stitch plate with a brush and soft cloth.

BSR not detected

BSR cable not inserted correctly. ► Insert the BSR connector properly and ensure it is
clicked into place.

Screen not responding

The screen is locked ► Unlock the screen. [} see page 23]

Screen is defective or not connected correctly. ► Contact your BERNINA dealer.

Wrong Touchscreen Pen ► Use the supplied touchscreen pen or finger.

Error during Firmware Update

USB stick is not recognized. ► Use a BERNINA USB stick.

Update process is blocked and the animation on the
screen stops.

► Remove the USB stick.
► Switch off the machine.
► Switch the machine on.
► Follow the instructions on the screen.
► Contact your BERNINA dealer.
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Error during Firmware Update

Firmware update files are not found. ► Unpack the compressed ZIP file according to the
update instructions.

► Store data for the firmware update directly on the
data medium and not in a folder on the USB stick.

Skipped Stitches

Incorrect needle. ► Use the needle system 130/705H.

Needle blunt or bent. ► Replace the needle.

Poor quality needle. ► Use a new BERNINA quality needle.

The needle is incorrectly inserted. ► Insert the needle with the flat side to the back as
far up as it will go into the needle holder and
tighten the screw.

Incorrect needle point. ► Match the needle point to the texture of the
material.

Incorrect needle/thread combination. ► Use a needle with a suitable needle size. [} see
page 31]

Speed too low

Room temperature is too warm or too cold. ► Place the machine in a warm room one hour before
use.

Reduced maximum speed. ► Move the speed control to the right.
► Modify the maximum sewing speed in the Settings.

[} see page 45]
► Modify the maximum embroidery speed in the

Settings. [} see page 47]

Camera image is blurred or contains dirt particles

Camera lens dirty. ► Have the lens cleaned by a BERNINA dealer.

The Laser Dot is not visible or is at the wrong position

The laser is concealed or deflected by the presser foot
or the needle.

► Raise the needle.
► Fit another presser foot.
► Lower the presser foot before starting sewing.
► Contact your BERNINA dealer.

The Light of the button “Start-/Stop” doesn't light up

Light is defective. ► Contact your BERNINA dealer.
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The Machine doesn't start

The machine is not connected to the power supply. ► Insert the mains plug into the socket and into the
machine.

► Check the socket for power.

Room temperature is too warm or too cold. ► Place the machine in a warm room one hour before
use.

► Connect the machine and switch it on.

The machine is damaged. ► Contact your BERNINA dealer.

Needle Breaks

The needle is incorrectly inserted. ► Insert the needle with the flat side to the back as
far up as it will go into the needle holder and
tighten the screw.

Fabric was pulled. ► Feed the fabric evenly.

Thick fabric has been pushed. ► Use a suitable presser foot for thick fabric,
e.g. Jeans Foot #8.

► Use the height compensation tool when sewing
over a thick seam.

Knotted thread. ► Use quality thread.

Sewing Light and/or the Light on the Free Arm do not light up

Sewing light and/or light on the free arm not switched
on.

► Switch on the sewing light and the light on the free
arm in the Settings. [} see page 44]

Sewing light and/or free arm light defective. ► Contact your BERNINA dealer.

Faulty Stitching

Thread remnants between the thread tension discs. ► Fold a piece of thin material and slide the folded
edge (not the raw edges) between the thread
tension discs.

Incorrectly threaded. ► Rethread the upper and lower thread.

Thread remnants below the bobbin case spring. ► Remove the bobbin case.
► Remove the thread remnants under the spring.

Upper Thread Breaks

Incorrect needle/thread combination. ► Match the needle with the thread size.

Upper thread is too tight. ► Reduce the upper thread tension.
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Upper Thread Breaks

Incorrectly threaded. ► Rethread the upper thread.

Poor quality thread. ► Use quality thread.

The stitch plate or the hook tip is damaged. ► Contact your BERNINA dealer to have the damages
repaired.

► Replace the stitch plate.

The thread is caught in the area of the thread take-up
lever.

► Slide the cover at the front of the sewing machine
head to the left and remove the cover.

► Remove the thread remnants.
► Guide the 4 knobs of the cover into the recesses

provided and push the cover to the right until it
clicks into place.

Upper Thread Indicator fails to respond

The upper thread indicator is not switched on. ► Switch on the upper thread indicator in the
Settings. [} see page 44]

The upper thread indicator is defective. ► Contact your BERNINA dealer.

Upper Thread Indicator reacts too frequently

Upper thread not threaded correctly. ► Thread the upper thread correctly. [} see page 34]

Upper thread tension too low. ► Adjust the upper thread tension. [} see page 50]

The upper thread indicator is defective. ► Contact your BERNINA dealer.

Buttonholes are repeatedly not sewn properly

The Buttonhole Foot with Slide #3A is not calibrated
with the machine.

► Calibrate Buttonhole Foot with Slide #3A. [} see
page 47]

Lens on the presser foot is dirty. ► Clean the lens with a soft, slightly damp cloth.

Stitch Plate not detected

Stitch Plate without sensor. ► Attach Stitch Plate with sensor.

Disturbance due to magnetic field. ► Remove magnetic accessories in the area of the
stitch plate.

Sensor on the stitch plate defective. ► Contact your BERNINA dealer.
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Time does not remain set

Battery is empty. ► Change battery. [} see page 101]

Battery protection film has not been removed. ► Removing the Protective Film on the Battery. [} see
page 26]

Uneven Stitch Formation

Upper thread too tight or too loose. ► Adjust the upper thread tension. [} see page 50]
► Check the thread feed from the thread spool.

Needle blunt or bent. ► Replace the needle, make sure that a new BERNINA
quality needle is used. [} see page 33]

Poor quality needle. ► Use a new BERNINA quality needle.

Poor quality thread. ► Use quality thread.

Incorrect needle/thread combination. ► Match the needle with the thread size.

Incorrectly threaded. ► Rethread the upper thread. [} see page 34]
► Rehtread the bobbin thread. [} see page 39]

Fabric was pulled. ► Feed the fabric evenly.

Incorrect bobbin case is used. ► Use supplied bobbin case.

Lower thread too tight or too loose. ► Contact your BERNINA dealer.

Lower Thread Breaks

The bobbin case is damaged. ► Replace the bobbin case.

The stitch hole in the stitch plate is damaged. ► Contact your BERNINA dealer to have the damages
repaired.

► Replace the stitch plate. [} see page 30]

Needle blunt or bent. ► Replace the needle. [} see page 33]

Bobbin Thread Indicator doesn't react

The bobbin door cover is opened. ► Close the bobbin cover.

The bobbin thread indicator is not switched on. ► Switch on the bobbin thread indicator in the
Settings. [} see page 44]

The bobbin thread indicator is defective. ► Contact your BERNINA dealer.
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USB stick is not detected

USB stick is incompatible. ► Use a BERNINA USB stick or compatible USB stick.

USB stick not with correct file system. ► Use a USB stick with the FAT32 file system.
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16.1 Storing the Machine
BERNINA recommends that you store the machine in its
original packaging. If the machine is stored in a cold
room, place the machine in a warm room for one hour
before use.

1. Switch off the machine and disconnect it from the
power supply.

2. Clean the machine.
3. Don't store the machine outdoors.
4. Protect the machine against climatic influences.

16.2 Dispose of the Machine

1. Delete personal data on the machine. [} see
page 97]

2. Sort components by material and dispose of in
accordance with local laws and regulations.
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Designation Value Unit

Maximum Speed 1200 Stitches per Minute

Needle System 130/705

Measurements without the Spool Pin (W × H × D) 675 × 420 × 245
(26.6 × 16.5 × 9.7)

mm
(in)

Measurements incl. Embroidery Module without
Spool Pin (W × H × D)

1175 × 420 × 635
46.3 × 16.5 × 25.0

mm
(in)

Weight of the Machine 19.2
(42.3)

kg
(lb)

Weight of the Embroidery Module 6.7
14.8

kg
(lb)

Energy Consumption 160 W

Input Voltage 100 – 240
50/60

V
Hz

WiFi Frequency Band
WiFi Protocol

2.4
802.11 b/g/n

GHz

Power Output (802.11 b)
Power Output (802.11 g)
Power Output (802.11 n)

17.5
14.0
12.5

dBm
dBm
dBm

Laser Class
(according to IEC 60825-1:2014)

Protection Class (Electrical Engineering) II
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18.1 Practical Stitches

1 2 3 4 5 6 7 8 9 10 11 12 13 14

15 16 17 18 19 20 21 22 23 24 25 26 27 29

31 32 33 34 35 36 37 38 39 40 41 42

18.2 Decorative Stitches

Nature

101 102 103 104 105 106 107 108 109 110 111 112 113 114

115 116 117 118 119 120 122 123 124 125 126 127 128 129

130 131 132 133 134 135 136 137 138 139 140 141 142 143

144 145 146 147 148 149 150 152 153 154 155 156 158 159

160 161 162 163 164 165 166 167 168 169 170 171 172 173

174 175 176 177 178 179 180 181 182 183 184 185 186 187

188
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Nature Sideways Motion

201 202 203 204 205 206 207 208 209 210 211 212 213 214

215 216 217 218 219 220 221 222 223 224 225 228 229 230

231 232 233 234 235 236 237 238 239 240 241 242 243 244

245 246 247 248 249 250 251 252 253 254 255 256 257 258

259 260 261 262 263 264 265 266 267 268 269 270 271

Cross Stitches

301 302 303 304 305 306 307 308 309 311 312 313 314 316

318 319 320 321 322 323 324 325 326 327 328 329 330 331

332 333 334 335 336 337 338 339 343 344 371 372 373 374

375 376 377 378 379

Satin

401 402 405 406 407 408 409 410 412 413 414 415 416 417

418 419 421 422 423 424 425 426 427 428 429 430 431 433
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434 436 437 440 442 443 444 445 447 448 449 450 451 452

453 454 455 456 457 458 461 464 465 466 467 468 469 471

472 473

Satin Sideways Motion

501 503 505 506 507 508 509 510 511 512 513 514 517 518

519 520 523 524 525

Geometric

601 602 603 604 605 606 607 608 609 610 611 612 613 614

615 616 618 619 620 621 622 623 624 625 626 627 628 629

630 631 632 633 634 635 636 637 639 640 641 642 643 644

645 646 647 648 649 650 651 652 653 654 655 656 657 658

660 661 662 663 664 665 666 674 675 676 677 678 679 680

682 683 684 685 686 691 693 694 697 698 699
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Heirloom

701 702 703 704 705 706 707 708 709 710 711 712 713 714

715 716 717 721 722 723 724 725 726 727 729 730 731 732

733 734 735 736 737 738 739 740 741 742 743 744 745 746

747 748 749 750 751 752 756 757 758 759 761 762 763 764

765 766 767 768 769 770 771 772 773 774 775 776 777 778

779 780 781 782 783

Heirloom Sideways Motion

801 802 803 804 805 806 807 808 809 810 811 812 813 814

815 816 817 818 819 820 831 832 833 834 835 840 841

Children

901 902 903 904 905 906 907 908 909 910 911 912 913 914

915 916 917 918 919 920 921 922 923 924 926 928 929 932

933 934 935 936 938 939 940 942 944 945 946 948 949 950
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952 954 955 957 958 959 960 961 962 963 964 965

Children Sideways Motion

1001 1002 1003 1004 1005 1006 1007 1008 1009 1010 1011 1012 1013 1014

1015 1016 1017 1018 1019 1020 1021 1022 1023 1024 1025 1026 1027 1028

Special

1101 1102 1103 1104 1105 1106 1107 1108 1109 1110 1113 1114 1115 1116

1117 1118 1119 1120 1121 1122 1123

Filigree Sideways Motion

1201 1202 1203 1204 1205 1206 1207 1208 1209 1210 1211 1212 1213 1214

1215 1216 1217 1218 1220 1221 1222 1223 1224 1225 1226 1227 1228

Tapering

1401 1402 1403 1404 1405 1406 1407 1408 1409 1410 1411 1412 1413 1414

1415 1416 1417 1418 1419 1420 1422 1423 1424 1425 1427 1428 1429 1430
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1431 1437 1438 1440 1446 1447 1448 1449 1450 1454 1455 1459 1460 1461

1462

Banner

1501 1502 1503 1504 1505 1506 1507 1508 1509 1510 1511 1512 1513 1514

1515 1516 1517 1518 1519 1520 1521 1522 1524 1525 1526 1527 1528 1529

1530 1531 1532 1533 1534 1535 1536 1538 1539

Quilting Stitches Sideways Motion

1601 1602 1603 1604 1605 1606 1607 1608 1609 1610 1611 1612 1613 1614

1615 1616 1617 1618 1619 1620 1621 1622 1623 1625 1629 1630 1631 1632

1633 1634 1635 1636 1643 1644 1645 1646 1647 1648 1649 1650 1651 1652

1653 1654 1657 1658 1659 1660

International

1701 1702 1703 1704 1705 1706 1707 1708 1709 1710 1711 1715 1716 1717
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1718 1719 1720 1721 1722 1723 1729 1730 1731 1732 1733 1734 1735 1736

1737 1738 1739

Geometric Sideways Motion

1901 1902 1903 1904 1905 1906 1907 1908 1909 1910 1911 1912 1915 1916

1917 1918 1919 1920 1921 1922 1923 1924 1925 1929 1930 1931 1932 1933

1934 1935 1936 1937 1938 1939

Seasons

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014

2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 2026 2027 2028

Sport and Hobbies

2201 2202 2203 2204 2205 2206 2207 2208 2209 2210 2211 2212 2213 2215

2216 2217 2218 2219 2220 2221 2222 2223 2224 2225 2226 2227 2230 2231

2232 2233 2234 2235
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Constellations

2501 2502 2503 2504 2505 2506 2507 2508 2509 2510 2511 2512

Emojis

2601 2602 2603 2604 2605 2606 2607 2608 2609 2610 2611 2612 2613 2614

2615 2616 2617

Emojis Sideways Motion

2701 2702 2703 2704 2705 2706 2707 2708

18.3 Buttonholes

51 52 53 54 55 56 57 58 59 60 61 62 63 64

65 66 67 68 69 70

18.4 Quilting Stitches

1301 1302 1303 1304 1305 1306 1307 1308 1309 1310 1311 1312 1313 1314

1315 1316 1317 1318 1319 1320 1321 1322 1323 1324 1325 1326 1327 1329

1330 1331 1332 1333 1334 1335 1336 1337 1338 1339 1340 1341 1342 1343
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1344 1345 1346 1363 1364 1365 1366 1367 1368 1369 1370 1371 1372 1373

1374 1375 1376 1377 1378 1379 1380 1381 1382 1383 1384 1385 1386 1387

1388 1389 1390 1391 1393 1394
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Let your creativity run free. A large selection of
embroidery designs is included with your
machine.

After registering your machine, the included
embroidery designs are available as downloads in an
editable format at the BERNINA Customer Portal.
If you see one of the following pictograms below a
number of the embroidery design, you can find
additional information at 
https://www.bernina.com/specialeffects.

Freestanding
Lace

PunchWork

Basic CutWork Couching

Fringe
Embroidery

Projects in the
Hoop

Appliqué Puffy Fonts

CutWork Quilting

PaintWork Trapunto

CrystalWork

19.1 Inspirations
You can find the detailed embroidery instructions at
bernina.com/990-designs.

Quilt

Q101  

1.      Isacord 40   0020

Q102  

1.      Isacord 40   0020

Q103  

1.      Isacord 40   0020

Q104  

1.      Isacord 40   0020

Q105  

1.      Isacord 40   0020

Q106  

1.      Isacord 40   0020

https://www.bernina.com/specialeffects
https://www.bernina.com/990-designs
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Q107  

1.      Isacord 40   0020

Q108  

1.      Isacord 40   0020

Q109  

1.      Isacord 40   0020

Q110  

1.      Isacord 40   0020

Q111  

1.      Isacord 40   0020

Q112  

1.      Isacord 40   0020

Q113  

1.      Isacord 40   0020

Q114  

1.      Isacord 40   0020

Q115  

1.      Isacord 40   0020

Q116  

1.      Isacord 40   0020
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Q117  

1.      Isacord 40   0020

Q118  

1.      Isacord 40   0020

Q119  

1.      Isacord 40   0020

Q120  

1.      Isacord 40   0020

Q121  

1.      Isacord 40   0020

Q122  

1.      Isacord 40   0020

Q123  

1.      Isacord 40   0020

Q124  

1.      Isacord 40   0020

Q125  

1.      Isacord 40   0020

Q126  

1.      Isacord 40   0020
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Q127  

1.      Isacord 40   0020

Q128  

1.      Isacord 40   0020

Q129  

1.      Isacord 40   0020

Q130  

1.      Isacord 40   0020

Q131  

1.      Isacord 40   0020

Q132  

1.      Isacord 40   0020

Q133  

1.      Isacord 40   0020

Q134  

1.      Isacord 40   0020

Q135  

1.      Isacord 40   0020

Q136  

1.      Isacord 40   0020
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Q137  

1.      Isacord 40   0020

Petal LG 305 x 305 mm
12 x 12 inch

5.139

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Isacord 40   3210

Petal SM 165 x 165 mm
6.5 x 6.5 inch

2.877

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Isacord 40   3210

Circle LG 305 x 305 mm
12 x 12 inch

3.296

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Isacord 40   3210

Circle SM 165 x 165 mm
6.5 x 6.5 inch

2.271

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Isacord 40   3210

Four Circles 305 x 305 mm
12 x 12 inch

6.604

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Applique   2

6.      Applique   3

7.      Applique   2

8.      Applique   3

9.      Applique   2

10.      Applique   3 11.      Isacord 40   3210

Half Circle 165 x 318 mm
6.5 x 12.5 inch

5.970

1.      Isacord 40   3210

2.      Applique   1

3.      Applique   2

4.      Applique   3

5.      Isacord 40   3210

CutWork Petal LG 280 x 280 mm
11 x 11 inch

3.550

1.      Isacord 40   3210

2.      Cut   0001

3.      Cut   0003

4.      Cut   0004

CutWork Petal SM 153 x 153 mm
6 x 6 inch

1.930

1.      Isacord 40   3210

2.      Cut   0001

3.      Cut   0003

4.      Cut   0004

CutWork Circle LG 280 x 280 mm
11 x 11 inch

3.488

1.      Isacord 40   3210

2.      Cut   0001

3.      Cut   0002

4.      Cut   0003

5.      Cut   0004
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CutWork Circle
SM

152 x 152 mm
6 x 6 inch

1.844

1.      Isacord 40   3210

2.      Cut   0001

3.      Cut   0002

4.      Cut   0003

5.      Cut   0004

CutWork Half
Circle

149 x 302 mm
5.9 x 11.9 inch

2.697

1.      Isacord 40   3210

2.      Cut   0001

3.      Cut   0002

4.      Cut   0003

5.      Cut   0004

Dress

D101 185 x 176 mm
7.3 x 6.9 inch

20.050

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D102 118 x 101 mm
4.7 x 4 inch

7.440

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D103 73 x 77 mm
2.9 x 3 inch

2.451

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D104 55 x 48 mm
2.1 x 1.9 inch

1.839

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D105 54 x 42 mm
2.1 x 1.7 inch

1.776

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D106 117 x 123 mm
4.6 x 4.8 inch

9.074

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D107 151 x 129 mm
5.9 x 5.1 inch

9.175

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D108 149 x 149 mm
5.9 x 5.9 inch

11.186

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101
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D109 110 x 117 mm
4.3 x 4.6 inch

5.557

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D110 207 x 200 mm
8.1 x 7.9 inch

29.950

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D111 120 x 118 mm
4.7 x 4.7 inch

6.664

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D112 100 x 80 mm
3.9 x 3.2 inch

5.531

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D113 168 x 137 mm
6.6 x 5.4 inch

9.922

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   0101

D114 187 x 178 mm
7.4 x 7 inch

15.018

1.      Isacord 40   1720

2.      Isacord 40   1720

3.      Isacord 40   0672

4.      Isacord 40   0101

D115 115 x 70 mm
4.5 x 2.8 inch

5.784

1.      Applique   1

2.      Applique   3

3.      Isacord 40   0672

4.      Isacord 40   0101

5.      Isacord 40   2900

6.      Isacord 40   0101

D116 119 x 139 mm
4.7 x 5.5 inch

22.320

1.      Applique   1

2.      Applique   3

3.      Isacord 40   0672

4.      Isacord 40   0101

D117 72 x 115 mm
2.8 x 4.5 inch

4.221

1.      Applique   1

2.      Applique   3

3.      Isacord 40   6031

4.      Isacord 40   0630

5.      Isacord 40   0672

6.      Isacord 40   0101

D118 70 x 139 mm
2.8 x 5.5 inch

2.782

1.      Isacord 40   6043
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D119 59 x 129 mm
2.3 x 5.1 inch

2.268

1.      Isacord 40   6043

D120 64 x 147 mm
2.5 x 5.8 inch

2.746

1.      Isacord 40   6043

D121 104 x 79 mm
4.1 x 3.1 inch

3.294

1.      Isacord 40   0442

2.      Isacord 40   0345

D122 105 x 107 mm
4.1 x 4.2 inch

5.672

1.      Isacord 40   0352

2.      Isacord 40   6133

D123 65 x 126 mm
2.6 x 5 inch

2.348

1.      Isacord 40   5912

2.      Isacord 40   5722

3.      Isacord 40   5633

D124 74 x 110 mm
2.9 x 4.4 inch

2.210

1.      Isacord 40   5912

2.      Isacord 40   5633

D125 104 x 109 mm
4.1 x 4.3 inch

3.416

1.      Isacord 40   5912

2.      Isacord 40   5633

D126 71 x 62 mm
2.8 x 2.4 inch

1.273

1.      Isacord 40   5912

2.      Isacord 40   5633
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D127 301 x 374 mm
11.9 x 14.7 inch

46.715

1.      Isacord 40   3962

2.      Isacord 40   3644

3.      Isacord 40   0134

4.      Isacord 40   5233

5.      Isacord 40   5233

6.      Isacord 40   3644

7.      Isacord 40   3644

8.      Isacord 40   3644

9.      Isacord 40   3644

10.      Isacord 40   0504 11.      Isacord 40   0504 12.      Isacord 40   0504

13.      Isacord 40   0504 14.      Isacord 40   3713 15.      Isacord 40   3713

16.      Isacord 40   3713 17.      Isacord 40   3713 18.      Isacord 40   2711

19.      Isacord 40   2711 20.      Isacord 40   2711 21.      Isacord 40   2711

D128 305 x 404 mm
12 x 15.9 inch

74.181

1.      Isacord 40   0132

2.      Isacord 40   5233

3.      Isacord 40   5233

4.      Isacord 40   0170

5.      Isacord 40   0170

6.      Isacord 40   0170

7.      Isacord 40   0170

8.      Isacord 40   3644

9.      Isacord 40   3644

10.      Isacord 40   3644 11.      Isacord 40   3644 12.      Isacord 40   0134

13.      Isacord 40   0134 14.      Isacord 40   0134 15.      Isacord 40   0134

16.      Isacord 40   2900 17.      Isacord 40   2900 18.      Isacord 40   2900

19.      Isacord 40   2900 20.      Isacord 40   5934 21.      Isacord 40   5934

22.      Isacord 40   5934 23.      Isacord 40   5934 24.      Isacord 40   2711

25.      Isacord 40   2711 26.      Isacord 40   2711 27.      Isacord 40   2711

28.      Isacord 40   1720 29.      Isacord 40   1720 30.      Isacord 40   1720

31.      Isacord 40   1720

Organizer

O101 264 x 305 mm
10.4 x 12 inch

80.817

1.      Isacord 40   3631

O102 396 x 82 mm
15.6 x 3.2 inch

33.812

1.      Isacord 40   3631

O103 150 x 147 mm
5.9 x 5.8 inch

20.709

1.      Isacord 40   3631

Chair

C101 300 x 370 mm
11.8 x 14.6 inch

72.017

1.      Isacord 40   0015
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19.2 Quilting

80202-01  

1.      Isacord 40   0020

80202-02  

1.      Isacord 40   0020

80202-03  

1.      Isacord 40   0020

80202-04  

1.      Isacord 40   0020

80202-05  

1.      Isacord 40   0020

80202-05s  

1.      Isacord 40   0020

80202-06  

1.      Isacord 40   0020

80257-01  

1.      Isacord 40   0020

80257-02  

1.      Isacord 40   0020

80257-03  

1.      Isacord 40   0020



Appendix

19 Embroidery Designs 129

80257-04  

1.      Isacord 40   0020

80257-05  

1.      Isacord 40   0020

80257-05s  

1.      Isacord 40   0020

80257-06  

1.      Isacord 40   0020

80258-02  

1.      Isacord 40   0020

80258-03  

1.      Isacord 40   0020

80258-04  

1.      Isacord 40   0020

80258-05  

1.      Isacord 40   0020

80258-06  

1.      Isacord 40   0020

80259-01  

1.      Isacord 40   0020
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80259-02  

1.      Isacord 40   0020

80259-03  

1.      Isacord 40   0020

80259-04  

1.      Isacord 40   0020

80259-05  

1.      Isacord 40   0020

80259-06  

1.      Isacord 40   0020

80260-02  

1.      Isacord 40   0020

80260-03  

1.      Isacord 40   0020

80260-06  

1.      Isacord 40   0020

80210-07s  

1.      Isacord 40   0020

80210-03  

1.      Isacord 40   0020
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80210-05  

1.      Isacord 40   0020

80210-06  

1.      Isacord 40   0020

80210-08  

1.      Isacord 40   0020

80210-09  

1.      Isacord 40   0020

32196-01  

1.      Isacord 40   0020

32196-02  

1.      Isacord 40   0020

32196-03  

1.      Isacord 40   0020

32196-04  

1.      Isacord 40   0020

32196-05  

1.      Isacord 40   0020

32196-06  

1.      Isacord 40   0020
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32196-07  

1.      Isacord 40   0020

32196-08  

1.      Isacord 40   0020

32196-09  

1.      Isacord 40   0020

32196-10  

1.      Isacord 40   0020

32196-11  

1.      Isacord 40   0020

32196-12  

1.      Isacord 40   0020

32196-13  

1.      Isacord 40   0020

32196-14  

1.      Isacord 40   0020

32196-15  

1.      Isacord 40   0020

32196-16  

1.      Isacord 40   0020
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32196-17  

1.      Isacord 40   0020

32196-18  

1.      Isacord 40   0020

32196-19  

1.      Isacord 40   0020

32196-19-1  

1.      Isacord 40   0020

32196-20  

1.      Isacord 40   0020

32196-21  

1.      Isacord 40   0020

32196-22  

1.      Isacord 40   0020

32196-23  

1.      Isacord 40   0020

32196-24  

1.      Isacord 40   0020

32196-25  

1.      Isacord 40   0020
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32196-26  

1.      Isacord 40   0020

32196-27  

1.      Isacord 40   0020

32196-28  

1.      Isacord 40   0020

32196-29  

1.      Isacord 40   0020

32196-30  

1.      Isacord 40   0020

80210-01  

1.      Isacord 40   0020

80210-04  

1.      Isacord 40   0020

80210-07  

1.      Isacord 40   0020

Basics_02s  

1.      Isacord 40   0020

Basics_05s  

1.      Isacord 40   0020
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Basics_01  

1.      Isacord 40   0020

Basics_02  

1.      Isacord 40   0020

Basics_03  

1.      Isacord 40   0020

Basics_04  

1.      Isacord 40   0020

Basics_04_corner  

1.      Isacord 40   0020

Basics_05  

1.      Isacord 40   0020

12416-15q  

1.      Isacord 40   0020

12416-36q  

1.      Isacord 40   0020

12416-38q  

1.      Isacord 40   0020

12591-14_1  

1.      Isacord 40   0020
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12591-14_2  

1.      Isacord 40   0020

12607-28q  

1.      Isacord 40   0020

12607-33q  

1.      Isacord 40   0020

12756-01q  

1.      Isacord 40   0020

12756-02q  

1.      Isacord 40   0020

12756-03q  

1.      Isacord 40   0020

12756-11q  

1.      Isacord 40   0020

12756-18q  

1.      Isacord 40   0020

12756-19q  

1.      Isacord 40   0020

12756-22q  

1.      Isacord 40   0020
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80185-01q  

1.      Isacord 40   0020

80185-03q  

1.      Isacord 40   0020

80185-07q  

1.      Isacord 40   0020

12380-04q  

1.      Isacord 40   0020

12380-08q  

1.      Isacord 40   0020

12380-09q  

1.      Isacord 40   0020

BD285q  

1.      Isacord 40   0020

BD288q  

1.      Isacord 40   0020

BD289q  

1.      Isacord 40   0020

BD292q  

1.      Isacord 40   0020
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BD299q  

1.      Isacord 40   0020

BD308q  

1.      Isacord 40   0020

Quilt project_1  

1.      Isacord 40   0020

Quilt project_2  

1.      Isacord 40   0020

BD394  

1.      Isacord 40   0020

BD412  

1.      Isacord 40   0020

BD413  

1.      Isacord 40   0020

BD513  

1.      Isacord 40   0020

BD514  

1.      Isacord 40   0020

BD553  

1.      Isacord 40   0020
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BD554  

1.      Isacord 40   0020

BD567  

1.      Isacord 40   0020

BD659  

1.      Isacord 40   0020

BD665  

1.      Isacord 40   0020

BD800  

1.      Isacord 40   0020

BD801  

1.      Isacord 40   0020

BD804  

1.      Isacord 40   0020

BD837  

1.      Isacord 40   0020

HE959  

1.      Isacord 40   0020

LoopedFlowers_
Border1

 

1.      Isacord 40   0020
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LoopedFlowers_
Panto2

 

1.      Isacord 40   0020

Panto_Candle  

1.      Isacord 40   0020

PebblesShell_
Square

 

1.      Isacord 40   0020

PebblesShells_
Border

 

1.      Isacord 40   0020

PebblesShells_
Corner

 

1.      Isacord 40   0020

PebblesShells_
Panto

 

1.      Isacord 40   0020

PebblesShells_
Segment

 

1.      Isacord 40   0020

PebblesShells_
Segment1

 

1.      Isacord 40   0020

PebblesShells_
Triangle

 

1.      Isacord 40   0020

SwirlsPaisley_
Border

 

1.      Isacord 40   0020
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SwirlsPaisley_
Corner

 

1.      Isacord 40   0020

SwirlsPaisley_
Panto

 

1.      Isacord 40   0020

SwirlsPaisley_
Segment

 

1.      Isacord 40   0020

SwirlsPaisley_
Segment1

 

1.      Isacord 40   0020

SwirlsPaisley_
Square1

 

1.      Isacord 40   0020

SwirlsPaisley_
Square2

 

1.      Isacord 40   0020

Villette  

1.      Isacord 40   0020

Villette2  

1.      Isacord 40   0020

VinesBerries_
Block

 

1.      Isacord 40   0020

VinesBerries_
Border

 

1.      Isacord 40   0020
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VinesBerries_
Border2

 

1.      Isacord 40   0020

VinesBerries_
Corner

 

1.      Isacord 40   0020

VinesBerries_
Panto

 

1.      Isacord 40   0020

VinesBerries_
triangle

 

1.      Isacord 40   0020

VinesBerries_
Wreath

 

1.      Isacord 40   0020

Template

QS101  

1.      Isacord 40   0020

QS102  

1.      Isacord 40   0020

QS103  

1.      Isacord 40   0020

QS104  

1.      Isacord 40   0020
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QS105  

1.      Isacord 40   0020

QS106  

1.      Isacord 40   0020

QS107  

1.      Isacord 40   0020

QS108  

1.      Isacord 40   0020

QS109  

1.      Isacord 40   0020

QS110  

1.      Isacord 40   0020

QS111  

1.      Isacord 40   0020

QS112  

1.      Isacord 40   0020

QS113  

1.      Isacord 40   0020
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19.3 Accents

12436-29 100 x 37 mm
3.9 x 1.4 inch

2.464

1.      YLI variations   8016

2.      YLI variations   8015

3.      Yenmet   7030

12440-19 172 x 50 mm
6.8 x 2 inch

3.005

1.      Isacord 40   1543

2.      Isacord 40   1521

3.      Isacord 40   2761

4.      Isacord 40   1543

12445-11 124 x 124 mm
4.9 x 4.9 inch

11.385

1.      Isacord 40   2520

2.      Isacord 40   2550

3.      Isacord 40   2504

4.      Isacord 40   2520

5.      Isacord 40   2715

12445-13 127 x 120 mm
5 x 4.7 inch

16.595

1.      Isacord 40   2520

2.      Isacord 40   2550

3.      Isacord 40   2504

4.      Isacord 40   2520

5.      Isacord 40   2715

12508-12 44 x 34 mm
1.8 x 1.3 inch

1.789

1.      Isacord 40   4752

2.      Isacord 40   0352

3.      Isacord 40   5552

12508-21 46 x 60 mm
1.8 x 2.4 inch

2.629

1.      Isacord 40   6133

2.      Isacord 40   4752

3.      Isacord 40   5552

12508-30 46 x 58 mm
1.8 x 2.3 inch

1.662

1.      Isacord 40   0124

2.      Isacord 40   0352

3.      Isacord 40   6133

12523-04 110 x 139 mm
4.3 x 5.5 inch

13.768

1.      Isacord 40   0310

2.      Isacord 40   0310

3.      Isacord 40   1701

4.      Isacord 40   1701

5.      Isacord 40   0311

6.      Isacord 40   1102

7.      Isacord 40   2508

8.      Isacord 40   1701

9.      Isacord 40   2530

10.      Isacord 40   0101 11.      Isacord 40   0310 12.      Isacord 40   1701

13.      Isacord 40   4174
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12523-05 30 x 75 mm
1.2 x 3 inch

3.717

1.      Isacord 40   0151

2.      Isacord 40   0151

3.      Isacord 40   0151

4.      Isacord 40   4111

5.      Isacord 40   2504

6.      Isacord 40   4174

7.      Isacord 40   0101

8.      Isacord 40   4073

12523-06 121 x 105 mm
4.8 x 4.1 inch

17.120

1.      Isacord 40   0015

2.      Isacord 40   0015

3.      Isacord 40   0151

4.      Isacord 40   0311

5.      Isacord 40   3652

6.      Isacord 40   1701

7.      Isacord 40   5822

8.      Isacord 40   3040

9.      Isacord 40   4103

10.      Isacord 40   2530 11.      Isacord 40   2640 12.      Isacord 40   5633

13.      Isacord 40   2504 14.      Isacord 40   1902 15.      Isacord 40   1301

16.      Isacord 40   4174 17.      Isacord 40   4410 18.      Isacord 40   5944

19.      Isacord 40   0101 20.      Isacord 40   4073 21.      Isacord 40   1902

22.      Isacord 40   4111 23.      Isacord 40   5944 24.      Isacord 40   2905

12523-16 173 x 172 mm
6.8 x 6.8 inch

40.607

1.      Isacord 40   1701

2.      Isacord 40   1102

3.      Isacord 40   0101

4.      Isacord 40   3652

5.      Isacord 40   3040

6.      Isacord 40   2530

7.      Isacord 40   1701

8.      Isacord 40   5822

9.      Isacord 40   4111

10.      Isacord 40   4103 11.      Isacord 40   2905 12.      Isacord 40   1902

13.      Isacord 40   1301 14.      Isacord 40   0311 15.      Isacord 40   1102

16.      Isacord 40   4410 17.      Isacord 40   5633 18.      Isacord 40   5944

19.      Isacord 40   1344 20.      Isacord 40   0101 21.      Isacord 40   4103

22.      Isacord 40   2530 23.      Isacord 40   1102 24.      Isacord 40   5633

25.      Isacord 40   1902 26.      Isacord 40   2905

12620-14 87 x 120 mm
3.4 x 4.7 inch

12.023

1.      Isacord 40   2520

12633-09 120 x 120 mm
4.7 x 4.7 inch

16.361

1.      Isacord 40   0015

12773-32 64 x 83 mm
2.5 x 3.3 inch

12.896

1.      Isacord 40   4174

2.      Isacord 40   0015

3.      Isacord 40   0600

4.      Isacord 40   1725

5.      Isacord 40   0020

12879-07L 155 x 151 mm
6.1 x 5.9 inch

5.437

1.      Isacord 40   5740

2.      Isacord 40   5440

3.      Isacord 40   5210

12919-02 73 x 152 mm
2.9 x 6 inch

6.442

1.      Isacord 40   2560

2.      Isacord 40   2732

3.      Isacord 40   1220

4.      Isacord 40   0934

5.      Isacord 40   1055

6.      Isacord 40   3962

7.      Isacord 40   3820
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21021-10 117 x 148 mm
4.6 x 5.8 inch

14.469

1.      Isacord 40   1252

2.      Isacord 40   1161

3.      Isacord 40   1565

21021-14 122 x 122 mm
4.8 x 4.8 inch

18.063

1.      Isacord 40   1252

2.      Isacord 40   1161

3.      Isacord 40   1565

51204-15 28 x 172 mm
1.1 x 6.8 inch

5.304

1.      Isacord 40   5510

2.      Isacord 40   0703

3.      Isacord 40   3713

4.      Isacord 40   1102

5.      Isacord 40   3210

6.      Isacord 40   1805

7.      Isacord 40   2723

51204-22 23 x 27 mm
0.9 x 1.1 inch

971

1.      Isacord 40   2723

51278-01 116 x 147 mm
4.6 x 5.8 inch

14.604

1.      Isacord 40   1260

2.      Isacord 40   0731

51278-09 110 x 128 mm
4.3 x 5 inch

7.310

1.      Isacord 40   1260

2.      Isacord 40   0731

51278-10 89 x 228 mm
3.5 x 9 inch

6.998

1.      Isacord 40   0731

2.      Isacord 40   1260

82001-04 97 x 103 mm
3.8 x 4.1 inch

7.650

1.      Isacord 40   0933

2.      Isacord 40   1252

82001-08 76 x 78 mm
3 x 3.1 inch

4.252

1.      Isacord 40   1252

2.      Isacord 40   0933

3.      Isacord 40   1252

82001-12 60 x 95 mm
2.4 x 3.8 inch

3.514

1.      Isacord 40   0933

2.      Isacord 40   1252
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82001-20 52 x 60 mm
2 x 2.4 inch

3.448

1.      Isacord 40   0933

82001-40 242 x 242 mm
9.5 x 9.5 inch

22.712

1.      Isacord 40   1252

82005-15 186 x 249 mm
7.3 x 9.8 inch

38.983

1.      Isacord 40   1032

2.      Isacord 40   0870

3.      Isacord 40   0851

4.      Isacord 40   1346

5.      Isacord 40   1346

6.      Isacord 40   1346

7.      Isacord 40   2650

8.      Isacord 40   0851

9.      Isacord 40   1753

10.      Isacord 40   0870 11.      Isacord 40   0851 12.      Isacord 40   1346

82005-22 138 x 145 mm
5.4 x 5.7 inch

12.325

1.      Isacord 40   1032

2.      Isacord 40   0870

82015-23 54 x 54 mm
2.1 x 2.1 inch

2.980

1.      Isacord 40   2152

2.      Isacord 40   0874

3.      Isacord 40   0532

4.      Isacord 40   0453

Bd361 108 x 46 mm
4.2 x 1.8 inch

2.197

1.      Isacord 40   0504

2.      Isacord 40   2152

3.      Isacord 40   2920

4.      Isacord 40   3815

5.      Isacord 40   5610

6.      Isacord 40   1010

Fs327_48 125 x 123 mm
4.9 x 4.8 inch

10.514

1.      Isacord 40   0862

Pk10005-01 114 x 99 mm
4.5 x 3.9 inch

4.626

1.      Isacord 40   3810

2.      Isacord 40   3920

3.      Isacord 40   5115

4.      Isacord 40   5510

5.      Isacord 40   0713

6.      Isacord 40   1200

7.      Isacord 40   2520

8.      Isacord 40   2723

Pk10005-02 108 x 97 mm
4.2 x 3.8 inch

3.561

1.      Isacord 40   1200

2.      Isacord 40   0713

3.      Isacord 40   5510

4.      Isacord 40   3920

5.      Isacord 40   2723

6.      Isacord 40   1906

51220-01 102 x 161 mm
4 x 6.4 inch

24.353

1.      Isacord 40   0020

2.      Isacord 40   0630

3.      Isacord 40   1332

4.      Isacord 40   0660

5.      Isacord 40   2521

6.      Isacord 40   2333

7.      Isacord 40   1362

8.      Isacord 40   1334

9.      Isacord 40   0020
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51222-15 104 x 99 mm
4.1 x 3.9 inch

8.078

1.      Isacord 40   0721

2.      Yenmet   7012

3.      Isacord 40   1260

51222-16 82 x 82 mm
3.2 x 3.2 inch

4.507

1.      Isacord 40   1260

2.      Isacord 40   0721

3.      Yenmet   7012

51232-14 108 x 75 mm
4.3 x 3 inch

18.932

1.      Isacord 40   5230

2.      Isacord 40   2520

3.      Isacord 40   0608

4.      Isacord 40   1114

5.      Isacord 40   1900

6.      Isacord 40   0020

7.      Isacord 40   0010

51232-15 90 x 134 mm
3.5 x 5.3 inch

22.628

1.      Isacord 40   5230

2.      Isacord 40   0010

3.      Isacord 40   1900

4.      Isacord 40   0608

5.      Isacord 40   1114

6.      Isacord 40   0020

51251-15l 174 x 174 mm
6.8 x 6.9 inch

4.069

1.      Isacord 40   4620

2.      Isacord 40   2508

3.      Isacord 40   0506

4.      Isacord 40   6011

51283-01l 75 x 150 mm
2.9 x 5.9 inch

4.367

1.      Isacord 40   0020

51283-07l 110 x 106 mm
4.3 x 4.2 inch

2.324

1.      Isacord 40   0020

51283-08l 72 x 144 mm
2.8 x 5.6 inch

2.894

1.      Isacord 40   0020

82026-11 126 x 211 mm
4.9 x 8.3 inch

10.279

1.      Isacord 40   1161

2.      Isacord 40   5743

3.      Isacord 40   0020

4.      Isacord 40   0721

5.      Yenmet   7012

82026-13 54 x 240 mm
2.1 x 9.5 inch

15.033

1.      Isacord 40   1161

2.      Isacord 40   5743

3.      Isacord 40   5822

4.      Isacord 40   0020

5.      Isacord 40   3762

6.      Isacord 40   3953

7.      Isacord 40   3732

8.      Yenmet   7012

9.      Isacord 40   0721

10.      Yenmet   7012
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82026-16 132 x 138 mm
5.2 x 5.4 inch

17.746

1.      Isacord 40   0721

2.      Yenmet   7012

3.      Isacord 40   1161

4.      Isacord 40   5743

5.      Isacord 40   3762

6.      Isacord 40   3953

7.      Isacord 40   3732

8.      Yenmet   7012

9.      Isacord 40   0660

10.      Isacord 40   1060 11.      Yenmet   7012 12.      Isacord 40   1761

13.      Yenmet   7012 14.      Isacord 40   5822 15.      Isacord 40   0020

82026-31 96 x 108 mm
3.8 x 4.2 inch

5.023

1.      Isacord 40   0721

2.      Yenmet   7012

82026-32 78 x 78 mm
3.1 x 3.1 inch

6.436

1.      Isacord 40   0721

2.      Yenmet   7012

Nb830_48 76 x 156 mm
3 x 6.1 inch

9.123

1.      Isacord 40   9925

2.      Isacord 40   9975

3.      Isacord 40   9924

4.      Isacord 40   9973

5.      Isacord 40   1972

Nb840_48 124 x 142 mm
4.9 x 5.6 inch

11.593

1.      Isacord 40   9925

2.      Isacord 40   9971

3.      Isacord 40   9937

4.      Isacord 40   9973

5.      Isacord 40   9924

6.      Isacord 40   1972

19.4 Borders

12398-13 31 x 152 mm
1.2 x 6 inch

1.966

1.      Isacord 40   5822

2.      Isacord 40   2153

3.      Isacord 40   2155

12398-14 75 x 75 mm
2.9 x 2.9 inch

1.834

1.      Isacord 40   5822

2.      Isacord 40   2153

3.      Isacord 40   2155

12398-20 32 x 152 mm
1.3 x 6 inch

8.518

1.      Isacord 40   6051

2.      Isacord 40   5610

3.      Isacord 40   4250

4.      Isacord 40   4430

5.      Isacord 40   6051

6.      Isacord 40   5610

12398-21 76 x 76 mm
3 x 3 inch

4.344

1.      Isacord 40   6051

2.      Isacord 40   5610

3.      Isacord 40   4250

4.      Isacord 40   4430

5.      Isacord 40   5610

6.      Isacord 40   6051
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12398-24 30 x 152 mm
1.2 x 6 inch

8.275

1.      Isacord 40   4220

2.      Isacord 40   0722

12418-25 25 x 141 mm
1 x 5.5 inch

2.980

1.      Isacord 40   6141

2.      Isacord 40   5822

3.      Isacord 40   2250

12428-32 115 x 18 mm
4.5 x 0.7 inch

2.192

1.      Isacord 40   0015

12428-33 39 x 39 mm
1.5 x 1.5 inch

1.232

1.      Isacord 40   0015

12445-18 108 x 16 mm
4.2 x 0.6 inch

2.680

1.      Isacord 40   1010

12445-20 33 x 33 mm
1.3 x 1.3 inch

1.234

1.      Isacord 40   1010

12508-26 44 x 152 mm
1.7 x 6 inch

8.761

1.      Isacord 40   0352

2.      Isacord 40   6133

3.      Isacord 40   4752

4.      Isacord 40   5552

12508-27 78 x 77 mm
3.1 x 3 inch

6.600

1.      Isacord 40   0352

2.      Isacord 40   6133

3.      Isacord 40   4752

4.      Isacord 40   5552

12576-10 70 x 200 mm
2.8 x 7.9 inch

10.961

1.      Isacord 40   3444

2.      Isacord 40   1332

3.      Isacord 40   2022

51208-15 48 x 170 mm
1.9 x 6.7 inch

2.614

1.      Isacord 40   0020
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Fb038 107 x 22 mm
4.2 x 0.9 inch

3.544

1.      Isacord 40   0352

2.      Isacord 40   1532

3.      Isacord 40   1730

Fs114_48 24 x 103 mm
1 x 4.1 inch

3.963

1.      Isacord 40   6011

2.      Isacord 40   6133

3.      Isacord 40   2550

4.      Isacord 40   2520

Hg792_48 21 x 153 mm
0.8 x 6 inch

2.998

1.      Isacord 40   1900

2.      Isacord 40   4113

3.      Isacord 40   1355

Nz819 71 x 45 mm
2.8 x 1.8 inch

3.325

1.      Isacord 40   5220

12426-18 178 x 27 mm
7 x 1.1 inch

1.023

1.      Isacord 40   0520

2.      Isacord 40   1730

3.      Isacord 40   0800

4.      Isacord 40   3920

12426-19 62 x 82 mm
2.4 x 3.2 inch

723

1.      Isacord 40   3920

2.      Isacord 40   0800

3.      Isacord 40   1730

4.      Isacord 40   0520

51214-15l 82 x 260 mm
3.2 x 10.2 inch

9.320

1.      Isacord 40   6043

2.      Isacord 40   3030

3.      Isacord 40   0442

4.      Isacord 40   3630

5.      Isacord 40   3650

82008-44 35 x 171 mm
1.4 x 6.7 inch

5.183

1.      Isacord 40   0453

82008-45 116 x 115 mm
4.6 x 4.5 inch

5.760

1.      Isacord 40   0453

82028-32 30 x 178 mm
1.2 x 7 inch

3.820

1.      Isacord 40   1521

2.      Isacord 40   1725

3.      Isacord 40   1352



Appendix

19 Embroidery Designs 152

82028-33 89 x 89 mm
3.5 x 3.5 inch

3.244

1.      Isacord 40   1521

2.      Isacord 40   1725

3.      Isacord 40   1352

Cm575_48 33 x 169 mm
1.3 x 6.6 inch

7.514

1.      Isacord 40   5230

2.      Isacord 40   5933

3.      Isacord 40   5610

4.      Isacord 40   4152

5.      Isacord 40   4610

Cm576_48 89 x 68 mm
3.5 x 2.7 inch

7.924

1.      Isacord 40   5633

2.      Isacord 40   5643

3.      Isacord 40   5610

4.      Isacord 40   6133

5.      Isacord 40   5934

6.      Isacord 40   5531

Pk10019-05 71 x 50 mm
2.8 x 2 inch

6.412

1.      Isacord 40   0832

2.      Isacord 40   2530

3.      Isacord 40   2508

4.      Isacord 40   1730

5.      Isacord 40   0904

6.      Isacord 40   5740

Pk10019-06 36 x 190 mm
1.4 x 7.5 inch

14.430

1.      Isacord 40   0670

2.      Isacord 40   5740

3.      Isacord 40   1730

4.      Isacord 40   0670

5.      Isacord 40   2530

6.      Isacord 40   0832

7.      Isacord 40   2508

8.      Isacord 40   0134

9.      Isacord 40   0904

19.5 Frames

12508-24 122 x 122 mm
4.8 x 4.8 inch

15.870

1.      Isacord 40   0352

2.      Isacord 40   6133

3.      Isacord 40   4752

4.      Isacord 40   5552

12719-53 124 x 124 mm
4.9 x 4.9 inch

4.728

1.      Isacord 40   0020

12931-01 150 x 150 mm
5.9 x 5.9 inch

25.245

1.      Isacord 40   0721

2.      Isacord 40   0731

3.      Isacord 40   0660

4.      Isacord 40   0721

5.      Isacord 40   0741

6.      Isacord 40   0660

7.      Yenmet   7011

51208-08 121 x 122 mm
4.8 x 4.8 inch

14.443

1.      Isacord 40   0131

2.      Isacord 40   5743

3.      Isacord 40   5643

4.      Isacord 40   0020
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51285-08 124 x 135 mm
4.9 x 5.3 inch

10.513

1.      Isacord 40   0152

2.      Isacord 40   2650

3.      Isacord 40   2721

4.      Isacord 40   0020

5.      Isacord 40   0020

Ck983 182 x 126 mm
7.2 x 4.9 inch

12.962

1.      Isacord 40   2166

Ck993 183 x 117 mm
7.2 x 4.6 inch

13.772

1.      Isacord 40   0015

2.      Isacord 40   0811

3.      Isacord 40   1904

4.      Isacord 40   0108

5.      Isacord 40   3711

82020-54 139 x 162 mm
5.5 x 6.4 inch

9.797

1.      Isacord 40   0345

2.      Isacord 40   0761

3.      Isacord 40   0622

4.      Isacord 40   0542

5.      Isacord 40   0442

6.      Isacord 40   0622

7.      Isacord 40   0542

8.      Isacord 40   0221

82022-17 203 x 197 mm
8 x 7.8 inch

16.442

1.      Isacord 40   0674

12795-05 305 x 299 mm
12 x 11.8 inch

28.802

1.      Isacord 40   2830

2.      Isacord 40   2810

3.      Isacord 40   2504

4.      Isacord 40   0811

5.      Isacord 40   1141

51227-04 237 x 305 mm
9.3 x 12 inch

42.525

1.      Isacord 40   4610

2.      Isacord 40   0702

3.      Isacord 40   1840

4.      Isacord 40   1860

5.      Isacord 40   4174

6.      Isacord 40   0010

7.      Isacord 40   1521

8.      Isacord 40   1352

9.      Isacord 40   0713

19.6 Lace

12474-01 110 x 92 mm
4.3 x 3.6 inch

10.113

1.      Isacord 40   2051

2.      Isacord 40   2051

3.      Isacord 40   2051

4.      Isacord 40   2241

5.      Isacord 40   0131

6.      Isacord 40   0112

12474-19 147 x 123 mm
5.8 x 4.9 inch

25.009

1.      Isacord 40   5822

2.      Isacord 40   5531

3.      Isacord 40   5633

4.      Isacord 40   5633

5.      Isacord 40   5633

6.      Isacord 40   0771
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12609-03 222 x 76 mm
8.7 x 3 inch

33.502

1.      Isacord 40   0015

2.      Isacord 40   0015

3.      Isacord 40   0015

4.      Isacord 40   0015

5.      Isacord 40   0015

6.      Isacord 40   2250

7.      Yenmet   7008

12609-04 84 x 85 mm
3.3 x 3.3 inch

8.968

1.      Isacord 40   0015

2.      Isacord 40   0015

3.      Isacord 40   0015

4.      Isacord 40   0015

5.      Isacord 40   2250

6.      Isacord 40   0015

7.      Yenmet   7008

12635-03 38 x 165 mm
1.5 x 6.5 inch

16.833

1.      Isacord 40   0131

2.      Isacord 40   0132

3.      Isacord 40   0112

12742-01 137 x 133 mm
5.4 x 5.2 inch

41.668

1.      Isacord 40   1911

12746-11 110 x 110 mm
4.3 x 4.3 inch

21.560

1.      Isacord 40   2762

2.      Isacord 40   0761

3.      Isacord 40   2764

4.      Isacord 40   2153

12758-03 50 x 173 mm
2 x 6.8 inch

21.912

1.      Isacord 40   0015

12771-01 135 x 211 mm
5.3 x 8.3 inch

44.572

1.      Isacord 40   0870

2.      Isacord 40   0870

3.      Isacord 40   0870

4.      Isacord 40   0101

12779-01 106 x 210 mm
4.2 x 8.3 inch

77.864

1.      Isacord 40   1874

12779-02 87 x 210 mm
3.4 x 8.3 inch

63.342

1.      Isacord 40   1874

12779-05 76 x 75 mm
3 x 2.9 inch

8.875

1.      Isacord 40   1874
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12788-01 141 x 218 mm
5.6 x 8.6 inch

48.677

1.      Isacord 40   4071

2.      Isacord 40   4071

3.      Isacord 40   4071

4.      Isacord 40   0010

12889-09 133 x 224 mm
5.3 x 8.8 inch

51.499

1.      Isacord 40   0017

2.      Isacord 40   3652

3.      Isacord 40   2650

4.      Isacord 40   3030

12896-05 116 x 117 mm
4.6 x 4.6 inch

32.525

1.      Isacord 40   0781

82014-34 45 x 76 mm
1.8 x 3 inch

8.451

1.      Isacord 40   0131

82018-08 129 x 64 mm
5.1 x 2.5 inch

16.909

1.      Isacord 40   0010

82018-13 177 x 223 mm
7 x 8.8 inch

71.896

1.      Isacord 40   0010

82018-14 88 x 139 mm
3.5 x 5.5 inch

26.422

1.      Isacord 40   0010

2.      Isacord 40   2153

3.      Isacord 40   2241

4.      Isacord 40   1172

5.      Isacord 40   0010

82018-18 89 x 125 mm
3.5 x 4.9 inch

20.053

1.      Isacord 40   1172

82018-30 76 x 68 mm
3 x 2.7 inch

9.755

1.      Isacord 40   1161

Oc07107 121 x 172 mm
4.8 x 6.8 inch

50.579

1.      Isacord 40   0670
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12667-08 130 x 130 mm
5.1 x 5.1 inch

48.177

1.      Isacord 40   0504

2.      Isacord 40   2115

12794-02-06 196 x 394 mm
7.7 x 15.5 inch

163.459

1.      Isacord 40   0015

19.7 Mini

12491-23 27 x 31 mm
1.1 x 1.2 inch

1.439

1.      Isacord 40   3815

2.      Isacord 40   3962

3.      Isacord 40   3902

4.      Isacord 40   0020

12819-01 24 x 31 mm
1 x 1.2 inch

1.797

1.      Isacord 40   0934

2.      Isacord 40   6133

3.      Isacord 40   6141

4.      Isacord 40   5650

5.      Isacord 40   5944

12819-02 33 x 30 mm
1.3 x 1.2 inch

1.588

1.      Isacord 40   4071

2.      Isacord 40   0015

3.      Isacord 40   0800

4.      Isacord 40   0020

12819-03 29 x 36 mm
1.1 x 1.4 inch

1.918

1.      Isacord 40   5944

2.      Isacord 40   6141

3.      Isacord 40   5933

4.      Isacord 40   5531

5.      Isacord 40   1010

6.      Isacord 40   0015

12819-04 30 x 37 mm
1.2 x 1.5 inch

1.396

1.      Isacord 40   0020

2.      Isacord 40   2530

3.      Isacord 40   0800

4.      Isacord 40   0131

12819-05 32 x 34 mm
1.3 x 1.4 inch

740

1.      Isacord 40   3650

2.      Isacord 40   3910

3.      Isacord 40   3902

4.      Isacord 40   2530

12819-06 34 x 25 mm
1.4 x 1 inch

914

1.      Isacord 40   0970

2.      Isacord 40   0771

3.      Isacord 40   0945

4.      Isacord 40   1725

12819-07 28 x 32 mm
1.1 x 1.3 inch

1.209

1.      Isacord 40   0310

2.      Isacord 40   1725

3.      Isacord 40   2530

4.      Isacord 40   2702

5.      Isacord 40   0015
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12819-08 33 x 34 mm
1.3 x 1.3 inch

358

1.      Isacord 40   0132

2.      Isacord 40   2530

12819-10 32 x 34 mm
1.3 x 1.4 inch

857

1.      Isacord 40   2530

2.      Isacord 40   1725

3.      Isacord 40   0020

4.      Isacord 40   1010

5.      Isacord 40   5531

6.      Isacord 40   3045

12819-11 34 x 32 mm
1.3 x 1.2 inch

1.355

1.      Isacord 40   0771

2.      Isacord 40   1725

3.      Isacord 40   0800

4.      Isacord 40   0015

5.      Isacord 40   0131

6.      Isacord 40   6141

12819-12 30 x 32 mm
1.2 x 1.2 inch

942

1.      Isacord 40   6141

2.      Isacord 40   5531

3.      Isacord 40   5944

4.      Isacord 40   0131

12819-13 34 x 35 mm
1.3 x 1.4 inch

1.121

1.      Isacord 40   5664

2.      Isacord 40   5933

3.      Isacord 40   3730

4.      Isacord 40   4032

12819-14 31 x 30 mm
1.2 x 1.2 inch

999

1.      Isacord 40   0015

2.      Isacord 40   2530

3.      Isacord 40   6141

4.      Isacord 40   0020

12819-17 32 x 34 mm
1.3 x 1.4 inch

1.277

1.      Isacord 40   3830

2.      Isacord 40   3730

3.      Isacord 40   5531

12819-18 30 x 34 mm
1.2 x 1.3 inch

1.028

1.      Isacord 40   0822

2.      Isacord 40   1010

3.      Isacord 40   0020

12819-20 31 x 34 mm
1.2 x 1.4 inch

1.179

1.      Isacord 40   4032

2.      Isacord 40   3650

3.      Isacord 40   5101

4.      Isacord 40   0970

5.      Isacord 40   2530

6.      Isacord 40   0800

12822-06 34 x 36 mm
1.3 x 1.4 inch

1.083

1.      Isacord 40   5510

2.      Isacord 40   5822

3.      Isacord 40   3901

4.      Isacord 40   2152

5.      Isacord 40   0904

6.      Isacord 40   2171

7.      Isacord 40   4114
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12822-07 32 x 38 mm
1.3 x 1.5 inch

1.781

1.      Isacord 40   3901

2.      Isacord 40   5822

3.      Isacord 40   4114

4.      Isacord 40   0015

12822-10 22 x 48 mm
0.9 x 1.9 inch

1.115

1.      Isacord 40   3150

2.      Isacord 40   3251

3.      Isacord 40   5531

12822-12 28 x 30 mm
1.1 x 1.2 inch

1.027

1.      Isacord 40   2152

2.      Isacord 40   3901

3.      Isacord 40   3730

4.      Isacord 40   1725

5.      Isacord 40   2155

6.      Isacord 40   5531

12822-13 28 x 28 mm
1.1 x 1.1 inch

909

1.      Isacord 40   2155

2.      Isacord 40   2152

3.      Isacord 40   3901

4.      Isacord 40   0015

5.      Isacord 40   6043

12822-14 24 x 28 mm
0.9 x 1.1 inch

831

1.      Isacord 40   5531

2.      Isacord 40   3211

3.      Isacord 40   2640

4.      Isacord 40   2171

12822-15 76 x 78 mm
3 x 3.1 inch

5.802

1.      Isacord 40   6043

2.      Isacord 40   2152

3.      Isacord 40   1725

4.      Isacord 40   0015

5.      Isacord 40   3901

6.      Isacord 40   2640

12822-18 80 x 84 mm
3.2 x 3.3 inch

5.167

1.      Isacord 40   3901

2.      Isacord 40   3251

3.      Isacord 40   5531

4.      Isacord 40   4114

5.      Isacord 40   2640

6.      Isacord 40   3150

7.      Isacord 40   6141

8.      Isacord 40   0015

12836-35 45 x 46 mm
1.8 x 1.8 inch

2.190

1.      Isacord 40   1900

2.      Isacord 40   2011

3.      Isacord 40   5833

4.      Isacord 40   0010

12903-07 21 x 45 mm
0.8 x 1.8 inch

741

1.      Isacord 40   4740

2.      Isacord 40   5115

3.      Isacord 40   3150

21017-15 30 x 36 mm
1.2 x 1.4 inch

977

1.      Isacord 40   0453

2.      Isacord 40   0442

3.      Isacord 40   0345

4.      Isacord 40   0702

5.      Isacord 40   1102

6.      Isacord 40   0640
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51215-18 30 x 29 mm
1.2 x 1.1 inch

994

1.      Isacord 40   6011

2.      Isacord 40   1904

3.      Isacord 40   5912

4.      Isacord 40   5633

51253-07 24 x 42 mm
0.9 x 1.7 inch

1.008

1.      Isacord 40   0506

2.      Isacord 40   2160

3.      Isacord 40   2530

4.      Isacord 40   2520

51253-08 26 x 41 mm
1 x 1.6 inch

937

1.      Isacord 40   0741

2.      Isacord 40   0506

3.      Isacord 40   0520

51253-13 34 x 33 mm
1.4 x 1.3 inch

1.471

1.      Isacord 40   0670

2.      Isacord 40   0506

3.      Isacord 40   1030

4.      Isacord 40   4174

5.      Isacord 40   2520

51253-20 26 x 24 mm
1 x 0.9 inch

816

1.      Isacord 40   0506

2.      Isacord 40   1030

3.      Isacord 40   0741

80081-18 20 x 27 mm
0.8 x 1.1 inch

432

1.      Isacord 40   2520

2.      Isacord 40   2521

80081-19 107 x 23 mm
4.2 x 0.9 inch

7.930

1.      Isacord 40   2521

Cj325 32 x 24 mm
1.2 x 0.9 inch

1.303

1.      Isacord 40   3761

2.      Isacord 40   0250

3.      Isacord 40   2153

Cj587 24 x 33 mm
0.9 x 1.3 inch

1.919

1.      Isacord 40   2171

2.      Isacord 40   1840

3.      Isacord 40   5610

Cj850 20 x 23 mm
0.8 x 0.9 inch

836

1.      Isacord 40   3640

2.      Isacord 40   1755

3.      Isacord 40   3331

Cj862 23 x 22 mm
0.9 x 0.9 inch

1.054

1.      Isacord 40   0630

2.      Isacord 40   0221

3.      Isacord 40   1352

Cj864 25 x 19 mm
1 x 0.8 inch

1.463

1.      Isacord 40   2764

2.      Isacord 40   0811

3.      Isacord 40   0713

4.      Isacord 40   1430



Appendix

19 Embroidery Designs 160

Cj866 19 x 22 mm
0.7 x 0.9 inch

806

1.      Isacord 40   2764

2.      Isacord 40   0630

3.      Isacord 40   4071

Cj868 25 x 25 mm
1 x 1 inch

1.171

1.      Isacord 40   3761

2.      Isacord 40   3331

3.      Isacord 40   0713

4.      Isacord 40   2920

Cj870 32 x 24 mm
1.2 x 1 inch

985

1.      Isacord 40   6051

2.      Isacord 40   0811

3.      Isacord 40   3650

4.      Isacord 40   3951

Nv104 34 x 31 mm
1.4 x 1.2 inch

1.854

1.      Isacord 40   3600

2.      Isacord 40   0015

3.      Isacord 40   1902

Oc86069 18 x 21 mm
0.7 x 0.8 inch

441

1.      Isacord 40   3962

2.      Isacord 40   3641

Oc86074 15 x 15 mm
0.6 x 0.6 inch

359

1.      Isacord 40   2155

2.      Isacord 40   2764

12507-32 55 x 34 mm
2.2 x 1.3 inch

3.989

1.      Isacord 40   0015

19.8 Flowers

Hb101 127 x 133 mm
5 x 5.2 inch

18.368

1.      Isacord 40   5722

2.      Isacord 40   5643

3.      Isacord 40   2560

4.      Isacord 40   2532

5.      Isacord 40   1921

6.      Isacord 40   0640

12379-33 80 x 205 mm
3.1 x 8.1 inch

9.003

1.      Isacord 40   2170

2.      Isacord 40   2761

3.      Isacord 40   0311

4.      Isacord 40   0931

5.      Isacord 40   6141

6.      Isacord 40   0453

7.      Isacord 40   5944

8.      Isacord 40   2051

9.      Isacord 40   2764

10.      Isacord 40   0015 11.      Isacord 40   0853
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12379-49 96 x 156 mm
3.8 x 6.1 inch

14.900

1.      Isacord 40   3350

2.      Isacord 40   3130

3.      Isacord 40   2650

4.      Isacord 40   2920

5.      Isacord 40   2900

6.      Isacord 40   2510

7.      Isacord 40   2832

8.      Isacord 40   1362

9.      Isacord 40   0453

10.      Isacord 40   5944

12417-08 104 x 160 mm
4.1 x 6.3 inch

13.421

1.      Isacord 40   0442

2.      Isacord 40   0721

3.      Isacord 40   0532

4.      Isacord 40   0345

5.      Isacord 40   1521

6.      Isacord 40   0811

7.      Isacord 40   1010

8.      Isacord 40   1311

12417-10 113 x 136 mm
4.5 x 5.4 inch

8.635

1.      Isacord 40   0811

2.      Isacord 40   0721

3.      Isacord 40   1032

4.      Isacord 40   0345

12422-31 32 x 40 mm
1.3 x 1.6 inch

2.539

1.      Isacord 40   1114

2.      Isacord 40   1311

3.      Isacord 40   0811

12713-01 82 x 125 mm
3.2 x 4.9 inch

11.150

1.      Isacord 40   5450

2.      Isacord 40   2530

3.      Isacord 40   4174

4.      Isacord 40   4174

5.      Isacord 40   2530

6.      Isacord 40   2320

12713-03 134 x 132 mm
5.3 x 5.2 inch

26.164

1.      Isacord 40   5832

2.      Isacord 40   5450

3.      Isacord 40   5722

4.      Isacord 40   1321

5.      Isacord 40   1911

6.      Isacord 40   4174

7.      Isacord 40   2530

8.      Isacord 40   2320

9.      Isacord 40   1730

10.      Isacord 40   1911 11.      Isacord 40   0800 12.      Isacord 40   1321

13.      Isacord 40   0015 14.      Isacord 40   4174

12773-40 46 x 86 mm
1.8 x 3.4 inch

8.070

1.      Isacord 40   2155

2.      Isacord 40   5830

3.      Isacord 40   0020

12914-01 117 x 155 mm
4.6 x 6.1 inch

19.835

1.      Isacord 40   2600

2.      Isacord 40   2241

3.      Isacord 40   2944

4.      Isacord 40   1342

5.      Isacord 40   5643

6.      Isacord 40   5912

7.      Isacord 40   0465

12914-02 112 x 154 mm
4.4 x 6.1 inch

16.778

1.      Isacord 40   5643

2.      Isacord 40   5722

3.      Isacord 40   5912

4.      Isacord 40   0465

12914-03 113 x 153 mm
4.4 x 6 inch

13.250

1.      Isacord 40   5643

2.      Isacord 40   5722

3.      Isacord 40   5912

4.      Isacord 40   0853

5.      Isacord 40   0465
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12914-06 110 x 151 mm
4.3 x 5.9 inch

15.331

1.      Isacord 40   5722

2.      Isacord 40   5912

3.      Isacord 40   0465

12914-07 122 x 153 mm
4.8 x 6 inch

11.873

1.      Isacord 40   5643

2.      Isacord 40   0853

3.      Isacord 40   5912

4.      Isacord 40   0465

12914-08 106 x 159 mm
4.2 x 6.3 inch

16.390

1.      Isacord 40   5912

2.      Isacord 40   5643

3.      Isacord 40   5722

4.      Isacord 40   0465

12931-04 89 x 176 mm
3.5 x 6.9 inch

16.702

1.      Isacord 40   0660

2.      Isacord 40   0731

3.      Isacord 40   0660

4.      Isacord 40   0721

5.      Isacord 40   0741

6.      Isacord 40   0721

7.      Yenmet   7011

12931-05 81 x 128 mm
3.2 x 5.1 inch

9.495

1.      Isacord 40   0660

2.      Isacord 40   0731

3.      Isacord 40   0660

4.      Isacord 40   0721

5.      Isacord 40   0741

6.      Isacord 40   0721

7.      Yenmet   7011

32040-02 128 x 114 mm
5.1 x 4.5 inch

16.844

1.      Isacord 40   6031

2.      Isacord 40   5643

3.      Isacord 40   4240

4.      Isacord 40   0702

5.      Isacord 40   3210

6.      Isacord 40   1902

7.      Isacord 40   1543

32040-08 126 x 133 mm
4.9 x 5.2 inch

25.386

1.      Isacord 40   1900

2.      Isacord 40   0800

3.      Isacord 40   4114

4.      Isacord 40   0800

5.      Isacord 40   5643

6.      Isacord 40   0132

7.      Isacord 40   2220

8.      Isacord 40   0800

9.      Isacord 40   4114

10.      Isacord 40   1900 11.      Isacord 40   5643

32040-09 119 x 173 mm
4.7 x 6.8 inch

14.343

1.      Isacord 40   0800

2.      Isacord 40   5912

3.      Isacord 40   5643

4.      Isacord 40   0800

5.      Isacord 40   2220

6.      Isacord 40   4114

7.      Isacord 40   1900

51202-11 64 x 75 mm
2.5 x 3 inch

7.224

1.      Isacord 40   5770

2.      Isacord 40   5822

3.      Isacord 40   1911

4.      Isacord 40   1921

5.      Isacord 40   1430

6.      Isacord 40   1532

7.      Isacord 40   1362

8.      Isacord 40   2153

9.      Isacord 40   2152

10.      Isacord 40   2155 11.      Isacord 40   2171 12.      Isacord 40   0010

13.      Isacord 40   0622

51202-12 83 x 46 mm
3.3 x 1.8 inch

5.388

1.      Isacord 40   5770

2.      Isacord 40   5822

3.      Isacord 40   1911

4.      Isacord 40   2155

5.      Isacord 40   2152

6.      Isacord 40   2171

7.      Isacord 40   2153

8.      Isacord 40   1921

9.      Isacord 40   0010

10.      Isacord 40   0622
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51202-13 88 x 77 mm
3.5 x 3 inch

10.693

1.      Isacord 40   5833

2.      Isacord 40   6043

3.      Isacord 40   5933

4.      Isacord 40   5643

5.      Isacord 40   2153

6.      Isacord 40   1921

7.      Isacord 40   1911

8.      Isacord 40   0622

51203-13 117 x 125 mm
4.6 x 4.9 inch

19.514

1.      Isacord 40   5832

2.      Isacord 40   5643

3.      Isacord 40   0945

4.      Isacord 40   2220

5.      Isacord 40   0310

6.      Isacord 40   4116

7.      Isacord 40   2155

8.      Isacord 40   2920

9.      Isacord 40   0010

51227-08 124 x 136 mm
4.9 x 5.4 inch

26.077

1.      Isacord 40   4430

2.      Isacord 40   0010

3.      Isacord 40   4610

4.      Isacord 40   4515

5.      Isacord 40   0702

6.      Isacord 40   1521

7.      Isacord 40   1840

8.      Isacord 40   1860

9.      Isacord 40   4174

10.      Isacord 40   1704 11.      Isacord 40   1521 12.      Isacord 40   0010

13.      Isacord 40   1755 14.      Isacord 40   4174

51227-10 90 x 136 mm
3.5 x 5.4 inch

20.095

1.      Isacord 40   4515

2.      Isacord 40   0702

3.      Isacord 40   4610

4.      Isacord 40   0010

5.      Isacord 40   1840

6.      Isacord 40   1860

7.      Isacord 40   4531

8.      Isacord 40   4515

9.      Isacord 40   1521

10.      Isacord 40   1840 11.      Isacord 40   4174 12.      Isacord 40   0010

13.      Isacord 40   1840

82006-17 35 x 37 mm
1.4 x 1.4 inch

3.133

1.      Isacord 40   0660

2.      Isacord 40   0832

3.      Isacord 40   1526

4.      Isacord 40   4421

5.      Isacord 40   4174

Cm416_48 76 x 70 mm
3 x 2.8 inch

8.699

1.      Isacord 40   0504

2.      Isacord 40   0904

3.      Isacord 40   1311

4.      Isacord 40   2155

5.      Isacord 40   5822

6.      Isacord 40   5833

7.      Isacord 40   2655

8.      Isacord 40   3045

9.      Isacord 40   3130

Fp785 99 x 104 mm
3.9 x 4.1 inch

21.993

1.      Isacord 40   3150

2.      Isacord 40   5822

3.      Isacord 40   0232

4.      Isacord 40   5770

5.      Isacord 40   1755

6.      Isacord 40   2152

7.      Isacord 40   2363

8.      Isacord 40   3650

9.      Isacord 40   0640

10.      Isacord 40   0131

Fq561_48 185 x 243 mm
7.3 x 9.6 inch

18.778

1.      Isacord 40   0552

2.      Isacord 40   6051

3.      Isacord 40   5833

4.      Isacord 40   5934

5.      Isacord 40   5822

6.      Isacord 40   5833

7.      Isacord 40   5650

8.      Isacord 40   3652

9.      Isacord 40   3641

10.      Isacord 40   3620 11.      Isacord 40   0970 12.      Isacord 40   1805

13.      Isacord 40   2123 14.      Isacord 40   1913
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Fq986_48 139 x 145 mm
5.5 x 5.7 inch

23.426

1.      Isacord 40   5650

2.      Isacord 40   5833

3.      Isacord 40   0352

4.      Isacord 40   5934

5.      Isacord 40   0465

6.      Isacord 40   5822

7.      Isacord 40   0015

8.      Isacord 40   0781

9.      Isacord 40   0170

10.      Isacord 40   0731 11.      Isacord 40   0640 12.      Isacord 40   6133

Fs316_48 124 x 167 mm
4.9 x 6.6 inch

9.758

1.      Isacord 40   3853

Na882 134 x 66 mm
5.3 x 2.6 inch

10.597

1.      Isacord 40   0352

2.      Isacord 40   0453

3.      Isacord 40   0532

4.      Isacord 40   1060

5.      Isacord 40   1430

6.      Isacord 40   1532

7.      Isacord 40   3650

8.      Isacord 40   3641

9.      Isacord 40   3762

10.      Isacord 40   2655 11.      Isacord 40   2764 12.      Isacord 40   3040

13.      Isacord 40   0520 14.      Isacord 40   0811 15.      Isacord 40   0506

16.      Isacord 40   2250 17.      Isacord 40   2153 18.      Isacord 40   1840

Oc86020 65 x 82 mm
2.6 x 3.2 inch

2.462

1.      Isacord 40   5610

2.      Isacord 40   0504

3.      Isacord 40   0922

4.      Isacord 40   1840

5.      Isacord 40   2363

6.      Isacord 40   0520

7.      Isacord 40   1123

51322-01 60 x 203 mm
2.4 x 8 inch

15.467

1.      Isacord 40   5542

2.      Isacord 40   5730

3.      Isacord 40   5833

4.      Isacord 40   5743

5.      Isacord 40   2506

6.      Isacord 40   2521

7.      Isacord 40   2320

8.      Isacord 40   2520

9.      Isacord 40   2170

51322-02 80 x 201 mm
3.1 x 7.9 inch

17.811

1.      Isacord 40   5531

2.      Isacord 40   6141

3.      Isacord 40   5633

4.      Isacord 40   5643

5.      Isacord 40   2920

6.      Isacord 40   3130

7.      Isacord 40   2702

8.      Isacord 40   2953

9.      Isacord 40   6141

51322-03 74 x 202 mm
2.9 x 7.9 inch

10.100

1.      Isacord 40   6043

2.      Isacord 40   5833

3.      Isacord 40   5933

4.      Isacord 40   0853

5.      Isacord 40   1061

6.      Isacord 40   0310

7.      Isacord 40   6051

8.      Isacord 40   0250

9.      Isacord 40   0311

10.      Isacord 40   0811 11.      Isacord 40   0824

51322-04 97 x 203 mm
3.8 x 8 inch

20.256

1.      Isacord 40   5833

2.      Isacord 40   5832

3.      Isacord 40   5933

4.      Isacord 40   5643

5.      Isacord 40   0670

6.      Isacord 40   4071

7.      Isacord 40   0176

8.      Isacord 40   0622

9.      Isacord 40   0704

10.      Isacord 40   0824
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51322-05 123 x 176 mm
4.8 x 6.9 inch

22.119

1.      Isacord 40   5531

2.      Isacord 40   0250

3.      Isacord 40   5633

4.      Isacord 40   5643

5.      Isacord 40   0532

6.      Isacord 40   5832

7.      Isacord 40   5633

8.      Isacord 40   0670

51322-06 88 x 202 mm
3.5 x 8 inch

23.883

1.      Isacord 40   5833

2.      Isacord 40   5743

3.      Isacord 40   5542

4.      Isacord 40   5944

5.      Isacord 40   5933

6.      Isacord 40   5832

7.      Isacord 40   1921

8.      Isacord 40   2011

9.      Isacord 40   2152

10.      Isacord 40   2170 11.      Isacord 40   0010 12.      Isacord 40   0853

13.      Isacord 40   1543

51322-07 95 x 202 mm
3.7 x 7.9 inch

26.158

1.      Isacord 40   5833

2.      Isacord 40   5743

3.      Isacord 40   5832

4.      Isacord 40   3363

5.      Isacord 40   3810

6.      Isacord 40   3622

7.      Isacord 40   3730

8.      Isacord 40   0622

51322-08 104 x 177 mm
4.1 x 7 inch

20.646

1.      Isacord 40   5542

2.      Isacord 40   5743

3.      Isacord 40   5822

4.      Isacord 40   1911

5.      Isacord 40   1725

6.      Isacord 40   1521

7.      Isacord 40   1532

8.      Isacord 40   0731

9.      Isacord 40   2336

51322-09 96 x 203 mm
3.8 x 8 inch

25.942

1.      Isacord 40   5542

2.      Isacord 40   5832

3.      Isacord 40   5743

4.      Isacord 40   5643

5.      Isacord 40   2510

6.      Isacord 40   2723

7.      Isacord 40   2520

8.      Isacord 40   2506

9.      Isacord 40   2650

51322-10 68 x 203 mm
2.7 x 8 inch

23.235

1.      Isacord 40   5542

2.      Isacord 40   5822

3.      Isacord 40   5643

4.      Isacord 40   5743

5.      Isacord 40   6141

6.      Isacord 40   1334

7.      Isacord 40   1220

8.      Isacord 40   1321

9.      Isacord 40   1030

10.      Isacord 40   0630

51322-11 98 x 202 mm
3.9 x 7.9 inch

27.263

1.      Isacord 40   5822

2.      Isacord 40   6043

3.      Isacord 40   5933

4.      Isacord 40   1335

5.      Isacord 40   1521

6.      Isacord 40   1532

7.      Isacord 40   1060

51322-12 101 x 184 mm
4 x 7.2 inch

25.161

1.      Isacord 40   5833

2.      Isacord 40   5633

3.      Isacord 40   5944

4.      Isacord 40   5531

5.      Isacord 40   1911

6.      Isacord 40   2113

7.      Isacord 40   1725
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82022-13 126 x 179 mm
4.9 x 7 inch

52.543

1.      Isacord 40   1140

2.      Isacord 40   0781

3.      Isacord 40   1172

4.      Isacord 40   5643

5.      Isacord 40   5610

6.      Isacord 40   5650

7.      Isacord 40   5832

8.      Isacord 40   5531

9.      Isacord 40   6043

10.      Isacord 40   1154 11.      Isacord 40   5730 12.      Isacord 40   5740

13.      Isacord 40   0722 14.      Isacord 40   1375 15.      Isacord 40   5643

16.      Isacord 40   5633 17.      Isacord 40   2155 18.      Isacord 40   2241

19.      Isacord 40   5912

82033-07 124 x 150 mm
4.9 x 5.9 inch

6.752

1.      Isacord 40   5500

2.      Isacord 40   2532

3.      Isacord 40   5230

4.      Isacord 40   2532

5.      Isacord 40   2510

6.      Isacord 40   5613

7.      Isacord 40   2532

8.      Isacord 40   5500

9.      Isacord 40   0704

10.      Isacord 40   2810 11.      Isacord 40   2510 12.      Isacord 40   0704

19.9 Stylized Flowers

12579-02 115 x 118 mm
4.5 x 4.6 inch

22.571

1.      Isacord 40   0020

2.      Isacord 40   0015

3.      Isacord 40   0020

12579-05 107 x 88 mm
4.2 x 3.5 inch

9.293

1.      Isacord 40   0015

2.      Isacord 40   0020

12579-06 73 x 101 mm
2.9 x 4 inch

5.350

1.      Isacord 40   0015

2.      Isacord 40   0020

12579-08 70 x 95 mm
2.8 x 3.7 inch

7.524

1.      Isacord 40   0020

2.      Isacord 40   0015

12579-10 142 x 144 mm
5.6 x 5.6 inch

11.277

1.      Isacord 40   0015

2.      Isacord 40   0020

12627-05 93 x 100 mm
3.7 x 3.9 inch

8.679

1.      Isacord 40   5230
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12627-22 67 x 173 mm
2.6 x 6.8 inch

9.172

1.      Isacord 40   2320

12633-03 99 x 117 mm
3.9 x 4.6 inch

11.235

1.      Isacord 40   0015

12633-13 76 x 124 mm
3 x 4.9 inch

8.728

1.      Isacord 40   0015

12633-14 82 x 119 mm
3.2 x 4.7 inch

7.406

1.      Isacord 40   0015

12633-16 86 x 138 mm
3.4 x 5.4 inch

10.182

1.      Isacord 40   0015

12802-02l 203 x 260 mm
8 x 10.2 inch

15.158

1.      Isacord 40   0020

12802-04l 203 x 278 mm
8 x 10.9 inch

16.322

1.      Isacord 40   0020

12802-06s 127 x 128 mm
5 x 5.1 inch

17.403

1.      Isacord 40   0020

12802-07s 107 x 178 mm
4.2 x 7 inch

13.642

1.      Isacord 40   0020

12812-01L 197 x 222 mm
7.7 x 8.7 inch

31.258

1.      Isacord 40   0020



Appendix

19 Embroidery Designs 168

12812-02L 197 x 176 mm
7.8 x 6.9 inch

29.132

1.      Isacord 40   0020

12812-03L 197 x 205 mm
7.8 x 8.1 inch

38.896

1.      Isacord 40   0020

12812-08M 146 x 199 mm
5.7 x 7.8 inch

23.815

1.      Isacord 40   0020

12852-01 193 x 150 mm
7.6 x 5.9 inch

17.004

1.      Isacord 40   0010

12852-07 122 x 126 mm
4.8 x 4.9 inch

10.996

1.      Isacord 40   0010

12852-15 86 x 108 mm
3.4 x 4.3 inch

6.566

1.      Isacord 40   0010

12854-01 208 x 280 mm
8.2 x 11 inch

17.641

1.      Isacord 40   0015

12854-02 137 x 298 mm
5.4 x 11.8 inch

11.045

1.      Isacord 40   0015

12861-09L 178 x 253 mm
7 x 10 inch

32.697

1.      Isacord 40   0640

2.      Isacord 40   1030

3.      Isacord 40   2640

4.      Isacord 40   1840

5.      Isacord 40   0506

6.      Isacord 40   1102

7.      Isacord 40   2721

12919-04 82 x 154 mm
3.2 x 6.1 inch

6.068

1.      Isacord 40   5210

2.      Isacord 40   5220

3.      Isacord 40   3820

4.      Isacord 40   1362

5.      Isacord 40   1220

6.      Isacord 40   0934
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21017-13 66 x 94 mm
2.6 x 3.7 inch

4.253

1.      Isacord 40   0702

2.      Isacord 40   0453

3.      Isacord 40   0442

4.      Isacord 40   0345

5.      Isacord 40   1301

6.      Isacord 40   0640

21017-16 128 x 117 mm
5 x 4.6 inch

12.222

1.      Isacord 40   0453

2.      Isacord 40   0442

3.      Isacord 40   0702

4.      Isacord 40   1102

5.      Isacord 40   1301

6.      Isacord 40   0345

7.      Isacord 40   0761

8.      Isacord 40   0640

51208-13 120 x 166 mm
4.7 x 6.6 inch

31.904

1.      Isacord 40   0131

2.      Isacord 40   0131

3.      Isacord 40   5210

4.      Isacord 40   5100

5.      Isacord 40   0020

51208-14 119 x 172 mm
4.7 x 6.8 inch

31.738

1.      Isacord 40   0131

2.      Isacord 40   1800

3.      Isacord 40   2123

4.      Isacord 40   0020

51259-07 126 x 150 mm
4.9 x 5.9 inch

7.750

1.      Isacord 40   3743

2.      Isacord 40   1600

82004-14 135 x 135 mm
5.3 x 5.3 inch

19.103

1.      Isacord 40   0352

2.      Isacord 40   5510

3.      Isacord 40   0506

4.      Isacord 40   0015

5.      Isacord 40   1220

6.      Isacord 40   4111

7.      Isacord 40   0352

8.      Isacord 40   5050

9.      Isacord 40   4240

10.      Isacord 40   4111 11.      Isacord 40   1730 12.      Isacord 40   0352

13.      Isacord 40   1900 14.      Isacord 40   0506 15.      Isacord 40   0015

16.      Isacord 40   1220

82004-39 100 x 99 mm
3.9 x 3.9 inch

7.235

1.      Isacord 40   5722

82004-44 62 x 69 mm
2.4 x 2.7 inch

2.122

1.      Isacord 40   5722

82010-02 122 x 176 mm
4.8 x 6.9 inch

24.563

1.      Isacord 40   0721

2.      Isacord 40   0352

3.      Isacord 40   0672

4.      Isacord 40   4620

5.      Isacord 40   0352

6.      Isacord 40   0152

7.      Isacord 40   0672

8.      Isacord 40   0152

9.      Isacord 40   4620

82010-03 119 x 138 mm
4.7 x 5.4 inch

17.842

1.      Isacord 40   0721

2.      Isacord 40   0672

3.      Isacord 40   4620

4.      Isacord 40   0352

5.      Isacord 40   0152

6.      Isacord 40   0672

7.      Isacord 40   0152

8.      Isacord 40   0352
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82010-12 118 x 120 mm
4.7 x 4.7 inch

18.177

1.      Isacord 40   0721

2.      Isacord 40   0672

3.      Isacord 40   4620

4.      Isacord 40   0352

5.      Isacord 40   0672

6.      Isacord 40   0152

82010-19 108 x 109 mm
4.3 x 4.3 inch

15.359

1.      Isacord 40   0672

2.      Isacord 40   0721

3.      Isacord 40   0352

4.      Isacord 40   4620

5.      Isacord 40   0152

82010-28 124 x 124 mm
4.9 x 4.9 inch

22.492

1.      Isacord 40   0721

2.      Isacord 40   0672

3.      Isacord 40   4620

4.      Isacord 40   0352

5.      Isacord 40   0152

6.      Isacord 40   0672

82010-34 148 x 73 mm
5.8 x 2.9 inch

9.941

1.      Isacord 40   0152

2.      Isacord 40   4620

82010-36 80 x 112 mm
3.1 x 4.4 inch

8.223

1.      Isacord 40   0152

2.      Isacord 40   0721

82035-01 145 x 176 mm
5.7 x 6.9 inch

21.540

1.      Isacord 40   2832

Bd681_48 119 x 111 mm
4.7 x 4.4 inch

3.514

1.      Isacord 40   0124

2.      Isacord 40   1352

3.      Isacord 40   3652

4.      Isacord 40   3040

Bd691_48 112 x 315 mm
4.4 x 12.4 inch

11.224

1.      Isacord 40   0124

2.      Isacord 40   1352

3.      Isacord 40   3652

Fq505_48 105 x 100 mm
4.1 x 3.9 inch

4.618

1.      Isacord 40   9405

2.      Isacord 40   9916

3.      Isacord 40   9302

4.      Isacord 40   9805

5.      YLI variations   8019

6.      Isacord 40   9405

7.      YLI variations   8020

8.      Isacord 40   9605

9.      YLI variations   8009

10.      YLI variations   8021

Fq506_48 154 x 87 mm
6.1 x 3.4 inch

3.796

1.      Isacord 40   9405

2.      YLI variations   8020

3.      Isacord 40   9805

4.      YLI variations   8006

5.      YLI variations   8008

6.      YLI variations   8020
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Fs332_48 95 x 174 mm
3.8 x 6.8 inch

12.081

1.      Isacord 40   1725

Fs337_48 69 x 136 mm
2.7 x 5.4 inch

7.998

1.      Isacord 40   1730

12812-06s 121 x 122 mm
4.8 x 4.8 inch

14.413

1.      Isacord 40   0020

12812-08l 197 x 268 mm
7.7 x 10.6 inch

31.963

1.      Isacord 40   0020

Pk50017-01 140 x 212 mm
5.5 x 8.4 inch

25.629

1.      Isacord 40   5326

2.      Isacord 40   5513

3.      Isacord 40   5450

4.      Isacord 40   2721

5.      Isacord 40   2152

6.      Isacord 40   1310

7.      Isacord 40   3210

8.      Isacord 40   5912

9.      Isacord 40   0600

10.      Isacord 40   1800 11.      Isacord 40   3510 12.      Isacord 40   3713

13.      Isacord 40   0015 14.      Isacord 40   0015

Pk50017-02 139 x 208 mm
5.5 x 8.2 inch

21.837

1.      Isacord 40   5326

2.      Isacord 40   5513

3.      Isacord 40   5450

4.      Isacord 40   5912

5.      Isacord 40   3541

6.      Isacord 40   2508

7.      Isacord 40   2721

8.      Isacord 40   3210

9.      Isacord 40   3510

10.      Isacord 40   3713 11.      Isacord 40   0600 12.      Isacord 40   1310

13.      Isacord 40   1800 14.      Isacord 40   0015 15.      Isacord 40   0015

51220-09 119 x 132 mm
4.7 x 5.2 inch

31.868

1.      Isacord 40   0630

2.      Isacord 40   2521

3.      Isacord 40   4152

4.      Isacord 40   1332

5.      Isacord 40   0020

51221-04 124 x 171 mm
4.9 x 6.7 inch

21.180

1.      Isacord 40   5100

2.      Isacord 40   4010

3.      Isacord 40   4643

4.      Isacord 40   5210

Pk50012-02 142 x 142 mm
5.6 x 5.6 inch

12.960

1.      Isacord 40   5830

2.      Isacord 40   2810

3.      Isacord 40   2300

4.      Isacord 40   5100

5.      Isacord 40   2732

6.      Isacord 40   1030

7.      Isacord 40   2650

8.      Isacord 40   4111

Pk50012-04 78 x 205 mm
3.1 x 8.1 inch

9.480

1.      Isacord 40   5830

2.      Isacord 40   2810

3.      Isacord 40   2732

4.      Isacord 40   2300

5.      Isacord 40   5100

6.      Isacord 40   1030

7.      Isacord 40   2650

8.      Isacord 40   4111
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19.10 Animals

12375-04 129 x 71 mm
5.1 x 2.8 inch

8.191

1.      Isacord 40   0811

2.      Isacord 40   0020

3.      Isacord 40   3630

4.      Isacord 40   5722

12375-09 158 x 217 mm
6.2 x 8.6 inch

18.055

1.      Isacord 40   3251

2.      Isacord 40   2532

3.      Isacord 40   1906

4.      Isacord 40   5722

5.      Isacord 40   3630

6.      Isacord 40   0811

7.      Isacord 40   1304

8.      Isacord 40   0105

9.      Isacord 40   0020

12418-03 80 x 101 mm
3.2 x 4 inch

13.696

1.      Isacord 40   0870

2.      Isacord 40   1055

3.      Isacord 40   1123

4.      Isacord 40   0842

5.      Isacord 40   1154

6.      Isacord 40   0853

7.      Isacord 40   0945

8.      Isacord 40   4174

9.      Isacord 40   0101

10.      Isacord 40   6141 11.      Isacord 40   5822

12441-37 116 x 103 mm
4.6 x 4 inch

4.741

1.      Isacord 40   1900

12454-14 64 x 31 mm
2.5 x 1.2 inch

6.666

1.      Isacord 40   3810

2.      Yenmet   7037

3.      Isacord 40   3732

4.      Isacord 40   0020

5.      Isacord 40   0015

6.      Isacord 40   3810

12550-06 113 x 141 mm
4.5 x 5.6 inch

8.738

1.      Isacord 40   0352

2.      Isacord 40   5230

3.      Isacord 40   1061

4.      Isacord 40   1220

5.      Isacord 40   1565

12576-04 176 x 127 mm
6.9 x 5 inch

21.242

1.      Isacord 40   2022

2.      Isacord 40   3444

3.      Isacord 40   1322

12662-08 105 x 109 mm
4.1 x 4.3 inch

12.928

1.      Isacord 40   1032

2.      Isacord 40   1032

3.      Isacord 40   1032

4.      Isacord 40   1010

5.      Isacord 40   0015

6.      Isacord 40   5822

7.      Isacord 40   4220

8.      Isacord 40   4531

9.      Isacord 40   1055

10.      Isacord 40   0576

12672-01 138 x 137 mm
5.4 x 5.4 inch

30.972

1.      Isacord 40   0015

2.      Isacord 40   2600

3.      Isacord 40   2655

4.      Isacord 40   2250

5.      Isacord 40   2510

6.      Isacord 40   2702

12712-03 126 x 188 mm
5 x 7.4 inch

20.165

1.      Isacord 40   1362

2.      Isacord 40   1220

3.      Isacord 40   1301

4.      Isacord 40   1301

5.      Isacord 40   4174
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12878-01 141 x 112 mm
5.6 x 4.4 inch

8.899

1.      Isacord 40   3852

2.      Isacord 40   1362

3.      Isacord 40   1030

4.      Isacord 40   4250

5.      Isacord 40   4430

12729-02 137 x 214 mm
5.4 x 8.4 inch

18.286

1.      Isacord 40   1010

2.      Isacord 40   0124

3.      Isacord 40   0132

12745-01 109 x 122 mm
4.3 x 4.8 inch

15.872

1.      Isacord 40   1912

2.      Isacord 40   1725

3.      Isacord 40   1904

4.      Isacord 40   2115

5.      Isacord 40   0853

6.      Isacord 40   0945

7.      Isacord 40   4174

8.      Isacord 40   0020

9.      Isacord 40   1310

10.      Isacord 40   0904 11.      Isacord 40   0010

12760-01 128 x 179 mm
5.1 x 7 inch

36.480

1.      Isacord 40   0020

12760-03 106 x 169 mm
4.2 x 6.7 inch

22.971

1.      Isacord 40   0020

12791-01L 203 x 241 mm
8 x 9.5 inch

34.026

1.      Isacord 40   4174

2.      Isacord 40   0310

3.      Isacord 40   3910

4.      Isacord 40   2363

5.      Isacord 40   5515

6.      Isacord 40   0904

7.      Isacord 40   1940

8.      Isacord 40   2504

9.      Isacord 40   2520

10.      Isacord 40   4116

12791-01s 126 x 150 mm
5 x 5.9 inch

20.066

1.      Isacord 40   4174

2.      Isacord 40   0310

3.      Isacord 40   3910

4.      Isacord 40   2363

5.      Isacord 40   5515

6.      Isacord 40   0904

7.      Isacord 40   1940

8.      Isacord 40   2504

9.      Isacord 40   2520

10.      Isacord 40   4116

12791-04L 203 x 207 mm
8 x 8.1 inch

15.540

1.      Isacord 40   4174

2.      Isacord 40   4174

3.      Isacord 40   1900

4.      Isacord 40   4174

5.      Isacord 40   0310

6.      Isacord 40   4174

12824-01l 195 x 198 mm
7.7 x 7.8 inch

21.735

1.      Isacord 40   0922

2.      Isacord 40   1134

3.      Isacord 40   1172

4.      Isacord 40   0945

12824-03M 144 x 150 mm
5.7 x 5.9 inch

11.307

1.      Isacord 40   1134

2.      Isacord 40   0922

3.      Isacord 40   1172

4.      Isacord 40   0945
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12824-05s 115 x 117 mm
4.5 x 4.6 inch

12.463

1.      Isacord 40   0945

2.      Isacord 40   1134

3.      Isacord 40   1172

4.      Isacord 40   0922

12910-03 142 x 118 mm
5.6 x 4.6 inch

18.848

1.      Isacord 40   0853

2.      Isacord 40   0870

3.      Isacord 40   0832

4.      Isacord 40   1755

5.      Isacord 40   2211

6.      Isacord 40   2153

7.      Isacord 40   1565

51202-02 114 x 145 mm
4.5 x 5.7 inch

12.428

1.      Isacord 40   0010

2.      Isacord 40   2762

3.      Isacord 40   0182

4.      Isacord 40   2776

5.      Isacord 40   2152

6.      Isacord 40   0020

7.      Isacord 40   0310

8.      Isacord 40   1755

9.      Isacord 40   5770

10.      Isacord 40   5822 11.      Isacord 40   1911 12.      Isacord 40   1921

13.      Isacord 40   1430 14.      Isacord 40   1532 15.      Isacord 40   1362

16.      Isacord 40   2153 17.      Isacord 40   2152 18.      Isacord 40   2155

19.      Isacord 40   2171 20.      Isacord 40   0010

51202-04 83 x 152 mm
3.3 x 6 inch

11.330

1.      Isacord 40   2155

2.      Isacord 40   2152

3.      Isacord 40   2171

4.      Isacord 40   1755

5.      Isacord 40   0010

6.      Isacord 40   2776

51202-07 120 x 153 mm
4.7 x 6 inch

27.553

1.      Isacord 40   2152

2.      Isacord 40   2153

3.      Isacord 40   6043

4.      Isacord 40   5933

5.      Isacord 40   5643

6.      Isacord 40   5555

7.      Isacord 40   0010

8.      Isacord 40   0182

9.      Isacord 40   2762

10.      Isacord 40   2776 11.      Isacord 40   0310 12.      Isacord 40   2152

13.      Isacord 40   1921 14.      Isacord 40   1911 15.      Isacord 40   1755

16.      Isacord 40   2152 17.      Isacord 40   1921 18.      Isacord 40   0310

19.      Isacord 40   0622 20.      Isacord 40   5770 21.      Isacord 40   5822

51202-08 75 x 165 mm
2.9 x 6.5 inch

7.518

1.      Isacord 40   2152

2.      Isacord 40   1921

51208-04 113 x 172 mm
4.5 x 6.8 inch

22.742

1.      Isacord 40   1220

2.      Isacord 40   1321

3.      Isacord 40   0020

51208-11 120 x 159 mm
4.7 x 6.3 inch

21.602

1.      Isacord 40   1800

2.      Isacord 40   2011

3.      Isacord 40   0020

4.      Isacord 40   0131
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51212-05 106 x 178 mm
4.2 x 7 inch

28.067

1.      Isacord 40   1114

2.      Isacord 40   1030

3.      Isacord 40   0761

4.      Isacord 40   0442

5.      Isacord 40   6133

6.      Isacord 40   2504

7.      Isacord 40   4220

8.      Isacord 40   5866

9.      Isacord 40   0020

10.      Isacord 40   0015 11.      Isacord 40   1030 12.      Isacord 40   1321

51212-15 134 x 76 mm
5.3 x 3 inch

12.900

1.      Isacord 40   1140

2.      Isacord 40   0945

3.      Isacord 40   0442

4.      Isacord 40   1351

5.      Isacord 40   4220

6.      Isacord 40   1321

7.      Isacord 40   2504

8.      Isacord 40   1252

9.      Isacord 40   0020

10.      Isacord 40   1140

51274-04 89 x 140 mm
3.5 x 5.5 inch

33.260

1.      Isacord 40   2170

2.      Isacord 40   1860

3.      Isacord 40   2051

4.      Isacord 40   0761

5.      Isacord 40   1123

6.      Isacord 40   0853

7.      Isacord 40   1134

8.      Isacord 40   0945

9.      Isacord 40   0010

10.      Isacord 40   5542 11.      Isacord 40   0020 12.      Isacord 40   1375

13.      Isacord 40   2051 14.      Isacord 40   1123 15.      Isacord 40   4174

16.      Isacord 40   0020 17.      Isacord 40   0108 18.      Isacord 40   0010

51274-05 82 x 177 mm
3.2 x 7 inch

28.909

1.      Isacord 40   2170

2.      Isacord 40   1860

3.      Isacord 40   2051

4.      Isacord 40   0010

5.      Isacord 40   0761

6.      Isacord 40   1123

7.      Isacord 40   2051

8.      Isacord 40   1543

9.      Isacord 40   4174

10.      Isacord 40   0020 11.      Isacord 40   0853 12.      Isacord 40   0945

13.      Isacord 40   4174 14.      Isacord 40   0010

51278-06 170 x 117 mm
6.7 x 4.6 inch

15.393

1.      Isacord 40   1260

2.      Isacord 40   0731

51278-08 82 x 165 mm
3.2 x 6.5 inch

4.893

1.      Isacord 40   0731

2.      Isacord 40   1260

51289-03 146 x 130 mm
5.7 x 5.1 inch

13.672

1.      Isacord 40   4740

2.      Isacord 40   0010

3.      Isacord 40   4410

4.      Isacord 40   4610

5.      Isacord 40   4643

6.      Isacord 40   4410

7.      Isacord 40   4610

8.      Isacord 40   4740

9.      Isacord 40   5643

10.      Isacord 40   5510 11.      Isacord 40   0010 12.      Isacord 40   0622

80020-26 72 x 49 mm
2.8 x 1.9 inch

7.005

1.      Isacord 40   6141

2.      Isacord 40   5822

3.      Isacord 40   0453

4.      Isacord 40   0270

5.      Isacord 40   5833
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80126-02 75 x 144 mm
2.9 x 5.7 inch

25.466

1.      Isacord 40   1755

2.      Isacord 40   0670

3.      Isacord 40   0771

4.      Isacord 40   0853

5.      Isacord 40   0862

6.      Isacord 40   0132

7.      Isacord 40   5912

8.      Isacord 40   0015

9.      Isacord 40   0020

10.      Isacord 40   2152

80126-09 92 x 115 mm
3.6 x 4.5 inch

22.536

1.      Isacord 40   0101

2.      Isacord 40   0105

3.      Isacord 40   3265

4.      Isacord 40   0112

5.      Isacord 40   4174

6.      Isacord 40   6011

7.      Isacord 40   1755

8.      Isacord 40   0020

9.      Isacord 40   3971

10.      Isacord 40   0101

82010-15 123 x 124 mm
4.9 x 4.9 inch

11.769

1.      Isacord 40   0721

2.      Isacord 40   4620

3.      Isacord 40   0352

4.      Isacord 40   0672

5.      Isacord 40   0152

Cm421_48 54 x 71 mm
2.1 x 2.8 inch

3.719

1.      Isacord 40   2155

2.      Isacord 40   0015

3.      Isacord 40   2155

4.      Isacord 40   3045

5.      Isacord 40   2640

6.      Isacord 40   3130

7.      Isacord 40   2520

Cm621_48 111 x 166 mm
4.4 x 6.6 inch

19.059

1.      Isacord 40   0015

2.      Isacord 40   2250

3.      Isacord 40   3971

4.      Isacord 40   0552

5.      Isacord 40   0131

6.      Isacord 40   0108

7.      Isacord 40   0138

8.      Isacord 40   6133

9.      Isacord 40   0352

10.      Isacord 40   0020 11.      Isacord 40   0015 12.      Isacord 40   5730

13.      Isacord 40   5740 14.      Isacord 40   3953

Fm987 88 x 77 mm
3.5 x 3 inch

3.297

1.      YLI variations   8010

2.      Isacord 40   3040

3.      Isacord 40   0504

Fq518_48 90 x 114 mm
3.5 x 4.5 inch

4.269

1.      YLI variations   8006

2.      Isacord 40   9916

3.      Isacord 40   9605

4.      YLI variations   8008

5.      YLI variations   8014

6.      YLI variations   8009

7.      Isacord 40   9914

Fq520_48 257 x 212 mm
10.1 x 8.4 inch

15.274

1.      YLI variations   8010

2.      YLI variations   8004

3.      YLI variations   8023

4.      Isacord 40   9805

5.      Isacord 40   9405

6.      YLI variations   8023

7.      YLI variations   8006

8.      YLI variations   8019

9.      Isacord 40   9912

10.      Isacord 40   9918 11.      YLI variations   8020 12.      YLI variations   8006

13.      Isacord 40   9916 14.      Isacord 40   9605 15.      YLI variations   8008

16.      YLI variations   8009 17.      Isacord 40   9914 18.      Isacord 40   9405

19.      Isacord 40   9916 20.      Isacord 40   9302 21.      Isacord 40   9805

22.      YLI variations   8019 23.      Isacord 40   9405 24.      YLI variations   8020

25.      Isacord 40   9605 26.      YLI variations   8009 27.      YLI variations   8021

28.      YLI variations   8014
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Wo379 72 x 94 mm
2.8 x 3.7 inch

14.396

1.      Isacord 40   3951

2.      Isacord 40   5643

3.      Isacord 40   5912

4.      Isacord 40   0520

5.      Isacord 40   5866

6.      Isacord 40   5500

7.      Isacord 40   5422

8.      Isacord 40   0640

9.      Isacord 40   0310

10.      Isacord 40   0800 11.      Isacord 40   0853 12.      Isacord 40   4101

13.      Isacord 40   0015 14.      Isacord 40   0520 15.      Isacord 40   1430

16.      Isacord 40   2224 17.      Isacord 40   3522

Wp358_48 52 x 91 mm
2.1 x 3.6 inch

5.774

1.      Isacord 40   1375

Wp380_48 80 x 116 mm
3.2 x 4.6 inch

4.638

1.      Isacord 40   0020

Wp383_48 71 x 82 mm
2.8 x 3.2 inch

13.891

1.      Isacord 40   0352

2.      Isacord 40   5833

3.      Isacord 40   0015

4.      Isacord 40   1874

5.      Isacord 40   0150

6.      Isacord 40   4174

7.      Isacord 40   0020

8.      Isacord 40   0015

9.      Isacord 40   4174

Wp389_48 154 x 327 mm
6.1 x 12.9 inch

53.330

1.      Isacord 40   5822

2.      Isacord 40   0651

3.      Isacord 40   0015

4.      Isacord 40   0842

5.      Isacord 40   1755

6.      Isacord 40   0853

7.      Isacord 40   1055

8.      Isacord 40   1233

9.      Isacord 40   1123

10.      Isacord 40   0945 11.      Isacord 40   0150 12.      Isacord 40   0111

13.      Isacord 40   1430 14.      Isacord 40   0020 15.      Isacord 40   0131

16.      Isacord 40   3971 17.      Isacord 40   2674 18.      Isacord 40   0111

19.      Isacord 40   0108 20.      Isacord 40   0132 21.      Isacord 40   4174

22.      Isacord 40   0020 23.      Isacord 40   0015 24.      Isacord 40   5833

51255-03 80 x 75 mm
3.2 x 2.9 inch

6.458

1.      Isacord 40   0660

2.      Isacord 40   0506

3.      Isacord 40   4174

4.      Isacord 40   0660

51268-05 111 x 159 mm
4.4 x 6.3 inch

29.299

1.      Isacord 40   2170

2.      Isacord 40   2171

3.      Isacord 40   0015

4.      Isacord 40   1755

5.      Isacord 40   2051

6.      Isacord 40   1543

7.      Isacord 40   6051

8.      Isacord 40   5833

9.      Isacord 40   0465

10.      Isacord 40   2550 11.      Isacord 40   2532 12.      Isacord 40   2170

13.      Isacord 40   2222 14.      Isacord 40   1060 15.      Isacord 40   1760

16.      Isacord 40   1010 17.      Isacord 40   0931 18.      Isacord 40   0015

19.      Isacord 40   0853 20.      Isacord 40   4174 21.      Yenmet   7011
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19.11 Children

12435-22 140 x 122 mm
5.5 x 4.8 inch

18.579

1.      Isacord 40   1755

2.      Isacord 40   2250

3.      Yenmet   7028

4.      Isacord 40   2640

5.      Yenmet   7023

6.      Isacord 40   2912

7.      Yenmet   7025

8.      Isacord 40   4174

9.      Yenmet   7028

12440-01 81 x 100 mm
3.2 x 3.9 inch

7.339

1.      Isacord 40   1543

2.      Isacord 40   2761

3.      Isacord 40   1876

4.      Isacord 40   1521

12440-05 50 x 109 mm
2 x 4.3 inch

7.603

1.      Isacord 40   1543

2.      Isacord 40   1521

3.      Isacord 40   0870

4.      Isacord 40   2761

5.      Isacord 40   1876

12440-07 173 x 26 mm
6.8 x 1 inch

5.900

1.      Isacord 40   2761

2.      Isacord 40   1521

3.      Isacord 40   0546

4.      Isacord 40   1543

5.      Isacord 40   6133

12440-08 97 x 149 mm
3.8 x 5.9 inch

13.511

1.      Isacord 40   2761

2.      Isacord 40   1521

3.      Isacord 40   1543

4.      Isacord 40   0546

5.      Isacord 40   6133

6.      Isacord 40   1876

12440-09 119 x 172 mm
4.7 x 6.8 inch

15.037

1.      Isacord 40   0546

2.      Isacord 40   2761

3.      Isacord 40   1521

4.      Isacord 40   1543

5.      Isacord 40   1876

6.      Isacord 40   6133

12590-04 104 x 158 mm
4.1 x 6.2 inch

24.036

1.      Isacord 40   5740

2.      Isacord 40   5740

3.      Isacord 40   5740

4.      Isacord 40   5740

5.      Isacord 40   5740

6.      Isacord 40   5740

7.      Isacord 40   5740

8.      Isacord 40   5740

9.      Isacord 40   5740

10.      Isacord 40   0015 11.      Isacord 40   0020 12.      Isacord 40   4230

13.      Isacord 40   4116 14.      Isacord 40   5510 15.      Isacord 40   0132

16.      Isacord 40   0112 17.      Isacord 40   0132 18.      Isacord 40   0015

12685-01 90 x 157 mm
3.6 x 6.2 inch

16.660

1.      Isacord 40   0015

2.      Isacord 40   0015

3.      Isacord 40   0015

4.      Isacord 40   0015

5.      Isacord 40   0015

6.      Isacord 40   1140

7.      Isacord 40   4174

8.      Isacord 40   2152

9.      Isacord 40   5115

10.      Isacord 40   5513 11.      Isacord 40   2051 12.      Isacord 40   1010
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51201-01 66 x 152 mm
2.6 x 6 inch

18.346

1.      Isacord 40   3150

2.      Isacord 40   3810

3.      Isacord 40   4752

4.      Isacord 40   2152

5.      Isacord 40   2650

6.      Isacord 40   0020

7.      Isacord 40   2954

8.      Isacord 40   0015

9.      Isacord 40   2152

10.      Isacord 40   3150

51201-02 111 x 107 mm
4.4 x 4.2 inch

12.343

1.      Isacord 40   4752

2.      Isacord 40   0015

3.      Isacord 40   3810

4.      Isacord 40   0020

5.      Isacord 40   0015

6.      Isacord 40   4752

7.      Isacord 40   2650

8.      Isacord 40   3641

9.      Isacord 40   3830

10.      Isacord 40   2711 11.      Isacord 40   2152

51201-08 120 x 145 mm
4.7 x 5.7 inch

32.284

1.      Isacord 40   3045

2.      Isacord 40   1060

3.      Isacord 40   2650

4.      Isacord 40   2241

5.      Isacord 40   2152

6.      Isacord 40   2530

7.      Isacord 40   0131

8.      Isacord 40   0020

9.      Isacord 40   0145

10.      Isacord 40   0142 11.      Isacord 40   0020

51201-11 120 x 114 mm
4.7 x 4.5 inch

20.909

1.      Isacord 40   2920

2.      Isacord 40   4752

3.      Isacord 40   2152

4.      Isacord 40   1060

5.      Isacord 40   0020

6.      Isacord 40   2954

7.      Isacord 40   2920

8.      Isacord 40   2650

9.      Isacord 40   0015

51201-13 78 x 127 mm
3.1 x 5 inch

10.998

1.      Isacord 40   4332

2.      Isacord 40   4752

3.      Isacord 40   2954

4.      Isacord 40   0015

5.      Isacord 40   0020

51201-14 67 x 101 mm
2.6 x 4 inch

10.020

1.      Isacord 40   1060

2.      Isacord 40   2920

3.      Isacord 40   2152

4.      Isacord 40   2241

5.      Isacord 40   0015

6.      Isacord 40   0020

51203-04 119 x 120 mm
4.7 x 4.7 inch

22.989

1.      Isacord 40   0010

2.      Isacord 40   0310

3.      Isacord 40   2155

4.      Isacord 40   2220

5.      Isacord 40   4116

6.      Isacord 40   2920

7.      Isacord 40   4174

8.      Isacord 40   5643

9.      Isacord 40   0520

10.      Isacord 40   5832 11.      Isacord 40   2220 12.      Isacord 40   2920

13.      Isacord 40   2155 14.      Isacord 40   0010

51203-06 120 x 140 mm
4.7 x 5.5 inch

17.006

1.      Isacord 40   0310

2.      Isacord 40   2155

3.      Isacord 40   0010

4.      Isacord 40   5643

5.      Isacord 40   5832

6.      Isacord 40   4116

7.      Isacord 40   2920

8.      Isacord 40   2155

9.      Isacord 40   0310

10.      Isacord 40   2152 11.      Isacord 40   0010 12.      Isacord 40   4174
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51211-04 106 x 172 mm
4.2 x 6.8 inch

18.131

1.      Isacord 40   0138

2.      Isacord 40   0138

3.      Isacord 40   0138

4.      Isacord 40   0138

5.      Isacord 40   0138

6.      Isacord 40   0138

7.      Isacord 40   0138

8.      Isacord 40   0138

9.      Isacord 40   0138

10.      Isacord 40   4174 11.      Isacord 40   0020 12.      Isacord 40   1972

13.      Isacord 40   0700 14.      Isacord 40   1904 15.      Isacord 40   2123

16.      Isacord 40   0184 17.      Isacord 40   1141 18.      Isacord 40   1252

19.      Isacord 40   6141 20.      Isacord 40   5833 21.      Isacord 40   5944

22.      Isacord 40   1760 23.      Isacord 40   0874

51211-14 82 x 169 mm
3.2 x 6.7 inch

12.945

1.      Isacord 40   1141

2.      Isacord 40   1141

3.      Isacord 40   1141

4.      Isacord 40   1141

5.      Isacord 40   1141

6.      Isacord 40   1141

7.      Isacord 40   1141

8.      Isacord 40   1141

9.      Isacord 40   1141

10.      Isacord 40   2123 11.      Isacord 40   3810 12.      Isacord 40   3630

13.      Isacord 40   3732 14.      Isacord 40   4074 15.      Isacord 40   1972

16.      Isacord 40   0020 17.      Isacord 40   0184 18.      Isacord 40   2123

19.      Isacord 40   0722 20.      Isacord 40   0020 21.      Isacord 40   1760

22.      Isacord 40   0874 23.      Isacord 40   0015 24.      Isacord 40   0232

25.      Isacord 40   5832

51211-15 135 x 153 mm
5.3 x 6 inch

31.240

1.      Isacord 40   2123

2.      Isacord 40   2123

3.      Isacord 40   2123

4.      Isacord 40   2123

5.      Isacord 40   2123

6.      Isacord 40   2123

7.      Isacord 40   2123

8.      Isacord 40   2123

9.      Isacord 40   2123

10.      Isacord 40   5832 11.      Isacord 40   0352 12.      Isacord 40   4074

13.      Isacord 40   4174 14.      Isacord 40   0020 15.      Isacord 40   0700

16.      Isacord 40   1760 17.      Isacord 40   3815 18.      Isacord 40   6141

19.      Isacord 40   5833 20.      Isacord 40   4122 21.      Isacord 40   0015

22.      Isacord 40   3732 23.      Isacord 40   4101 24.      Isacord 40   1904

25.      Isacord 40   5832 26.      Isacord 40   0640 27.      Isacord 40   2115

28.      Isacord 40   0184 29.      Isacord 40   5944 30.      Isacord 40   1760

31.      Isacord 40   0874 32.      Isacord 40   0142

51211-16 111 x 144 mm
4.4 x 5.7 inch

8.230

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

4.      Isacord 40   0015

5.      Isacord 40   2123

51237-06 39 x 139 mm
1.5 x 5.5 inch

8.619

1.      Isacord 40   1703

2.      Isacord 40   1010

3.      Isacord 40   1030

4.      Isacord 40   4620

5.      Isacord 40   0945

6.      Isacord 40   1565

7.      Isacord 40   0576

51240-27 87 x 80 mm
3.4 x 3.2 inch

4.258

1.      Isacord 40   0630

2.      Isacord 40   0630

3.      Isacord 40   0630

4.      Isacord 40   1332

5.      Isacord 40   0811

6.      Isacord 40   1322

7.      Isacord 40   0020

51240-28 76 x 130 mm
3 x 5.1 inch

6.028

1.      Isacord 40   1332

2.      Isacord 40   0811

3.      Isacord 40   3963

4.      Isacord 40   3910

5.      Isacord 40   3810

6.      Isacord 40   0010

7.      Isacord 40   0131

8.      Isacord 40   1913

9.      Isacord 40   1521

10.      Isacord 40   2123 11.      Isacord 40   1322 12.      Isacord 40   0020

13.      Isacord 40   0020

51240-31 87 x 83 mm
3.4 x 3.3 inch

3.327

1.      Isacord 40   0010

2.      Isacord 40   0010

3.      Isacord 40   0010

4.      Isacord 40   0811

5.      Isacord 40   0020
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51240-32 76 x 142 mm
3 x 5.6 inch

3.835

1.      Isacord 40   0010

2.      Isacord 40   0811

3.      Isacord 40   5450

4.      Isacord 40   4752

5.      Isacord 40   1725

6.      Isacord 40   0010

7.      Isacord 40   3743

8.      Isacord 40   1725

9.      Isacord 40   0020

10.      Isacord 40   0020

51240-35 89 x 83 mm
3.5 x 3.3 inch

2.628

1.      Isacord 40   0020

2.      Isacord 40   3641

3.      Isacord 40   3641

4.      Isacord 40   3963

5.      Isacord 40   3743

6.      Isacord 40   0020

51240-36 92 x 141 mm
3.6 x 5.5 inch

5.338

1.      Isacord 40   3641

2.      Isacord 40   3963

3.      Isacord 40   3743

4.      Isacord 40   0020

5.      Isacord 40   0020

51267-07 99 x 144 mm
3.9 x 5.7 inch

18.599

1.      Isacord 40   4250

2.      Isacord 40   4610

3.      Isacord 40   1060

4.      Isacord 40   1030

5.      Isacord 40   1310

6.      Isacord 40   2155

7.      Isacord 40   1753

8.      Isacord 40   4133

Cj500 108 x 51 mm
4.2 x 2 inch

14.381

1.      Isacord 40   0015

2.      Isacord 40   1860

3.      Isacord 40   0182

4.      Isacord 40   0651

5.      Isacord 40   0853

6.      Isacord 40   1366

7.      Isacord 40   4174

8.      Isacord 40   1060

9.      Isacord 40   0640

10.      Isacord 40   1346

Cj959 92 x 99 mm
3.6 x 3.9 inch

11.127

1.      Isacord 40   4230

2.      Isacord 40   3840

3.      Isacord 40   3650

4.      Isacord 40   1430

5.      Isacord 40   0520

6.      Isacord 40   1351

7.      Isacord 40   1600

8.      Isacord 40   0310

9.      Isacord 40   2560

10.      Isacord 40   2241 11.      Isacord 40   0015 12.      Isacord 40   3815

13.      Isacord 40   5650 14.      Isacord 40   5610

Cj965 98 x 90 mm
3.9 x 3.6 inch

13.166

1.      Isacord 40   0015

2.      Isacord 40   3815

3.      Isacord 40   4230

4.      Isacord 40   5650

5.      Isacord 40   5115

6.      Isacord 40   5220

7.      Isacord 40   0704

8.      Isacord 40   1430

9.      Isacord 40   5210

10.      Isacord 40   3045 11.      Isacord 40   0630 12.      Isacord 40   1301

13.      Isacord 40   2830

Ck174 90 x 99 mm
3.5 x 3.9 inch

13.388

1.      Isacord 40   2051

2.      Isacord 40   0630

3.      Isacord 40   5833

4.      Isacord 40   0622

5.      Isacord 40   1010

6.      Isacord 40   0250

7.      Isacord 40   3762

8.      Isacord 40   4230

9.      Isacord 40   4452
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Ck254 91 x 99 mm
3.6 x 3.9 inch

15.229

1.      Isacord 40   5833

2.      Isacord 40   0640

3.      Isacord 40   3150

4.      Isacord 40   3241

5.      Isacord 40   5770

6.      Isacord 40   0520

7.      Isacord 40   4071

8.      Isacord 40   2920

9.      Isacord 40   1730

10.      Isacord 40   0111 11.      Isacord 40   0670 12.      Isacord 40   5650

13.      Isacord 40   4174 14.      Isacord 40   5531 15.      Isacord 40   5610

16.      Isacord 40   5510

Ck255 92 x 99 mm
3.6 x 3.9 inch

15.339

1.      Isacord 40   5833

2.      Isacord 40   5770

3.      Isacord 40   5740

4.      Isacord 40   5833

5.      Isacord 40   1755

6.      Isacord 40   2530

7.      Isacord 40   2155

8.      Isacord 40   0520

9.      Isacord 40   2220

10.      Isacord 40   2171 11.      Isacord 40   2761 12.      Isacord 40   3150

13.      Isacord 40   3151 14.      Isacord 40   4071 15.      Isacord 40   3710

16.      Isacord 40   2920

Ck518 76 x 67 mm
3 x 2.6 inch

14.433

1.      Isacord 40   0132

2.      Isacord 40   0310

3.      Isacord 40   0015

4.      Isacord 40   3901

5.      Yenmet   7000

6.      Isacord 40   4073

7.      Isacord 40   0310

8.      Yenmet   7013

9.      Isacord 40   1703

10.      Isacord 40   0020 11.      Isacord 40   1902 12.      Isacord 40   3323

13.      Isacord 40   0310

Ck524 76 x 72 mm
3 x 2.8 inch

11.188

1.      Isacord 40   0108

2.      Isacord 40   3910

3.      Isacord 40   0142

4.      Isacord 40   4174

5.      Isacord 40   5610

6.      Isacord 40   1703

7.      Isacord 40   1903

8.      Isacord 40   5944

Ck978 49 x 42 mm
1.9 x 1.7 inch

3.640

1.      Isacord 40   2560

2.      Isacord 40   2220

3.      Isacord 40   0015

4.      Isacord 40   4071

5.      Isacord 40   3641

Ck991 65 x 86 mm
2.6 x 3.4 inch

4.726

1.      Isacord 40   1904

2.      Isacord 40   0015

3.      Isacord 40   4071

4.      Isacord 40   0108

Cm200_48 94 x 109 mm
3.7 x 4.3 inch

9.623

1.      Isacord 40   1840

2.      Isacord 40   2220

3.      Isacord 40   1351

4.      Isacord 40   1430

5.      Isacord 40   1730

6.      Isacord 40   4174

7.      Isacord 40   0552

8.      Isacord 40   0232

9.      Isacord 40   1840

10.      Isacord 40   1730 11.      Isacord 40   2171 12.      Isacord 40   2250

Cm222_48 41 x 61 mm
1.6 x 2.4 inch

5.951

1.      Isacord 40   0101

2.      Isacord 40   0934

3.      Isacord 40   0015

4.      Isacord 40   0020

5.      Isacord 40   0853

6.      Isacord 40   0945

7.      Isacord 40   0870

8.      Isacord 40   0672

9.      Isacord 40   0811
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Cm420_48 88 x 145 mm
3.5 x 5.7 inch

20.513

1.      Isacord 40   0970

2.      Isacord 40   0124

3.      Isacord 40   0670

4.      Isacord 40   0015

5.      Isacord 40   0970

6.      Isacord 40   6141

7.      Isacord 40   2155

8.      Isacord 40   2171

9.      Isacord 40   2152

10.      Isacord 40   1172 11.      Isacord 40   0020 12.      Isacord 40   0853

13.      Isacord 40   5822 14.      Isacord 40   5833 15.      Isacord 40   0015

16.      Isacord 40   3045 17.      Isacord 40   2764

12426-01 71 x 212 mm
2.8 x 8.3 inch

6.671

1.      Isacord 40   1972

2.      Isacord 40   0015

3.      Isacord 40   3901

4.      Isacord 40   3920

5.      Isacord 40   2521

6.      Isacord 40   1904

7.      Isacord 40   2910

8.      Isacord 40   0230

9.      Isacord 40   0520

10.      Isacord 40   0506 11.      Isacord 40   0800 12.      Isacord 40   1730

19.12 Baby

12662-03 120 x 118 mm
4.7 x 4.6 inch

15.046

1.      Isacord 40   1133

2.      Isacord 40   1133

3.      Isacord 40   1133

4.      Isacord 40   0015

5.      Isacord 40   3150

6.      Isacord 40   4620

7.      Isacord 40   2764

8.      Isacord 40   2600

9.      Isacord 40   1543

10.      Isacord 40   1565

12662-05 131 x 100 mm
5.1 x 3.9 inch

11.823

1.      Isacord 40   0672

2.      Isacord 40   0672

3.      Isacord 40   0672

4.      Isacord 40   6051

5.      Isacord 40   2532

6.      Isacord 40   0741

7.      Isacord 40   0576

12662-09 112 x 133 mm
4.4 x 5.2 inch

14.365

1.      Isacord 40   2532

2.      Isacord 40   2532

3.      Isacord 40   2532

4.      Isacord 40   0015

5.      Isacord 40   5531

6.      Isacord 40   0221

7.      Isacord 40   2510

12662-10 137 x 124 mm
5.4 x 4.9 inch

13.689

1.      Isacord 40   5722

2.      Isacord 40   5722

3.      Isacord 40   5722

4.      Isacord 40   0015

5.      Isacord 40   3030

6.      Isacord 40   4421

7.      Isacord 40   5050

8.      Isacord 40   5944

9.      Isacord 40   5933

10.      Isacord 40   2864

12663-21 114 x 75 mm
4.5 x 2.9 inch

4.427

1.      Isacord 40   1140

2.      Isacord 40   1140

3.      Isacord 40   1140

4.      Isacord 40   1140

5.      Isacord 40   3631

6.      Isacord 40   1140

7.      Isacord 40   0020

12663-22 79 x 121 mm
3.1 x 4.8 inch

5.861

1.      Isacord 40   0781

2.      Isacord 40   0781

3.      Isacord 40   0934

4.      Isacord 40   1521

5.      Isacord 40   1140

6.      Isacord 40   0781

7.      Isacord 40   0020
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51272-07 117 x 147 mm
4.6 x 5.8 inch

21.530

1.      Isacord 40   2153

2.      Isacord 40   4250

3.      Isacord 40   3750

4.      Isacord 40   3971

5.      Isacord 40   0970

6.      Isacord 40   0184

7.      Isacord 40   1760

8.      Isacord 40   4174

9.      Isacord 40   2153

Cj346 96 x 106 mm
3.8 x 4.2 inch

21.486

1.      Isacord 40   0015

2.      Isacord 40   2152

3.      Isacord 40   0640

4.      Isacord 40   0552

5.      Isacord 40   0124

6.      Isacord 40   0520

7.      Isacord 40   1220

8.      Isacord 40   3962

9.      Isacord 40   1362

10.      Isacord 40   0015 11.      Isacord 40   0660 12.      Isacord 40   0853

13.      Isacord 40   3910

Cj529 76 x 73 mm
3 x 2.9 inch

10.846

1.      Isacord 40   0660

2.      Isacord 40   3840

3.      Isacord 40   2155

4.      Isacord 40   3840

5.      Isacord 40   3650

6.      Isacord 40   0970

7.      Isacord 40   0851

8.      Isacord 40   3910

9.      Isacord 40   1055

Cj530 82 x 82 mm
3.2 x 3.2 inch

11.186

1.      Isacord 40   0870

2.      Isacord 40   2170

3.      Isacord 40   0015

4.      Isacord 40   3640

5.      Isacord 40   3820

6.      Isacord 40   1123

7.      Isacord 40   1055

8.      Isacord 40   0270

9.      Isacord 40   5912

10.      Isacord 40   2650 11.      Isacord 40   5513 12.      Isacord 40   2560

Cj843 77 x 68 mm
3 x 2.7 inch

7.631

1.      Isacord 40   0250

2.      Isacord 40   0221

3.      Isacord 40   2363

4.      Isacord 40   2560

5.      Isacord 40   4071

6.      Isacord 40   3640

7.      Isacord 40   0221

Ck225 99 x 71 mm
3.9 x 2.8 inch

13.775

1.      Isacord 40   2363

2.      Isacord 40   0250

3.      Isacord 40   0713

4.      Isacord 40   1060

5.      Isacord 40   1362

6.      Isacord 40   4071

7.      Isacord 40   2655

8.      Isacord 40   3040

9.      Isacord 40   1755

10.      Isacord 40   0015 11.      Isacord 40   3650 12.      Isacord 40   3840

Ck229 89 x 98 mm
3.5 x 3.9 inch

14.211

1.      Isacord 40   0015

2.      Isacord 40   3650

3.      Isacord 40   3840

4.      Isacord 40   2655

5.      Isacord 40   3040

6.      Isacord 40   2363

7.      Isacord 40   1755

8.      Isacord 40   2153

9.      Isacord 40   1060

10.      Isacord 40   1362 11.      Isacord 40   0250 12.      Isacord 40   0713

13.      Isacord 40   3045

Ck532 99 x 89 mm
3.9 x 3.5 inch

10.788

1.      Isacord 40   3962
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Ck533 93 x 98 mm
3.6 x 3.9 inch

9.424

1.      Isacord 40   2155

Ck742 88 x 89 mm
3.5 x 3.5 inch

7.575

1.      Isacord 40   4430

2.      Isacord 40   4240

3.      Isacord 40   6011

4.      Isacord 40   3150

5.      Isacord 40   3151

6.      Isacord 40   2560

7.      Isacord 40   2764

8.      Isacord 40   0221

9.      Isacord 40   0811

Ck747 74 x 96 mm
2.9 x 3.8 inch

7.051

1.      Isacord 40   5770

2.      Isacord 40   2155

3.      Isacord 40   0221

4.      Isacord 40   1161

5.      Isacord 40   0622

6.      Isacord 40   0853

Ck748 89 x 96 mm
3.5 x 3.8 inch

8.881

1.      Isacord 40   5531

2.      Isacord 40   6011

3.      Isacord 40   5610

4.      Isacord 40   6011

5.      Isacord 40   0811

6.      Isacord 40   1430

7.      Isacord 40   0015

8.      Isacord 40   3652

9.      Isacord 40   5610

10.      Isacord 40   0221 11.      Isacord 40   0542

Ck753 89 x 89 mm
3.5 x 3.5 inch

6.747

1.      Isacord 40   2761

2.      Isacord 40   0352

3.      Isacord 40   0221

4.      Isacord 40   3151

5.      Isacord 40   5740

6.      Isacord 40   3951

7.      Isacord 40   0811

8.      Isacord 40   1600

9.      Isacord 40   5531

Ck797 94 x 85 mm
3.7 x 3.4 inch

20.281

1.      Isacord 40   1141

2.      Isacord 40   1123

3.      Isacord 40   0651

4.      Isacord 40   0853

5.      Isacord 40   0870

6.      Isacord 40   2250

7.      Isacord 40   2152

8.      Isacord 40   0945

9.      Isacord 40   2241

10.      Isacord 40   0015 11.      Isacord 40   1911 12.      Isacord 40   0111

Ck811 73 x 94 mm
2.9 x 3.7 inch

14.250

1.      Isacord 40   3743

2.      Isacord 40   3951

3.      Isacord 40   3853

4.      Isacord 40   3953

5.      Isacord 40   0851

6.      Isacord 40   1161

7.      Isacord 40   0945

8.      Isacord 40   1123

9.      Isacord 40   0761

10.      Isacord 40   0506 11.      Isacord 40   0015 12.      Isacord 40   4174

13.      Isacord 40   0131

Ck909 80 x 92 mm
3.2 x 3.6 inch

13.707

1.      Isacord 40   3045

2.      Isacord 40   0015

3.      Isacord 40   0630

4.      Isacord 40   1532

5.      Isacord 40   1600

6.      Isacord 40   2363

7.      Isacord 40   2530

8.      Isacord 40   0532

9.      Isacord 40   1521

10.      Isacord 40   3650 11.      Isacord 40   3641 12.      Isacord 40   2363

13.      Isacord 40   2640 14.      Isacord 40   1521 15.      Isacord 40   2810

16.      Isacord 40   2152
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Cm021_48 88 x 98 mm
3.5 x 3.8 inch

11.964

1.      Isacord 40   0640

2.      Isacord 40   1755

3.      Isacord 40   2920

4.      Isacord 40   3040

5.      Isacord 40   5730

6.      Isacord 40   1840

7.      Isacord 40   1730

8.      Isacord 40   0630

9.      Isacord 40   0232

Cm028_48 95 x 96 mm
3.7 x 3.8 inch

9.639

1.      Isacord 40   0640

2.      Isacord 40   5730

3.      Isacord 40   4220

4.      Isacord 40   3820

5.      Isacord 40   2920

6.      Isacord 40   1730

7.      Isacord 40   1840

8.      Isacord 40   3040

9.      Isacord 40   1755

10.      Isacord 40   0934

Cm032_48 96 x 81 mm
3.8 x 3.2 inch

5.732

1.      Isacord 40   0640

2.      Isacord 40   5730

3.      Isacord 40   2920

4.      Isacord 40   1840

5.      Isacord 40   1730

6.      Isacord 40   1352

7.      Isacord 40   3040

8.      Isacord 40   4220

Cm223_48 50 x 28 mm
1.9 x 1.1 inch

2.154

1.      Isacord 40   0713

2.      Isacord 40   6141

3.      Isacord 40   5833

4.      Isacord 40   0811

5.      Isacord 40   0101

6.      Isacord 40   0020

12401-07 97 x 110 mm
3.8 x 4.3 inch

1.140

1.      Isacord 40   5934

2.      Isacord 40   0352

3.      Isacord 40   4240

4.      Isacord 40   1342

5.      Isacord 40   0731

6.      Isacord 40   0111

12432-20 126 x 114 mm
5 x 4.5 inch

6.317

1.      Isacord 40   1902

2.      Isacord 40   0105

3.      Isacord 40   0131

4.      Isacord 40   0132

5.      Isacord 40   4174

6.      Isacord 40   1902

12903-12 32 x 35 mm
1.2 x 1.4 inch

1.612

1.      Isacord 40   4740

2.      Isacord 40   5115

3.      Isacord 40   0660

12903-13 32 x 36 mm
1.3 x 1.4 inch

1.733

1.      Isacord 40   1860

2.      Isacord 40   0660

3.      Isacord 40   1840

12903-20 27 x 25 mm
1.1 x 1 inch

1.024

1.      Isacord 40   4740

2.      Isacord 40   1860

3.      Isacord 40   5115

Cm164_48 89 x 97 mm
3.5 x 3.8 inch

6.714

1.      Isacord 40   3640

2.      Isacord 40   0704

3.      Isacord 40   3251

4.      Isacord 40   6141

5.      Isacord 40   1755

6.      Isacord 40   0232
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19.13 Food and Drink

12611-17 73 x 110 mm
2.9 x 4.3 inch

4.622

1.      Isacord 40   1154

2.      Isacord 40   1154

3.      Isacord 40   1154

4.      Isacord 40   5440

5.      Isacord 40   0151

6.      Isacord 40   0152

12611-29 85 x 90 mm
3.3 x 3.6 inch

3.766

1.      Isacord 40   4220

2.      Isacord 40   1154

3.      Isacord 40   1902

12629-18 67 x 91 mm
2.6 x 3.6 inch

5.944

1.      Isacord 40   4220

2.      Isacord 40   4220

3.      Isacord 40   4220

4.      Isacord 40   4220

5.      Isacord 40   4220

6.      Isacord 40   4421

7.      Isacord 40   0015

8.      Isacord 40   4240

12655-13 110 x 126 mm
4.3 x 5 inch

10.045

1.      Isacord 40   1055

12773-04 50 x 47 mm
2 x 1.9 inch

7.561

1.      Isacord 40   5500

2.      Isacord 40   5830

3.      Isacord 40   2241

4.      Isacord 40   2160

5.      Isacord 40   0230

6.      Isacord 40   0520

7.      Isacord 40   2830

8.      Isacord 40   0015

9.      Isacord 40   0020

12773-12 52 x 39 mm
2 x 1.5 inch

4.997

1.      Isacord 40   0842

2.      Isacord 40   3840

3.      Isacord 40   5610

4.      Isacord 40   0101

5.      Isacord 40   2155

6.      Isacord 40   0020

12774-13 80 x 79 mm
3.2 x 3.1 inch

4.558

1.      Isacord 40   0020

12774-15 118 x 146 mm
4.6 x 5.7 inch

12.440

1.      Isacord 40   1133

2.      Isacord 40   1134

3.      Isacord 40   0101

4.      Isacord 40   0270

5.      Isacord 40   0250

6.      Isacord 40   0145

7.      Isacord 40   0015

8.      Isacord 40   3953

12843-08 129 x 172 mm
5.1 x 6.8 inch

13.522

1.      Isacord 40   0311

2.      Isacord 40   0520

3.      Isacord 40   0310

4.      Isacord 40   0010

5.      Isacord 40   5510

6.      Isacord 40   0520

7.      Isacord 40   5610

8.      Isacord 40   5740

9.      Isacord 40   0310

12843-10 87 x 163 mm
3.4 x 6.4 inch

12.094

1.      Isacord 40   0311

2.      Isacord 40   0310

3.      Isacord 40   0520

4.      Isacord 40   5740

5.      Isacord 40   5610

6.      Isacord 40   5510

7.      Isacord 40   0010

8.      Isacord 40   0310
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12932-07 127 x 178 mm
5 x 7 inch

13.885

1.      Isacord 40   1010

2.      Isacord 40   1010

3.      Isacord 40   0101

4.      Isacord 40   1921

5.      Isacord 40   1921

6.      Isacord 40   0101

51202-14 82 x 139 mm
3.2 x 5.5 inch

21.603

1.      Isacord 40   0622

2.      Isacord 40   2153

3.      Isacord 40   0310

4.      Isacord 40   5555

5.      Isacord 40   5513

6.      Isacord 40   6043

7.      Isacord 40   2153

51213-13 37 x 241 mm
1.5 x 9.5 inch

12.110

1.      Isacord 40   0741

2.      Isacord 40   4620

3.      Isacord 40   3645

4.      Isacord 40   2241

51287-06 76 x 103 mm
3 x 4.1 inch

4.474

1.      Isacord 40   3644

2.      Isacord 40   3910

3.      Isacord 40   3114

4.      Isacord 40   2732

5.      Isacord 40   0345

6.      Isacord 40   0501

Cj291 14 x 32 mm
0.6 x 1.2 inch

1.571

1.      Isacord 40   0832

2.      Isacord 40   0933

3.      Isacord 40   2550

4.      Isacord 40   5230

12462-01 115 x 124 mm
4.5 x 4.9 inch

6.903

1.      Isacord 40   5050

2.      Isacord 40   0310

3.      Isacord 40   1521

4.      Isacord 40   5730

5.      Isacord 40   0111

6.      Isacord 40   1430

7.      Isacord 40   5833

8.      Isacord 40   0015

12462-28 64 x 76 mm
2.5 x 3 inch

2.402

1.      Isacord 40   6031

2.      Isacord 40   5833

12776-01 115 x 143 mm
4.5 x 5.6 inch

11.582

1.      Isacord 40   6051

2.      Isacord 40   6051

3.      Isacord 40   6051

4.      Isacord 40   1430

5.      Isacord 40   1430

6.      Isacord 40   1430

7.      Isacord 40   1430

8.      Isacord 40   1430

9.      Isacord 40   0851

10.      Isacord 40   0670 11.      Isacord 40   0020 12.      Isacord 40   0941

13.      Isacord 40   1900

51255-04 108 x 172 mm
4.3 x 6.8 inch

17.184

1.      Isacord 40   0702

2.      Isacord 40   0800

3.      Isacord 40   0506

4.      Isacord 40   0605

5.      Isacord 40   0520

6.      Isacord 40   0020

82022-09 107 x 132 mm
4.2 x 5.2 inch

13.993

1.      Isacord 40   0870

2.      Isacord 40   0761

3.      Isacord 40   0934

4.      Isacord 40   1172

5.      Isacord 40   0853

6.      Isacord 40   1055

7.      Isacord 40   1565

8.      Isacord 40   0862

9.      Isacord 40   0015

10.      Isacord 40   0781
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Pk10009-04 92 x 158 mm
3.6 x 6.2 inch

4.843

1.      Isacord 40   0020

Pk10009-09 165 x 78 mm
6.5 x 3.1 inch

4.224

1.      Isacord 40   0020

19.14 Hobbies

12378-16 100 x 152 mm
3.9 x 6 inch

11.964

1.      Isacord 40   0861

2.      Isacord 40   1874

3.      Isacord 40   0941

12449-08 92 x 142 mm
3.6 x 5.6 inch

8.409

1.      Isacord 40   0640

2.      Isacord 40   0842

3.      Isacord 40   3901

4.      Isacord 40   1900

5.      Isacord 40   5400

6.      Isacord 40   0131

7.      Isacord 40   3971

8.      Isacord 40   0020

9.      Isacord 40   3971

10.      Isacord 40   0504 11.      Isacord 40   3910 12.      Isacord 40   1900

13.      Isacord 40   2640

12449-09 82 x 144 mm
3.2 x 5.7 inch

8.425

1.      Isacord 40   6031

2.      Isacord 40   5115

3.      Isacord 40   0504

4.      Isacord 40   1351

5.      Isacord 40   1753

6.      Isacord 40   2920

7.      Isacord 40   1220

8.      Isacord 40   0131

9.      Isacord 40   3971

10.      Isacord 40   0020 11.      Isacord 40   0721

12572-04 137 x 85 mm
5.4 x 3.4 inch

7.238

1.      Isacord 40   3323

2.      Isacord 40   3323

3.      Isacord 40   3323

4.      Isacord 40   0105

5.      Isacord 40   1055

6.      Isacord 40   1055

7.      Isacord 40   0015

8.      Isacord 40   1055

9.      Isacord 40   1123

12611-01 121 x 104 mm
4.8 x 4.1 inch

7.344

1.      Isacord 40   0151

2.      Isacord 40   0151

3.      Isacord 40   0151

4.      Isacord 40   0151

5.      Isacord 40   0151

6.      Isacord 40   1902

12721-02 90 x 90 mm
3.5 x 3.5 inch

8.386

1.      Isacord 40   1220

2.      Isacord 40   1220

3.      Isacord 40   2220

4.      Isacord 40   1805

5.      Isacord 40   5610

6.      Isacord 40   0015

7.      Isacord 40   4174

8.      Isacord 40   1220

9.      Isacord 40   4220
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12774-02 52 x 144 mm
2.1 x 5.7 inch

11.330

1.      Isacord 40   3963

2.      Isacord 40   3650

3.      Isacord 40   3951

4.      Isacord 40   0017

5.      Isacord 40   3853

12774-04 60 x 136 mm
2.4 x 5.4 inch

7.588

1.      Isacord 40   5115

12796-03L 194 x 278 mm
7.6 x 10.9 inch

31.215

1.      Isacord 40   1904

12796-04L 204 x 259 mm
8 x 10.2 inch

18.337

1.      Isacord 40   1904

12796-04s 127 x 162 mm
5 x 6.4 inch

11.362

1.      Isacord 40   1904

12796-05s 127 x 178 mm
5 x 7 inch

8.778

1.      Isacord 40   1904

12796-07m 153 x 167 mm
6 x 6.6 inch

20.194

1.      Isacord 40   1904

12800-01s 111 x 176 mm
4.4 x 6.9 inch

12.448

1.      Isacord 40   0015

12800-05l 203 x 248 mm
8 x 9.8 inch

20.441

1.      Isacord 40   0015

12800-05S 123 x 150 mm
4.8 x 5.9 inch

11.476

1.      Isacord 40   0015
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12919-01 84 x 154 mm
3.3 x 6.1 inch

5.864

1.      Isacord 40   5210

2.      Isacord 40   0934

3.      Isacord 40   3962

4.      Isacord 40   2560

5.      Isacord 40   2732

6.      Isacord 40   1055

51216-11 114 x 170 mm
4.5 x 6.7 inch

19.771

1.      Isacord 40   3971

2.      Isacord 40   5050

3.      Isacord 40   1532

4.      Isacord 40   0020

5.      Isacord 40   2155

6.      Isacord 40   2300

7.      Isacord 40   5115

8.      Isacord 40   2711

9.      Isacord 40   1753

10.      Isacord 40   2300 11.      Isacord 40   0015 12.      Isacord 40   1840

51217-05L 159 x 210 mm
6.3 x 8.3 inch

28.887

1.      Isacord 40   3040

2.      Isacord 40   0842

3.      Isacord 40   0660

4.      Isacord 40   0853

5.      Isacord 40   0138

6.      Isacord 40   3971

7.      Isacord 40   2250

8.      Isacord 40   0020

80154-02 69 x 70 mm
2.7 x 2.7 inch

8.564

1.      Isacord 40   0904

2.      Isacord 40   1346

80154-08 89 x 67 mm
3.5 x 2.6 inch

10.589

1.      Isacord 40   1355

2.      Isacord 40   0101

82014-20 121 x 85 mm
4.8 x 3.4 inch

7.660

1.      Isacord 40   4174

82014-24 196 x 108 mm
7.7 x 4.3 inch

23.165

1.      Isacord 40   1902

82014-29 189 x 52 mm
7.4 x 2 inch

14.453

1.      Isacord 40   1902

2.      Isacord 40   0020

Ck973 106 x 61 mm
4.2 x 2.4 inch

11.362

1.      Isacord 40   3920

2.      Isacord 40   1061

3.      Isacord 40   0945

4.      Isacord 40   0101

5.      Isacord 40   3971

6.      Isacord 40   1010

7.      Isacord 40   1335

8.      Isacord 40   4174

9.      Isacord 40   1332

10.      Isacord 40   0660 11.      Isacord 40   0311 12.      Isacord 40   0704

13.      Isacord 40   0132

Sr639 127 x 46 mm
5 x 1.8 inch

20.623

1.      Isacord 40   3650

2.      Isacord 40   5650

3.      Isacord 40   5513

4.      Isacord 40   0670

5.      Isacord 40   3641

6.      Isacord 40   3444
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12370-01 127 x 126 mm
5 x 5 inch

6.263

1.      Isacord 40   5613

12370-04 83 x 216 mm
3.3 x 8.5 inch

3.407

1.      Isacord 40   2101

12370-12 17 x 203 mm
0.7 x 8 inch

3.427

1.      Isacord 40   3210

12952-02 101 x 162 mm
4 x 6.4 inch

12.934

1.      Isacord 40   0861

2.      Isacord 40   0520

3.      Isacord 40   1061

4.      Isacord 40   0643

5.      Isacord 40   2051

6.      Isacord 40   0453

7.      Isacord 40   0776

8.      Isacord 40   0142

9.      Isacord 40   0643

10.      Isacord 40   1362 11.      Isacord 40   1430 12.      Isacord 40   4074

13.      Isacord 40   0111 14.      Isacord 40   1322 15.      Isacord 40   0020

16.      Isacord 40   0010 17.      Isacord 40   0520

12952-12 89 x 41 mm
3.5 x 1.6 inch

4.288

1.      Isacord 40   0643

2.      Isacord 40   0352

3.      Isacord 40   2051

4.      Isacord 40   0832

5.      Isacord 40   0352

6.      Isacord 40   0454

7.      Isacord 40   0520

8.      Isacord 40   0465

9.      Isacord 40   0020

10.      Isacord 40   0010

51287-03 74 x 102 mm
2.9 x 4 inch

10.819

1.      Isacord 40   1334

2.      Isacord 40   1120

3.      Isacord 40   3644

4.      Isacord 40   3910

80154-05 64 x 64 mm
2.5 x 2.5 inch

6.259

1.      Isacord 40   0015

2.      Isacord 40   1911

82033-19 75 x 148 mm
3 x 5.8 inch

3.814

1.      Isacord 40   1730

2.      Isacord 40   1900

3.      Isacord 40   4114

4.      Isacord 40   3906

5.      Isacord 40   2532

6.      Isacord 40   0704

Lt850 104 x 44 mm
4.1 x 1.7 inch

6.904

1.      Isacord 40   4174

2.      Isacord 40   0015

3.      Isacord 40   0124

4.      Isacord 40   3640

5.      Isacord 40   5822

6.      Isacord 40   6133

7.      Isacord 40   5411

8.      Isacord 40   4250

9.      Isacord 40   5555

Pk50011-02 115 x 171 mm
4.5 x 6.7 inch

7.875

1.      Isacord 40   2711

2.      Isacord 40   3211

3.      Isacord 40   2723

4.      Isacord 40   3611

5.      Isacord 40   3906

6.      Isacord 40   0152
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Pk50011-03 119 x 172 mm
4.7 x 6.8 inch

8.185

1.      Isacord 40   5513

2.      Isacord 40   5832

3.      Isacord 40   5650

4.      Isacord 40   3611

5.      Isacord 40   3906

6.      Isacord 40   2920

7.      Isacord 40   2830

8.      Isacord 40   3040

9.      Isacord 40   1913

10.      Isacord 40   1725 11.      Isacord 40   1521 12.      Isacord 40   1334

13.      Isacord 40   1332 14.      Isacord 40   1362 15.      Isacord 40   0131

Pk50026-02 45 x 164 mm
1.8 x 6.5 inch

7.244

1.      Isacord 40   4250

2.      Isacord 40   4410

3.      Isacord 40   3743

4.      Isacord 40   0822

5.      Isacord 40   0010

19.15 Seasons

12384-03 123 x 161 mm
4.9 x 6.4 inch

22.233

1.      Isacord 40   0945

2.      Isacord 40   0454

3.      Isacord 40   0352

4.      Isacord 40   2764

5.      Isacord 40   2600

6.      Isacord 40   2761

12400-07 64 x 60 mm
2.5 x 2.4 inch

3.615

1.      Isacord 40   0250

2.      Isacord 40   0630

3.      Isacord 40   1102

4.      Isacord 40   0800

12765-07 253 x 253 mm
10 x 10 inch

61.060

1.      Yenmet   7005

2.      Isacord 40   0017

12861-02L 190 x 219 mm
7.5 x 8.6 inch

24.122

1.      Isacord 40   2640

2.      Isacord 40   2721

3.      Isacord 40   3815

4.      Isacord 40   3962

5.      Isacord 40   2721

12895-02L 127 x 178 mm
5 x 7 inch

7.610

1.      Isacord 40   0010

2.      Isacord 40   3730

3.      Isacord 40   5440

4.      Isacord 40   5210

5.      Isacord 40   5740

6.      Isacord 40   4174

51212-14 77 x 163 mm
3 x 6.4 inch

21.112

1.      Isacord 40   5866

2.      Isacord 40   0853

3.      Isacord 40   6133

4.      Isacord 40   1114

5.      Isacord 40   0781

6.      Isacord 40   0771

7.      Isacord 40   1030

8.      Isacord 40   6133

9.      Isacord 40   5866
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51248-14L 150 x 268 mm
5.9 x 10.5 inch

8.496

1.      Isacord 40   2715

2.      Isacord 40   3902

3.      Isacord 40   0922

4.      Isacord 40   3630

5.      Isacord 40   2723

6.      Isacord 40   3645

51266-06 70 x 166 mm
2.7 x 6.5 inch

13.036

1.      Isacord 40   0622

2.      Isacord 40   0622

3.      Isacord 40   0622

4.      Isacord 40   0520

51270-04 125 x 207 mm
4.9 x 8.1 inch

16.828

1.      Isacord 40   4740

2.      Isacord 40   2155

3.      Isacord 40   5115

4.      Isacord 40   4740

5.      Isacord 40   0904

6.      Isacord 40   1730

7.      Isacord 40   0506

8.      Isacord 40   0520

9.      Isacord 40   0138

51304-03 125 x 150 mm
4.9 x 5.9 inch

22.668

1.      Isacord 40   1060

2.      Isacord 40   0184

3.      Isacord 40   6071

4.      Isacord 40   0853

5.      Isacord 40   0453

6.      Isacord 40   0555

7.      Isacord 40   0672

8.      Isacord 40   1362

9.      Isacord 40   1032

10.      Isacord 40   1010 11.      Isacord 40   0352 12.      Isacord 40   0520

13.      Isacord 40   2333 14.      Isacord 40   2241 15.      Isacord 40   1755

51304-09 80 x 106 mm
3.1 x 4.2 inch

8.789

1.      Isacord 40   1600

2.      Isacord 40   0232

3.      Isacord 40   1565

4.      Isacord 40   1133

5.      Isacord 40   0853

6.      Isacord 40   1543

7.      Isacord 40   1010

8.      Isacord 40   0713

9.      Isacord 40   0520

51312-01 160 x 178 mm
6.3 x 7 inch

32.569

1.      Isacord 40   5743

2.      Isacord 40   5833

3.      Isacord 40   5944

4.      Isacord 40   9868

5.      Isacord 40   1055

6.      Isacord 40   0945

7.      Isacord 40   1252

8.      Isacord 40   1123

9.      Isacord 40   0781

10.      Isacord 40   5531 11.      Isacord 40   0747 12.      Isacord 40   1252

13.      Isacord 40   1725 14.      Isacord 40   2011 15.      Isacord 40   2123

16.      Isacord 40   1532

82031-24 123 x 119 mm
4.8 x 4.7 inch

23.676

1.      Isacord 40   5050

2.      Isacord 40   0015

3.      Isacord 40   0622

4.      Isacord 40   1321

5.      Isacord 40   1114

6.      Isacord 40   2171

7.      Isacord 40   3444

8.      Isacord 40   1753

9.      Isacord 40   2171

Cc82425 41 x 51 mm
1.6 x 2 inch

5.290

1.      Isacord 40   1134

2.      Isacord 40   1346

3.      Isacord 40   5730

4.      Isacord 40   5722
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Cm547_48 97 x 122 mm
3.8 x 4.8 inch

18.516

1.      Isacord 40   0182

2.      Isacord 40   0015

3.      Isacord 40   5531

4.      Isacord 40   0142

5.      Isacord 40   6031

6.      Isacord 40   0108

7.      Isacord 40   5101

8.      Isacord 40   6011

9.      Isacord 40   4122

10.      Isacord 40   4103 11.      Isacord 40   0111 12.      Yenmet   7030

13.      Isacord 40   3902 14.      Isacord 40   0020

Fp232 72 x 83 mm
2.8 x 3.3 inch

7.517

1.      Isacord 40   0101

2.      Yenmet   7029

3.      Isacord 40   4071

Hd300 91 x 99 mm
3.6 x 3.9 inch

13.754

1.      Isacord 40   0015

2.      Isacord 40   3901

3.      Isacord 40   0015

4.      Isacord 40   3650

5.      Isacord 40   3901

6.      Isacord 40   0250

7.      Isacord 40   2830

8.      Isacord 40   3743

9.      Isacord 40   0800

10.      Isacord 40   1902 11.      Isacord 40   0853 12.      Isacord 40   3600

13.      Isacord 40   1430 14.      Isacord 40   5531 15.      Isacord 40   0811

16.      Isacord 40   0660 17.      Isacord 40   4174 18.      Yenmet   7029

He923_48 86 x 99 mm
3.4 x 3.9 inch

16.158

1.      Isacord 40   0101

2.      Isacord 40   3840

3.      Isacord 40   3641

4.      Isacord 40   5822

5.      Isacord 40   5933

6.      Isacord 40   0145

Nb768_48 125 x 113 mm
4.9 x 4.4 inch

7.109

1.      Isacord 40   0651

2.      Yenmet   7037

12404-10 171 x 347 mm
6.7 x 13.7 inch

29.713

1.      Isacord 40   0132

2.      Isacord 40   2521

3.      Isacord 40   2520

4.      Isacord 40   2550

12422-33 36 x 37 mm
1.4 x 1.5 inch

2.649

1.      Isacord 40   0922

2.      Isacord 40   1154

3.      Isacord 40   0811

12569-02 100 x 157 mm
3.9 x 6.2 inch

23.131

1.      Isacord 40   3544

2.      Isacord 40   0015

3.      Isacord 40   5115

4.      Isacord 40   2912

5.      Isacord 40   5912

6.      Isacord 40   0721

7.      Isacord 40   0630

8.      Isacord 40   2550

9.      Isacord 40   3710

12907-24 109 x 131 mm
4.3 x 5.2 inch

15.167

1.      Isacord 40   4752

2.      Isacord 40   1755

3.      Isacord 40   5743

4.      Isacord 40   0870

5.      Isacord 40   5555

12935-08 123 x 140 mm
4.9 x 5.5 inch

7.135

1.      Isacord 40   1114

2.      Isacord 40   1114

3.      Isacord 40   1114

4.      Isacord 40   1114

5.      Isacord 40   1114

6.      Isacord 40   0020
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51232-02 107 x 146 mm
4.2 x 5.8 inch

38.676

1.      Isacord 40   0608

2.      Isacord 40   5230

3.      Isacord 40   1900

4.      Isacord 40   0010

5.      Isacord 40   0020

6.      Isacord 40   5230

7.      Isacord 40   1900

8.      Isacord 40   0020

51260-01 117 x 142 mm
4.6 x 5.6 inch

12.989

1.      Isacord 40   5743

2.      Isacord 40   1260

3.      Isacord 40   3644

4.      Isacord 40   0311

5.      Isacord 40   4332

6.      Isacord 40   3644

7.      Isacord 40   1346

51266-01 86 x 166 mm
3.4 x 6.5 inch

10.041

1.      Isacord 40   2530

2.      Isacord 40   2530

3.      Isacord 40   2530

4.      Isacord 40   2520

5.      Isacord 40   2160

6.      Isacord 40   4174

7.      Isacord 40   0108

51304-08 86 x 103 mm
3.4 x 4 inch

14.444

1.      Isacord 40   0651

2.      Isacord 40   0842

3.      Isacord 40   0853

4.      Isacord 40   1725

5.      Isacord 40   1521

6.      Isacord 40   1430

7.      Isacord 40   1532

8.      Isacord 40   1332

9.      Isacord 40   1010

10.      Isacord 40   1030 11.      Isacord 40   0713 12.      Isacord 40   0520

13.      Isacord 40   1351

51304-10 77 x 100 mm
3 x 3.9 inch

11.158

1.      Isacord 40   1521

2.      Isacord 40   0352

3.      Isacord 40   0232

4.      Isacord 40   0651

5.      Isacord 40   1430

6.      Isacord 40   1032

7.      Isacord 40   1010

8.      Isacord 40   0713

9.      Isacord 40   0520

10.      Isacord 40   1061 11.      Isacord 40   1565

Fs080_48 110 x 116 mm
4.4 x 4.6 inch

7.080

1.      YLI variations   8007

2.      Isacord 40   9925

3.      Isacord 40   0811

4.      YLI variations   8012

5.      Isacord 40   9978

6.      Isacord 40   0934

7.      Isacord 40   0853

8.      Isacord 40   1430

9.      Isacord 40   9924

10.      Isacord 40   0721 11.      Isacord 40   1543

Oc86075 70 x 98 mm
2.8 x 3.9 inch

5.143

1.      Isacord 40   0520

2.      Isacord 40   1123

3.      Isacord 40   0504

4.      Isacord 40   0922

5.      Isacord 40   3962

6.      Isacord 40   2761

7.      Isacord 40   3641

8.      Isacord 40   1840

9.      Isacord 40   1921

Oc88402 100 x 135 mm
3.9 x 5.3 inch

16.644

1.      Isacord 40   5822

2.      Isacord 40   0101

3.      Isacord 40   0151

4.      Isacord 40   5610

5.      Isacord 40   0630

6.      Isacord 40   1600

7.      Isacord 40   1010

8.      Isacord 40   5833

9.      Isacord 40   0853

10.      Isacord 40   1055

Pk10037-02 150 x 174 mm
5.9 x 6.9 inch

11.052

1.      Isacord 40   9302

2.      Isacord 40   1332

3.      Isacord 40   9978

4.      Isacord 40   4620

Pk10031-02 131 x 235 mm
5.1 x 9.3 inch

20.972

1.      Isacord 40   6156
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19.16 Holidays

12408-07 41 x 126 mm
1.6 x 5 inch

2.641

1.      YLI variations   8008

2.      Isacord 40   4122

3.      YLI variations   8015

4.      Isacord 40   1730

5.      Yenmet   7029

12408-08 66 x 141 mm
2.6 x 5.6 inch

2.127

1.      Yenmet   7030

2.      YLI variations   8015

3.      Isacord 40   1730

4.      Isacord 40   5500

5.      YLI variations   8008

6.      Isacord 40   4122

7.      Yenmet   7028

12421-35 43 x 64 mm
1.7 x 2.5 inch

3.993

1.      Isacord 40   0015

2.      Isacord 40   0131

3.      Isacord 40   0020

12428-01 101 x 128 mm
4 x 5.1 inch

4.503

1.      Isacord 40   0015

12428-20 124 x 137 mm
4.9 x 5.4 inch

6.610

1.      Isacord 40   0015

12629-15 87 x 86 mm
3.4 x 3.4 inch

8.345

1.      Isacord 40   1220

2.      Isacord 40   1220

3.      Isacord 40   1220

4.      Isacord 40   1220

5.      Isacord 40   1220

6.      Isacord 40   1220

7.      Isacord 40   1220

8.      Isacord 40   2920

9.      Isacord 40   4421

10.      Isacord 40   4421 11.      Isacord 40   4421 12.      Isacord 40   4240

13.      Isacord 40   0015

12655-15 202 x 135 mm
8 x 5.3 inch

21.439

1.      Isacord 40   1543

2.      Isacord 40   1055

3.      Isacord 40   1115

12682-01 98 x 132 mm
3.9 x 5.2 inch

11.482

1.      Isacord 40   0230

2.      Isacord 40   1030

3.      Isacord 40   1114

4.      Isacord 40   2560

5.      Isacord 40   5832

6.      Isacord 40   4430

7.      Isacord 40   2220

8.      Isacord 40   2510

12739-01 126 x 147 mm
5 x 5.8 inch

46.003

1.      Isacord 40   0015

12766-08 86 x 139 mm
3.4 x 5.5 inch

18.797

1.      Isacord 40   0017

2.      Isacord 40   0017

3.      Isacord 40   0017

4.      Isacord 40   0017

5.      Yenmet   7005

6.      Isacord 40   1903



Appendix

19 Embroidery Designs 198

12793-04 243 x 282 mm
9.6 x 11.1 inch

57.006

1.      Isacord 40   1902

2.      Isacord 40   2776

3.      Isacord 40   0020

4.      Isacord 40   5633

12793-10 226 x 294 mm
8.9 x 11.6 inch

29.319

1.      Isacord 40   3631

2.      Isacord 40   3652

3.      Isacord 40   3652

4.      Isacord 40   3743

12793-14 81 x 174 mm
3.2 x 6.9 inch

7.384

1.      Isacord 40   0020

12836-12 112 x 165 mm
4.4 x 6.5 inch

18.687

1.      Isacord 40   1161

2.      Isacord 40   5833

3.      Isacord 40   5643

4.      Isacord 40   2011

5.      Isacord 40   2152

6.      Isacord 40   1900

7.      Isacord 40   5643

8.      Isacord 40   5833

9.      Isacord 40   0453

10.      Isacord 40   5832 11.      Isacord 40   0010 12.      Isacord 40   3963

13.      Isacord 40   2011

12836-17 107 x 134 mm
4.2 x 5.3 inch

17.387

1.      Isacord 40   1761

2.      Isacord 40   2051

3.      Isacord 40   0020

4.      Isacord 40   1900

5.      Isacord 40   2011

6.      Isacord 40   0010

7.      Isacord 40   0142

8.      Isacord 40   2011

32015-01 124 x 160 mm
4.9 x 6.3 inch

14.856

1.      Isacord 40   5730

2.      Isacord 40   5722

3.      Isacord 40   5730

80037-01 120 x 119 mm
4.7 x 4.7 inch

11.098

1.      Isacord 40   1906

80037-09 143 x 81 mm
5.6 x 3.2 inch

8.641

1.      Isacord 40   2320

2.      Isacord 40   1906

3.      Isacord 40   0020

4.      Isacord 40   0020

5.      Isacord 40   2300

6.      Isacord 40   2550

80037-23 161 x 77 mm
6.4 x 3 inch

5.878

1.      Isacord 40   1906

2.      Isacord 40   2320

Cm302_48 180 x 59 mm
7.1 x 2.3 inch

5.485

1.      Isacord 40   3045

2.      Isacord 40   2640
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Hg298_48 65 x 112 mm
2.6 x 4.4 inch

1.878

1.      Isacord 40   2101

12907-20 96 x 146 mm
3.8 x 5.7 inch

19.073

1.      Isacord 40   1134

2.      Isacord 40   5555

3.      Isacord 40   5743

4.      Isacord 40   4752

5.      Isacord 40   4133

6.      Isacord 40   1600

7.      Isacord 40   1755

8.      Isacord 40   0800

9.      Isacord 40   1912

10.      Isacord 40   1134

51212-07 98 x 99 mm
3.8 x 3.9 inch

13.660

1.      Isacord 40   2504

2.      Isacord 40   4220

3.      Isacord 40   1030

4.      Isacord 40   1114

5.      Isacord 40   5866

6.      Isacord 40   0015

51238-03 27 x 51 mm
1.1 x 2 inch

1.560

1.      Isacord 40   3030

2.      Isacord 40   0640

3.      Isacord 40   4174

4.      Isacord 40   5740

5.      Isacord 40   0108

51238-04 36 x 43 mm
1.4 x 1.7 inch

1.566

1.      Isacord 40   5740

2.      Isacord 40   1030

3.      Isacord 40   0108

4.      Isacord 40   4174

5.      Isacord 40   0640

6.      Isacord 40   3030

Oc00429 190 x 323 mm
7.5 x 12.7 inch

59.101

1.      Isacord 40   0520

2.      Isacord 40   0270

3.      Isacord 40   0640

4.      Isacord 40   0532

Pk50032-01 160 x 211 mm
6.3 x 8.3 inch

43.095

1.      Isacord 40   1321

2.      Isacord 40   1030

3.      Isacord 40   2715

4.      Isacord 40   2721

5.      Isacord 40   0605

6.      Isacord 40   0220

7.      Isacord 40   2715

8.      Isacord 40   2721

9.      Isacord 40   5613

10.      Isacord 40   5500 11.      Isacord 40   1321 12.      Isacord 40   1030

13.      Isacord 40   0605 14.      Isacord 40   0220 15.      Isacord 40   1260

Pk50032-04 153 x 246 mm
6 x 9.7 inch

34.614

1.      Isacord 40   4423

2.      Isacord 40   5115

3.      Isacord 40   2508

4.      Isacord 40   2530

5.      Isacord 40   5613

6.      Isacord 40   5500

7.      Isacord 40   0605

8.      Isacord 40   0220

9.      Isacord 40   2715

10.      Isacord 40   2721 11.      Isacord 40   1260
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19.17 Celebrations

12436-23 62 x 64 mm
2.5 x 2.5 inch

5.510

1.      YLI variations   8004

2.      Isacord 40   1950

3.      YLI variations   8019

12478-01 36 x 49 mm
1.4 x 1.9 inch

1.746

1.      Isacord 40   0150

2.      Isacord 40   1902

3.      Isacord 40   0015

12478-03 39 x 48 mm
1.5 x 1.9 inch

2.859

1.      Isacord 40   3910

2.      Isacord 40   0640

3.      Isacord 40   5912

12478-07 39 x 37 mm
1.5 x 1.4 inch

1.694

1.      Isacord 40   5912

2.      Isacord 40   0015

3.      Isacord 40   2810

12478-08 39 x 55 mm
1.5 x 2.2 inch

3.263

1.      Isacord 40   5912

2.      Isacord 40   0941

3.      Isacord 40   2530

4.      Isacord 40   3910

5.      Isacord 40   0622

12478-12 43 x 38 mm
1.7 x 1.5 inch

3.372

1.      Isacord 40   0020

12478-13 46 x 53 mm
1.8 x 2.1 inch

1.752

1.      Isacord 40   1902

2.      Isacord 40   2810

3.      Isacord 40   5912

4.      Isacord 40   3910

12555-02 119 x 174 mm
4.7 x 6.9 inch

7.613

1.      Isacord 40   5400

2.      Isacord 40   1902

3.      Isacord 40   3906

4.      Yenmet   7029

5.      Isacord 40   5500

6.      Isacord 40   4122

7.      Yenmet   7030

8.      Isacord 40   1730

12693-01 115 x 117 mm
4.5 x 4.6 inch

15.755

1.      Isacord 40   4174

2.      Isacord 40   4174

3.      Isacord 40   4174

4.      Isacord 40   4174

12718-01 134 x 142 mm
5.3 x 5.6 inch

19.427

1.      Isacord 40   0015
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51252-02 97 x 125 mm
3.8 x 4.9 inch

24.063

1.      Isacord 40   2152

2.      Isacord 40   0015

3.      Isacord 40   4430

4.      Isacord 40   2152

5.      Isacord 40   0015

6.      Isacord 40   0702

7.      Isacord 40   0020

51252-03 122 x 152 mm
4.8 x 6 inch

23.665

1.      Isacord 40   2152

2.      Isacord 40   0015

3.      Isacord 40   4430

4.      Isacord 40   0020

5.      Isacord 40   0702

6.      Isacord 40   2152

51252-07 80 x 151 mm
3.2 x 5.9 inch

14.585

1.      Isacord 40   4421

2.      Isacord 40   4430

3.      Isacord 40   2152

4.      Isacord 40   0702

5.      Isacord 40   0250

6.      Isacord 40   0015

7.      Isacord 40   0020

51252-08 97 x 154 mm
3.8 x 6.1 inch

21.693

1.      Isacord 40   2241

2.      Isacord 40   2152

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

51252-09 98 x 160 mm
3.8 x 6.3 inch

20.912

1.      Isacord 40   0020

2.      Isacord 40   0132

3.      Isacord 40   2152

4.      Isacord 40   0702

5.      Isacord 40   0250

6.      Isacord 40   0015

7.      Isacord 40   0020

51252-10 102 x 153 mm
4 x 6 inch

17.531

1.      Isacord 40   4421

2.      Isacord 40   4430

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

51252-11 94 x 155 mm
3.7 x 6.1 inch

20.179

1.      Isacord 40   2241

2.      Isacord 40   2152

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

51252-12 102 x 151 mm
4 x 5.9 inch

19.365

1.      Isacord 40   0020

2.      Isacord 40   0132

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

51252-13 92 x 146 mm
3.6 x 5.7 inch

13.658

1.      Isacord 40   4421

2.      Isacord 40   4430

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

51252-14 96 x 153 mm
3.8 x 6 inch

21.686

1.      Isacord 40   2241

2.      Isacord 40   2152

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020
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51252-15 100 x 150 mm
3.9 x 5.9 inch

19.368

1.      Isacord 40   0020

2.      Isacord 40   0132

3.      Isacord 40   4430

4.      Isacord 40   0702

5.      Isacord 40   0250

6.      Isacord 40   0015

7.      Isacord 40   0020

51252-16 95 x 151 mm
3.7 x 5.9 inch

19.661

1.      Isacord 40   4421

2.      Isacord 40   4430

3.      Isacord 40   0702

4.      Isacord 40   0250

5.      Isacord 40   0015

6.      Isacord 40   0020

Pk50019-03 102 x 94 mm
4 x 3.7 inch

10.850

1.      Isacord 40   4174

2.      Isacord 40   4174

3.      Isacord 40   4174

4.      Isacord 40   0020

5.      Isacord 40   0870

6.      Isacord 40   0622

7.      Isacord 40   4174

19.18 Travel

12446-18 190 x 110 mm
7.5 x 4.4 inch

4.117

1.      Isacord 40   0015

2.      Isacord 40   0015

12677-03 148 x 104 mm
5.8 x 4.1 inch

7.927

1.      Isacord 40   0108

2.      Isacord 40   0108

3.      Isacord 40   0108

4.      Isacord 40   0108

5.      Isacord 40   0108

6.      Isacord 40   0108

7.      Isacord 40   0108

8.      Isacord 40   0108

9.      Isacord 40   0108

10.      Isacord 40   5050 11.      Isacord 40   1010 12.      Isacord 40   1332

13.      Isacord 40   4610 14.      Isacord 40   0132

12773-01 85 x 30 mm
3.4 x 1.2 inch

2.176

1.      Isacord 40   0020

12773-02 40 x 40 mm
1.6 x 1.6 inch

1.184

1.      Isacord 40   0020

12773-03 32 x 82 mm
1.2 x 3.2 inch

1.704

1.      Isacord 40   0020

12773-09 91 x 39 mm
3.6 x 1.5 inch

2.972

1.      Isacord 40   0020
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12773-10 33 x 33 mm
1.3 x 1.3 inch

1.323

1.      Isacord 40   0020

12773-11 54 x 79 mm
2.1 x 3.1 inch

2.764

1.      Isacord 40   0020

12773-17 54 x 44 mm
2.1 x 1.7 inch

2.192

1.      Isacord 40   0020

12773-18 40 x 19 mm
1.6 x 0.8 inch

769

1.      Isacord 40   0020

12773-19 67 x 48 mm
2.6 x 1.9 inch

2.750

1.      Isacord 40   0020

12773-20 77 x 49 mm
3 x 1.9 inch

8.666

1.      Isacord 40   5730

2.      Isacord 40   0230

3.      Isacord 40   0874

4.      Isacord 40   0722

5.      Isacord 40   0145

6.      Isacord 40   0138

7.      Isacord 40   5050

8.      Isacord 40   5230

9.      Isacord 40   0020

12773-21 94 x 30 mm
3.7 x 1.2 inch

3.053

1.      Isacord 40   0020

12773-22 29 x 32 mm
1.1 x 1.3 inch

1.523

1.      Isacord 40   0020

12773-23 94 x 30 mm
3.7 x 1.2 inch

1.819

1.      Isacord 40   0020

12773-24 71 x 54 mm
2.8 x 2.1 inch

3.455

1.      Isacord 40   4071

2.      Isacord 40   4230

3.      Isacord 40   3815

4.      Isacord 40   1911

5.      Isacord 40   1704

6.      Isacord 40   0020
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12773-25 93 x 33 mm
3.6 x 1.3 inch

2.364

1.      Isacord 40   0020

12773-26 46 x 32 mm
1.8 x 1.3 inch

2.055

1.      Isacord 40   0020

12773-29 78 x 38 mm
3.1 x 1.5 inch

1.941

1.      Isacord 40   0020

12773-30 33 x 33 mm
1.3 x 1.3 inch

844

1.      Isacord 40   0020

12773-33 83 x 23 mm
3.3 x 0.9 inch

2.234

1.      Isacord 40   0020

12773-34 40 x 40 mm
1.6 x 1.6 inch

882

1.      Isacord 40   0020

12773-35 84 x 32 mm
3.3 x 1.3 inch

2.023

1.      Isacord 40   0020

12773-37 100 x 27 mm
3.9 x 1.1 inch

3.206

1.      Isacord 40   0020

12773-38 33 x 40 mm
1.3 x 1.6 inch

1.944

1.      Isacord 40   0020

12773-39 62 x 72 mm
2.4 x 2.8 inch

2.176

1.      Isacord 40   0020
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12792-10 128 x 119 mm
5.1 x 4.7 inch

9.777

1.      Isacord 40   1800

2.      Isacord 40   1800

3.      Isacord 40   1800

4.      Isacord 40   1800

5.      Isacord 40   1800

6.      Isacord 40   2101

12804-01s 126 x 168 mm
5 x 6.6 inch

32.368

1.      Isacord 40   0020

12804-04s 126 x 132 mm
5 x 5.2 inch

23.373

1.      Isacord 40   0020

51217-12l 152 x 252 mm
6 x 9.9 inch

36.832

1.      Isacord 40   1133

2.      Isacord 40   3730

3.      Isacord 40   3630

4.      Isacord 40   0020

51284-01 67 x 134 mm
2.6 x 5.3 inch

15.426

1.      Isacord 40   4643

2.      Isacord 40   0221

3.      Isacord 40   1114

51296-04 92 x 100 mm
3.6 x 3.9 inch

30.369

1.      Isacord 40   3654

2.      Isacord 40   0800

3.      Isacord 40   0970

4.      Isacord 40   1305

5.      Isacord 40   1055

6.      Isacord 40   1776

7.      Isacord 40   1776

51296-10 91 x 92 mm
3.6 x 3.6 inch

6.721

1.      Isacord 40   0821

2.      Isacord 40   0941

3.      Isacord 40   0941

19.19 Words and Sayings

12381-01 97 x 158 mm
3.8 x 6.2 inch

11.095

1.      Isacord 40   2153

2.      Isacord 40   2011

12449-02 112 x 139 mm
4.4 x 5.5 inch

8.357

1.      Isacord 40   2920

2.      Isacord 40   0504

3.      Isacord 40   0015

4.      Isacord 40   2830
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12697-02 123 x 153 mm
4.9 x 6 inch

19.576

1.      Isacord 40   3713

2.      Isacord 40   0555

3.      Isacord 40   4220

4.      Isacord 40   4240

5.      Isacord 40   0761

6.      Isacord 40   0442

7.      Isacord 40   1430

8.      Isacord 40   1311

9.      Isacord 40   1060

10.      Isacord 40   1321

12738-01 126 x 121 mm
5 x 4.8 inch

16.138

1.      Isacord 40   4152

2.      Isacord 40   0643

3.      Isacord 40   5610

4.      Isacord 40   2500

5.      Isacord 40   2944

12738-03 113 x 139 mm
4.4 x 5.5 inch

25.182

1.      Isacord 40   2500

2.      Isacord 40   4152

3.      Isacord 40   0643

4.      Isacord 40   0015

5.      Isacord 40   2944

6.      Isacord 40   5610

12770-01 138 x 140 mm
5.4 x 5.5 inch

16.303

1.      Isacord 40   0800

2.      Isacord 40   3652

3.      Isacord 40   1532

4.      Isacord 40   4174

12770-08 116 x 112 mm
4.6 x 4.4 inch

12.081

1.      Isacord 40   1532

2.      Isacord 40   1840

3.      Isacord 40   1753

4.      Isacord 40   2320

5.      Isacord 40   1903

12774-03 126 x 136 mm
5 x 5.4 inch

9.656

1.      Isacord 40   0874

2.      Isacord 40   1913

12809-04 127 x 160 mm
5 x 6.3 inch

10.381

1.      Isacord 40   4240

2.      Isacord 40   4114

3.      Isacord 40   4116

12843-04 126 x 199 mm
5 x 7.8 inch

16.487

1.      Isacord 40   0520

2.      Isacord 40   0310

3.      Isacord 40   5510

4.      Isacord 40   5740

5.      Isacord 40   5610

6.      Isacord 40   0311

7.      Isacord 40   0010

8.      Isacord 40   5510

9.      Isacord 40   0311

12913-10L 127 x 178 mm
5 x 7 inch

3.929

1.      Isacord 40   0015

2.      Isacord 40   0132

3.      Isacord 40   0832

4.      Isacord 40   4423

5.      Isacord 40   1600

6.      Isacord 40   0132

19999-029 121 x 119 mm
4.8 x 4.7 inch

26.194

1.      Isacord 40   1840

2.      Isacord 40   0800

3.      Isacord 40   1114

4.      Isacord 40   1704

5.      Isacord 40   3951

6.      Isacord 40   4952

7.      Isacord 40   5210

8.      Isacord 40   2650

9.      Isacord 40   1375

10.      Isacord 40   0015
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51209-02 171 x 196 mm
6.7 x 7.7 inch

43.385

1.      Isacord 40   0020

2.      Isacord 40   4410

3.      Isacord 40   4643

4.      Isacord 40   4610

5.      Isacord 40   3030

6.      Isacord 40   3150

7.      Isacord 40   2920

8.      Isacord 40   0020

9.      Isacord 40   0010

10.      Isacord 40   0608 11.      Isacord 40   0904 12.      Isacord 40   1321

13.      Isacord 40   1912 14.      Isacord 40   1902 15.      Isacord 40   1725

16.      Isacord 40   0020 17.      Isacord 40   0010

51209-03 110 x 214 mm
4.3 x 8.4 inch

35.124

1.      Isacord 40   0020

2.      Isacord 40   2920

3.      Isacord 40   3150

4.      Isacord 40   3030

5.      Isacord 40   0182

6.      Isacord 40   2920

7.      Isacord 40   0020

8.      Isacord 40   0010

51209-04 146 x 216 mm
5.7 x 8.5 inch

56.779

1.      Isacord 40   0020

2.      Isacord 40   4643

3.      Isacord 40   4410

4.      Isacord 40   4610

5.      Isacord 40   4643

6.      Isacord 40   0182

7.      Isacord 40   0020

8.      Isacord 40   0608

9.      Isacord 40   0904

10.      Isacord 40   1321 11.      Isacord 40   1912 12.      Isacord 40   1902

13.      Isacord 40   1725 14.      Isacord 40   0020 15.      Isacord 40   0010

51209-08 50 x 163 mm
2 x 6.4 inch

15.255

1.      Isacord 40   3030

2.      Isacord 40   2920

3.      Isacord 40   0020

51209-09 68 x 162 mm
2.7 x 6.4 inch

14.542

1.      Isacord 40   0020

2.      Isacord 40   4410

51248-02L 197 x 206 mm
7.7 x 8.1 inch

17.453

1.      Isacord 40   3902

2.      Isacord 40   3630

3.      Isacord 40   2723

4.      Isacord 40   3902

5.      Isacord 40   3630

6.      Isacord 40   2715

51248-12S 110 x 171 mm
4.4 x 6.7 inch

9.750

1.      Isacord 40   3902

2.      Isacord 40   3630

3.      Isacord 40   3630

4.      Isacord 40   2723

5.      Isacord 40   3902

6.      Isacord 40   2715

7.      Isacord 40   0922

8.      Isacord 40   3645

51278-05 100 x 131 mm
3.9 x 5.1 inch

10.789

1.      Isacord 40   1260

2.      Isacord 40   0731
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51300-01 127 x 155 mm
5 x 6.1 inch

12.912

1.      Isacord 40   4740

2.      Isacord 40   1362

3.      Isacord 40   0520

4.      Isacord 40   1860

5.      Isacord 40   2550

6.      Isacord 40   2508

7.      Isacord 40   4531

8.      Isacord 40   1220

9.      Isacord 40   0704

10.      Isacord 40   1753 11.      Isacord 40   4220

51300-02 135 x 155 mm
5.3 x 6.1 inch

13.846

1.      Isacord 40   4740

2.      Isacord 40   1220

3.      Isacord 40   4220

4.      Isacord 40   0520

5.      Isacord 40   1753

6.      Isacord 40   0704

7.      Isacord 40   0015

8.      Isacord 40   2550

9.      Isacord 40   2508

10.      Isacord 40   4531

51300-04 106 x 173 mm
4.2 x 6.8 inch

12.911

1.      Isacord 40   4740

2.      Isacord 40   2550

3.      Isacord 40   1362

4.      Isacord 40   1220

5.      Isacord 40   2508

6.      Isacord 40   4220

7.      Isacord 40   4531

51300-10 110 x 147 mm
4.3 x 5.8 inch

8.359

1.      Isacord 40   1362

2.      Isacord 40   1220

3.      Isacord 40   2550

4.      Isacord 40   2508

5.      Isacord 40   4740

6.      Isacord 40   4220

7.      Isacord 40   0520

8.      Isacord 40   0704

9.      Isacord 40   4531

51300-11 131 x 136 mm
5.1 x 5.4 inch

16.730

1.      Isacord 40   4220

2.      Isacord 40   2550

3.      Isacord 40   0520

4.      Isacord 40   2508

5.      Isacord 40   1362

6.      Isacord 40   4740

7.      Isacord 40   4531

8.      Isacord 40   1860

9.      Isacord 40   1753

Cm203_48 135 x 53 mm
5.3 x 2.1 inch

5.254

1.      Isacord 40   2550

2.      Isacord 40   2160

3.      Isacord 40   2761

4.      Isacord 40   0640

Pk10004-01l 243 x 249 mm
9.6 x 9.8 inch

67.094

1.      Isacord 40   4752

2.      Isacord 40   2920

3.      Isacord 40   6051

4.      Isacord 40   0232

5.      Isacord 40   6133

6.      Isacord 40   6071

7.      Isacord 40   2910

8.      Isacord 40   0465

9.      Isacord 40   1755

10.      Isacord 40   3410 11.      Isacord 40   2723 12.      Isacord 40   0232

13.      Isacord 40   6071 14.      Isacord 40   4752 15.      Isacord 40   1352

16.      Isacord 40   6133 17.      Isacord 40   0010 18.      Isacord 40   4610

19.      Isacord 40   2920 20.      Isacord 40   6051 21.      Isacord 40   2910

22.      Isacord 40   2320 23.      Isacord 40   1352 24.      Isacord 40   0465
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19.20 Monograms

12863-01 113 x 119 mm
4.4 x 4.7 inch

10.297

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-02 113 x 119 mm
4.4 x 4.7 inch

10.441

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-03 113 x 119 mm
4.4 x 4.7 inch

10.224

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-04 113 x 119 mm
4.4 x 4.7 inch

10.360

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-05 113 x 119 mm
4.4 x 4.7 inch

10.658

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-06 113 x 119 mm
4.4 x 4.7 inch

10.414

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-07 113 x 119 mm
4.4 x 4.7 inch

10.430

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-08 113 x 119 mm
4.4 x 4.7 inch

10.741

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-09 113 x 119 mm
4.4 x 4.7 inch

9.720

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-10 113 x 119 mm
4.4 x 4.7 inch

9.836

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020
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12863-11 113 x 119 mm
4.4 x 4.7 inch

10.644

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-12 113 x 119 mm
4.4 x 4.7 inch

10.019

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-13 113 x 119 mm
4.4 x 4.7 inch

10.896

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-14 113 x 119 mm
4.4 x 4.7 inch

10.622

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-15 113 x 119 mm
4.4 x 4.7 inch

10.168

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-16 113 x 119 mm
4.4 x 4.7 inch

10.539

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-17 113 x 119 mm
4.4 x 4.7 inch

10.476

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-18 113 x 119 mm
4.4 x 4.7 inch

10.769

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-19 113 x 119 mm
4.4 x 4.7 inch

10.410

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-20 113 x 119 mm
4.4 x 4.7 inch

10.167

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020



Appendix

19 Embroidery Designs 211

12863-21 113 x 119 mm
4.4 x 4.7 inch

10.410

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-22 113 x 119 mm
4.4 x 4.7 inch

10.169

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-23 113 x 119 mm
4.4 x 4.7 inch

10.738

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-24 113 x 119 mm
4.4 x 4.7 inch

10.728

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-25 113 x 119 mm
4.4 x 4.7 inch

10.206

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-26 113 x 119 mm
4.4 x 4.7 inch

10.367

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-27 113 x 119 mm
4.4 x 4.7 inch

11.934

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-28 113 x 119 mm
4.4 x 4.7 inch

9.231

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-29 113 x 119 mm
4.4 x 4.7 inch

9.850

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020

12863-30 113 x 119 mm
4.4 x 4.7 inch

10.148

1.      Isacord 40   0020

2.      Isacord 40   0020

3.      Isacord 40   0020
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19.21 In the Hoop
You can find the detailed embroidery instructions at
bernina.com/990-designs.

12751-03 100 x 192 mm
3.9 x 7.6 inch

5.132

1.      Isacord 40   2550

2.      Isacord 40   2550

3.      Isacord 40   2550

4.      Isacord 40   2550

5.      Isacord 40   2550

6.      Isacord 40   2550

7.      Isacord 40   2550

8.      Isacord 40   2550

19999-019 114 x 133 mm
4.5 x 5.3 inch

2.451

1.      Isacord 40   0020

2.      Isacord 40   2550

3.      Isacord 40   0020

4.      Isacord 40   0020

12888-01 110 x 125 mm
4.3 x 4.9 inch

10.220

1.      Isacord 40   2520

2.      Isacord 40   2520

3.      Isacord 40   2520

4.      Isacord 40   2520

5.      Isacord 40   0010

12888-02 98 x 113 mm
3.9 x 4.4 inch

4.457

1.      Isacord 40   2520

2.      Isacord 40   2520

3.      Isacord 40   2520

4.      Isacord 40   2520

12888-03 150 x 165 mm
5.9 x 6.5 inch

14.152

1.      Isacord 40   2905

2.      Isacord 40   2905

3.      Isacord 40   2905

4.      Isacord 40   2905

5.      Isacord 40   0010

12888-04 122 x 141 mm
4.8 x 5.6 inch

5.603

1.      Isacord 40   2905

2.      Isacord 40   2905

3.      Isacord 40   2905

4.      Isacord 40   2905

12888-05 125 x 190 mm
4.9 x 7.5 inch

13.411

1.      Isacord 40   4032

2.      Isacord 40   4032

3.      Isacord 40   4032

4.      Isacord 40   4032

5.      Isacord 40   0010

12888-06 98 x 113 mm
3.9 x 4.4 inch

4.457

1.      Isacord 40   4032

2.      Isacord 40   4032

3.      Isacord 40   4032

4.      Isacord 40   4032

51298-02 99 x 129 mm
3.9 x 5.1 inch

9.279

1.      Isacord 40   0630

2.      Isacord 40   0630

3.      Isacord 40   0630

4.      Isacord 40   6051

51298-03 83 x 82 mm
3.3 x 3.2 inch

5.081

1.      Isacord 40   0870

2.      Isacord 40   0870

3.      Isacord 40   0870

4.      Isacord 40   1565

https://www.bernina.com/990-designs
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51298-04 38 x 230 mm
1.5 x 9.1 inch

17.556

1.      Isacord 40   0630

2.      Isacord 40   0630

3.      Isacord 40   0630

4.      Isacord 40   1220

5.      Isacord 40   1565

6.      Isacord 40   0870

51298-05 83 x 82 mm
3.3 x 3.2 inch

4.439

1.      Isacord 40   1565

2.      Isacord 40   1565

3.      Isacord 40   1565

51298-06 110 x 199 mm
4.3 x 7.8 inch

34.440

1.      Isacord 40   0630

2.      Isacord 40   1220

3.      Isacord 40   1860

51298-01 88 x 129 mm
3.4 x 5.1 inch

9.306

1.      Isacord 40   6051

2.      Isacord 40   6051

3.      Isacord 40   6051
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A

Accessories Box........................................................  27
Adjust

Design Preview ...................................................  79
Embroidery Screen..............................................  79
Presser Foot Pressure ..........................................  41
Seam Guide........................................................  29
Sewing Screen ....................................................  50
Stitch Length ......................................................  61
Stitch Preivew .....................................................  50
Stitch Width .................................................  49, 61

Adjust Stitch Length.................................................  61
Adjusting

Display Brightness...............................................  44
Sewing Light Brightness......................................  44
Stitch Length ......................................................  49

Alarm ................................................................  50, 80
Alphabets ................................................................  57

Embroidery .........................................................  82
Sewing ...............................................................  52

Attach
Knee Lifter..........................................................  29
Seam Guide........................................................  29
Thread Guide......................................................  34

Attaching
BSR Presser Foot .................................................  40
Hoop ..................................................................  43
Needle................................................................  33
Presser Foot ........................................................  40
Slide-on Table.....................................................  28
Stitch Plate .........................................................  30

Automatic Needle Threader .....................................  34
Button ................................................................  13

B

Back Kick .................................................................  46
Backstepping

Precise ................................................................  63
Basting ....................................................................  94
BERNINA Dual Feed..................................................  42
BERNINA Stitch Regulator (BSR)................................  72
BISR

Setting Functions ................................................  72
BISR Mode...............................................................  23
Bobbin Thread .........................................................  38

Spooling .............................................................  38
Threading ...........................................................  39

Bobbin Thread Indicator...........................................  44
Brightness

Display................................................................  44
Sewing Light.......................................................  44

BSR..........................................................................  72
Attach Presser Foot.............................................  40
Setting Functions ................................................  72

Button
Automatic Needle Threader................................. 13
Needle Position Left/Right ................................... 15
Needle Position Up/Down.................................... 14
Pattern Begin ...................................................... 14
Pattern End ......................................................... 14
Presser Foot Up/Down......................................... 13
Quick Reverse ..................................................... 14
Securing.............................................................. 14
Start/Stop............................................................ 13
Thread Cutter ..................................................... 13

Buttonholes ....................................................... 52, 57
Editing ................................................................ 64

C

Calibrating the Buttonhole Foot with Slide ............... 47
Changing

Needle ................................................................ 33
Presser Foot ........................................................ 40
Stitch Plate.......................................................... 30

Changing the Battery ............................................. 101
Cleaning

Feed Dog ............................................................ 99
Needle Threader................................................ 101
Screen................................................................. 99
Thread Catcher ................................................. 101

Cleaning the Needle Threader ................................ 101
Cleaning the Thread Catcher.................................. 101
Cleaning the Thread Clamp.................................... 101
Clock

Setting ................................................................ 44
Combi Mode............................................................ 68

Stitch Pattern ...................................................... 50
Connecting

Embroidery Module............................................. 42
Foot Control ....................................................... 27

Consultant ............................................................... 24
Controls ................................................................... 13
Copying

File...................................................................... 23
Folder ................................................................. 23

Create Text .............................................................. 92

D

Darning Program
Editing ................................................................ 67

Data
Delete ................................................................. 97
Save.................................................................... 97

Datei
Copying .............................................................. 23

Dealer Data.............................................................. 44
Decorative Stitches ............................................. 52, 56
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Delete
Embroidery Design..............................................  85
Folder .................................................................  23
Personal Data .....................................................  97

Design
Own Stitch Pattern .............................................  74
Stitch Pattern......................................................  52

Design Preview
Adjust.................................................................  79

Directional Sewing...................................................  62
Display

Adjusting the Brightness .....................................  44
Feed Dog Up/Down ......................................  50, 80
Hoop ..................................................................  80
Lower Thred Bobbin Fill Capacity ..................  50, 80
Needle..........................................................  50, 80
Needle Stop Up/Down ........................................  50
Presser Foot ..................................................  50, 80
Presser Foot Pressure ..........................................  50
Recommended Hoop ..........................................  80
Stitch Plate ...................................................  50, 80
Upper Thread Tension Sewing ............................  50
Upper Thread Tension Stitching ..........................  80
WiFi Connectivity..........................................  50, 80

Dispose of the machine..........................................  108
Distort .....................................................................  63
Dual Feed ................................................................  42

Optimize Balance................................................  64
Switching On/Off................................................  42

Duplicate
Embroider Design ...............................................  84
Stitch Pattern......................................................  69

E

Edit
Stitch Design ......................................................  75
Stitch Pattern................................................  49, 62
Stitch Pattern Combination.................................  68
Tapering Stitches ................................................  66
Text ....................................................................  92

Edit Balance
Dual Feed ...........................................................  64

Editing
Buttonholes ........................................................  64
Darning Program ................................................  67
Embroidery Design........................................  79, 84
Lettering.............................................................  92
Text ....................................................................  92

Embroidery Alphabets..............................................  82
Embroidery Design...................................................  82

Align ..................................................................  85
Arrange ..............................................................  85
Arranging around Shape.....................................  88
Center ................................................................  86
Change Color .....................................................  87

Change Thread Brand ......................................... 87
Check ................................................................. 86
Check Position .................................................... 88
Delete ................................................................. 85
Duplicate ............................................................ 84
Edit Colors .......................................................... 85
Editing .......................................................... 79, 84
Endless................................................................ 87
Endless Embroidery ............................................. 90
File Manager ....................................................... 82
Group ................................................................. 85
Information......................................................... 79
Loading............................................................... 83
Mirror ................................................................. 84
Move .................................................................. 84
Personal Folder.................................................... 82
Pinpoint Placement ....................................... 86, 88
Position............................................................... 86
Resize ................................................................. 84
Rotate................................................................. 84
Save.................................................................... 79
Select.................................................................. 83
Shape Designer ............................................. 85, 88
Standard Positioning ........................................... 47
Stitch Density ...................................................... 84
Stitchout ............................................................. 94
Ungroup ............................................................. 85
Virtual Positioning ............................................... 86

Embroidery Designs
Saving................................................................. 93
USB Stick ............................................................ 82

Embroidery Module
Connecting ......................................................... 42
Removing............................................................ 43

Embroidery Screen ................................................... 79
Adjust ................................................................. 79

Embroidery Speed
Settings............................................................... 47

Embroidery Test ....................................................... 78
Endless..................................................................... 90
Environmental Protection ........................................... 8
Explanation of Symbols .............................................. 9
External Buttons ....................................................... 13

F

Feed Dog ................................................................. 42
Cleaning ............................................................. 99

Feed Dog Up/Down
Display .......................................................... 50, 80
Setting .......................................................... 50, 80

File
Delete ................................................................. 23
Moving ............................................................... 23
Rename .............................................................. 23

File Format ............................................................... 77
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File Manager......................................................  51, 81
Embroidery Design..............................................  82
Navigation Bar ..............................................  52, 82
Quick Access Bar Embroidery Mode ....................  82
Sewing Mode Quick Access Bar ..........................  52
Toolbar.........................................................  51, 81

File Manger
Stitch Pattern......................................................  52

Folder
Copying..............................................................  23
Delete.................................................................  23
Moving...............................................................  23
Rename ..............................................................  23

Font...................................................................  82, 91
Embroidery .........................................................  82

Foot Control ............................................................  27
Connecting.........................................................  27
Programming the Back Kick Function..................  46

H

Help.........................................................................  24
Help Center .............................................................  24
Home Screen ...........................................................  22
Hook

Cleaning.............................................................  99
Lubricating .......................................................  100

Hoop .......................................................................  43
Attaching ...........................................................  43
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